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Welcome to the Financial Edge Guide for Australia and New Zealand. This guide details the Financial Edge
functionality specific to Australia and New Zealand.

For example, this guide explains how the Goods and Services Tax (GST) affects the Accounts Payable, Accounts
Receivable, and Student Billing programs of The Financial Edge.

If you have the optional module Electronic Funds Transfer, which adds fields and options to areas of Accounts
Payable, you can send and receive electronic transfers.

Keep in mind, if you need additional information while working in The Financial Edge, you have access to all the
user guides on our website. You can also access the help file from the Help menu, or by clicking F1 from the
program. Both help files and user guides contain the same helpful procedures, explanations, and examples.

The information in this guide is organised into eight chapters.

Note: Information in this guide is subject to change. Please visit our website to view the most current
information. To access our system recommendations, select System Recommendations from the Support
menu on our website at www.blackbaud.com.

Chapter 1: Welcome. This chapter details the various Blackbaud solutions we offer.

Chapter 2: GST in Accounts Payable. This chapter explains how sales taxes such as the Goods and Services
Tax (GST) and the Harmonized Sales Tax (HST) affect the Accounts Payable.

Chapter 3: GST in Accounts Receivable. This chapter explains how sales taxes such as the Goods and
Services Tax (GST) and the Harmonized Sales Tax (HST) affect the Accounts Receivable.

Chapter 4: GST in Accounts Student Billing. This chapter explains how sales taxes such as the Goods and
Services Tax (GST) and the Harmonized Sales Tax (HST) affect the Student Billing.

Chapter 5: Cheque Processing. This chapter explains how to print cheques, record bank drafts, create and
edit one-time cheques, and create manual cheques.

Chapter 6: GST Reporting. This chapter explains how to create Business Activity Statements so that you can
view sales tax information quickly and easily.

Chapter 7: Posting to General Ledger. This chapter addresses the posting and tracking of GST information
from The Raiser’s Edge.

Chapter 8: EFT Transactions. This chapter discusses the EFT functionality present in Accounts Payable when
you have the optional module Electronic Funds Transfer.

Blackbaud Solutions and Services

For more than two decades, we have provided world-class technology solutions to the nonprofit community,
helping organisations of all sizes and types.

Software plays an important role in the Blackbaud equation for success. Indeed, our products set the standards
by which others are measured. However, there is another essential part of the Blackbaud solution — services. As
the largest and most experienced provider of services to the nonprofit community, we understand the unique
challenges nonprofits face and help them overcome those challenges.

More than 12,000 nonprofit organisations have chosen to partner with us for the peace of mind that comes with
one company providing an end-to-end solution of software and services. We focus our expertise on meeting your
needs — so you can focus your resources on fulfilling your mission.

Data Services

We offer a wide range of data services. From database conversion to database consolidation, our staff of
programmers and analysts have the experience, technology, and expertise to meet your organisation’s needs.

To request a quote for data services or database conversion, please contact our Conversion Coordinator by e-
mail at conversionestimate@blackbaud.com or by phone at 1-800-468-8996 x4200. You can also submit your
request from the Data Services page on our website.
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Accounting System Consulting

Accounting System Consulting services help you get the most out of our Financial Edge software by aligning
your organisation’s systems with its processes and objectives. We partner with you to learn about your
organisation, identify issues, and plan a solution that is tailored to your needs.

Our consultants offer a unique combination of accounting experience and in-depth knowledge of our software.
Many of our consultants have gained experience by serving as controllers and technical specialists and have
worked for Big Five firms, nonprofit organisations, and the Financial Accounting Standards Board (FASB). They
can share insight garnered from their work with hundreds of nonprofit organisations. Our accounting consulting
team knows the software inside and out and are available to help you make the most of your system.

To learn how your organisation can benefit from our Accounting System Consulting services, call 800-443-9441
or send an e-mail to solutions@blackbaud.com.

How We Can Help
¢ Evaluate and define historic data to convert to The Financial Edge
¢ Import accounting information to General Ledger from non-Blackbaud products
e Assess your organisation’s unique reporting requirements
¢ Design your chart of accounts and account number structure
e Establish system security
e Determine the appropriate fund closing method based on your reporting needs
e Establish a start date for your new system, and determine what data to bring in from prior years’ records
e Review your data entry methods and recommend ways to increase productivity in your business office
¢ Evaluate job responsibilities to ensure optimal workflow
e Establish an interface between The Raiser’s Edge and General Ledger

¢ Set up and maximise your use of optional modules, including Projects and Grants, Budget Management, and
Allocation Management

¢ Create initial reports such as a balance sheet and income statements

Technical Consulting

Let our knowledgeable consultants bring their technical expertise to your site and manage the implementation of
your Financial Edge products. By entrusting the nuts and bolts of implementation to one of our consultants, you
ensure optimal setup of your system while keeping your time and energy focused on fostering your organisation’s
mission.

Whether it is software installation or a detailed assessment of your current IT capabilities and needs, our team of
Microsoft, Cisco, and Oracle certified engineers can help you meet your technical challenges head on.

If you would like to arrange for consulting services, call our Sales Department at 1-800-443-9441. Or send an
e-mail outlining your specific needs to sales@blackbaud.com.

To learn more about our technical consulting offerings, such as technology assessments, diagnostic services, and
software installations, you can download the printer-friendly document “Technical Consulting Services” from our
website.
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Training Solutions

Because we understand how important training is, we offer a variety of options to meet your different needs,
including specialized classes on The Financial Edge at our home office and in cities across North America. As an
alternative, trainers can come to your organisation to deliver classroom-style or individualized instruction.

You may prefer to have our consultants guide you through the implementation process, discuss your system
configuration, and tailor the software to meet your specific needs. For information about the best training option
for your organisation, call your account representative at 1-800-443-9441 or send an e-mail to
solutions@blackbaud.com.

Blackbaud University. Offers a variety of classes in historic Charleston, South Carolina. By leaving the
distractions of the office behind, clients can devote their energy to effectively learning Financial Edge
software. Attendees agree that a key benefit of Blackbaud University is sharing knowledge and ideas with
other students from a diverse range of nonprofit organisations.

Regional Training. Now available in more than 30 locations throughout North America. State-of-the-art
training facilities provide an ideal setting for developing your knowledge.

On-Site Training. Provides a cost-effective option for organisations that cannot afford to have staff members
away from the office for several days. The Blackbaud instructors can teach standard course curricula or create
a special training program to meet your specific needs.

Online Learning Network . Delivers instructor-led and self-paced distance training to students via the
Internet.
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User Guides

All manuals documenting The Financial Edge are available through the Help menu in electronic form.

If you need to access the documents before you install The Financial Edge, use the manuals directory on the CD,
the Read User Guides link, or the Blackbaud website — www.blackbaud.com.

Blackbaud Forms

Blackbaud Business Forms provides custom checks, student bills, statements, invoices, purchase orders, tax
forms, envelopes, and other computer forms that are specifically designed for use with The Financial Edge.
Blackbaud forms are guaranteed to align correctly and can be customised to your organisation’s specifications,
using your logo, special inks, and print styles. Pre-printed forms from other suppliers are not guaranteed to align
properly.

For more information, you can visit the forms section of our website at http://forms.blackbaud.com or send an
e-mail with questions to forms@blackbaud.com. You can also call 866-4-BB-FORMS (866-422-3676).

Blackbaud Developer Network

The Blackbaud Developer Network (BDN) is an alliance of development partners, including system integrators,
consultants, CPA firms and nonprofit organisations, that work with us to create solutions that expand the
capabilities of The Financial Edge. These solutions are additional applications, created specifically for our clients,
that work with our software to expand functionality. For example, BDN solutions can include customised tools
and plug-ins that integrate or interact with The Financial Edge to help your organisation accomplish more in less
time.

Our BDN development partners have been carefully selected. They each possess a distinct understanding of our
software products and how nonprofit organisations use them to further their mission. This insight, coupled with
technical expertise, provides the basis for creating quality solutions you can use to do more.

To learn more about the Blackbaud Developer Network (BDN), or to view potential software applications that can
help your organisation, go to http://developer.blackbaud.com.
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This chapter explains how the Goods and Services Tax (GST) affects the Accounts Payable program of The
Financial Edge.

This chapter includes information about managing GST in Configuration, Records, and Reports. In Configuration,
you can designate the Australian Business Number (ABN) and GST Branch Registration number, and you can set
important business rules that determine how GST information is handled in other areas of the program.

Accounts Payable Configuration

Configuration is where you set up Accounts Payable to fit the needs of your organisation. For example, on the
General page, you can designate an ABN and a GST Branch Registration number that appear automatically on
reports. On the GST Tax IDS page, you can create different GST tax items, such as the standard 10 percent GST
tax, a tax free item for tax-free products and services, and a 48.5 percent item you withhold from unregistered
organisations that have not declared an ABN number.

You can also set GST business rules for invoice, recurring invoice, credit memo, receipt, and line item records,
including an option that determines whether transaction amounts you enter already include tax, or must have
taxes added.

For more information and procedures for setting the other fields in Configuration, see the Configuration Guide for
Accounts Payable.

General Configuration

The General page is where you enter basic information about your organisation.

The address and phone information you enter on this page appears on printed documents and correspondence.
You can also designate the ABN and GST Branch Registration number on this page. For more detailed information
about entering information on the General page of Configuration, see the Configuration Guide for Accounts
Payable.

% The Education Edge HEE
File Edit “iew Go Favowites Took Help
% Back & Fomwvard ] Community Services Inc, = = Accounts Payable —
Shortubs i 3
Configuration * General
Organization: Communitp Services Inc. w
General I
County IAustlaIia j T
Brms
Address: 33509 Bertinck Strest = Attributes
LI Aging
Information
City: |P0|tland Business
— Rules
State: ic - | Wictoria
Tables
Postcode: |33DE —J
Fields
Phane: |[05] BEEE BEBE Distributions
Miscellane. ..
BETANET (6 5 Line Iterms
. Internatio, ..
ninistrakion ABM |-| 2345 ot
ress
_ GET Branch: I el
Figuration
G5T Mot Registered ‘withholding Tax 10 IGST vl Goods and Services Tax Posting
Information
Defaulk
| Accounts
a Plug-Ins - Products
T2 He [~ | GST Tax IDS
Blackbaud Systems |
Fress FF to zoom
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Warning: If you are a New Zealand user, enter your organisation’s GST number in the GST Registration
Number field. The ABN, GST Branch, and GST Not Registered Withholding Tax ID fields do not appear.

ABN. In the ABN field, enter the federal charitable identification number for your organisation. This number is
used in reports.

GST Branch. In the GST Branch field, enter your organisation’s GST branch number. This number is used in
reports.

GST Not Registered Withholding Tax ID. Select a default sales tax billing item to use for vendors who do
not declare an ABN.

Business Rules Configuration

Business rules help you customise standard procedures and requirements to suit your organisation. For example,
by setting Invoice business rules, you can designate the functions you use for invoicing. You can select whether to
automatically apply open credit to new invoices, to require invoice approval before paying, to exclude Do Not
Post as a post status, and whether to change an invoice status to paid when the applied credit reduces the
balance to zero.

You can set GST business rules for invoice, recurring invoice, credit memo, receipt, and line item records,
including an important tax option you can set for data entry. You can choose to “include tax” or “exclude tax”
during data entry for the unit price and extended price.

To change business rules, from the Configuration page, click Business Rules. The Business Rules page appears.

#% The Financial Edge

File Edit Yiew Go Favouwites Tool: Help

4 Back & Eorward I Community Services Inc. ™ + Accounts Payable ™

Shorkcuts

Configuration » Business Rules

EEEE General Configurat...
b Vendor General

b Irvoice ¥ Only check budgsts for income statement accounts Tems
b Recuring Invaice

¥ Credit Mote Use this scenario when checking budgets: IDD vl Main Operating Budget Attributes

b Payment Allaw norvbank transactions to use cash accounts: IAIways j Aging
# Cash Management Adjus Information

» Purchaze Order
b Line ltem

b Feceipt E=penditures for accounts without budgets: IAIways allow expenditure j Tables J
¥ Requisition =

b Gueue Budget checking for projects [within each GL account]: M

Diskribuk
Iw’arn when over-budaet for financial year or period ﬂ ISErIBUEONS

Miscelaneous
Expenditures for projects without budgets: IAIways allovs expenditurs j Line Items
International
Address
Interfund

Posting

Information

Default

Accounts
a Plug-Ins - Products

z G5T Tax IDS
15! Help [~ ]

Blackbaud Systems |

|F||1—' Home

Budget checking for accounts: IWam when over-budget for financial year or period j Business Rulesl

wWelcome to fccounts Payable

Invoice Business Rules

Note: This guide discusses only business rules related to GST. For detailed information about other business
rules, see the Configuration Guide for Accounts Payable.
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With Invoice business rules, you can determine whether displayed invoice transaction amounts include taxes,
and you can require including taxes when computing discounts you receive for making early payments.

The Financial Edge

File Edit “iew Go Favouites Tool: Help

# Back % Forvard I Comrunity Services Inc, ™ « Accounts Payable ™

Shorkcuts

Configuration « Business Rules

b General Inyoice Configurat...
b Yendor

General

» A s Automatically apply open credit to new \nvnices'«‘lAgk each time j Fr—
ecuring Invoice L
» Credt Nogte ™ Do you want to require invoice approval before payment or posting? Attributes

¥ Payment ™ Exclude "Do not post” as a post status Ading
b Cash Management Adju: | ¥ Changs invoice status to paid when applied credit reduces balance ta zern Informatian
B Purchase Order o data entry. show th " J Busi Rul
" -
b Line ltem uring data entry, show the | ranzaction amount only [exciuding tax) Uiz [FIL 2

s st ]
¥ Requisition ™ Includs tax in discount calculations Fields

b Queue
uplicate invaice criteria: Distributions

N Miscellaneous
Field Name I Length I T
Invoice dake NJA -
| |Invaice amount Wi International
Address
Interfund

Posting
Information
i Default
Accounts
a Plug-Ins [ Automaticaly check for duplicate invoices Products
<] Jyam user | G5T Tax IDS

=]

=13l Help
Blackbaud Systems |

‘wWelcome o Accounts Payable |

During data entry, show the. With this rule, you can select whether invoice transaction amounts should
include or exclude taxes.

Include tax in discount calculations. Tick this rule to include tax amounts when calculating discounts you
receive for early payments.
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Recurring Invoice Business Rules

With Recurring Invoice business rules, you can determine whether displayed recurring invoice transaction
amounts include taxes.

i The Financial Edge

File Edit View Go Favowites Tool: Help

4 Back & Eorywardl ] Community Services Inc, * + Accounts Payable ™

Shortcuts

Configuration « Business Rules

b General Recurring Invoice Configurat...
b Vendor J

General
.4 ‘WD'C V¥ ‘when invaices need ta be generated:lDispIay reminder on home page Terms
Recuring Ir 3 ) .
» Credit Note Remind |1 dapls] before the invoice date Attributes
b Payment - Aging
¥ Cash Management Adjus During data eritry, show the Itransactlnn amount only [exciuding tax] j Information
b Purchase Order .
» Line Item I™ Exclude "Do not post” as a post status Business Rules
» Receipt Tables

b Requisition

b Oueue M
Distributions
Miscellaneous
Line Iterms
Inkernational

Address
Interfund

Posting
. Information
; Defaulk
Arcounts
a Plug-Ins

Products
H G3T Tax IDS

=lad Help
Blackbaud Systems |

‘Welcome o Accounts Payable |

During data entry, show the. With this rule, you can select whether invoice transaction amounts should
include or exclude taxes.
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Credit Note Business Rules

With Credit Note business rules, you can determine whether displayed credit note transaction amounts include
taxes.

i The Financial Edge

File Edit View Go Favowites Tool: Help

4 Back & Eorywardl ] Community Services Inc, * + Accounts Payable ™

Shortcuts

* Configuration « Business Rules

|F|H—' Horme —-s8 - "
~ b General Credit Note (T e
7 b Yendor General
Eecocs b Invoice [~ Exclude "Da not post”’ as a post status Terms
‘\@ te Diuring data entry, show the Ilransacl\un amaunt only [excluding tax] j Attributes
- B Payment Aging
]-g Expart ¥ Cash Management Adjus Duplicate credit note criteria: Infarmation
wport
F g b Puchase Qider Field Mame I Length I Business
b Line ltem Credit nate date M Rules
g Report: » HECE!D_[_ Credit note amounk [TE Tables
b Requisition -
b Gueue — Filds

Distributions

Miscellane. .,
Line Items

Inkernational
I Automatically check for duplicate credit notes Address
I\N’am uzer j Interfund

Posting
Information

Difaulk
Accounts

Froducts

AU AR A

GST Tax IDS

‘Welcome o Accounts Payable

Note: This guide discusses only business rules related to GST. For detailed information about other business
rules, see the Configuration Guide for Accounts Payable.

During data entry, show the. With this rule, you can select whether credit note transaction amounts should
include or exclude taxes.
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Line Items Business Rules

With Line Item business rules, you can determine whether displayed line item costs include taxes.

i The Financial Edge

File Edit View Go Favowites Tool: Help

4 Back & Eorywardl ] Community Services Inc, * + Accounts Payable ™

Shortcuts

»* Configuration * Business Rules
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b Payment Ading
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b Purchase Order :
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Distributions
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Interfund

Posting
Information
| Default

Accounts
/ aF'Iug-Ir\:: ! Products
7 e n G3T Tax IDS
=lad Hel

Blackbaud Systems |

‘wWelcome o Accounts Payable |

During Unit Cost and Extended Cost data entry, show. With this rule, you can select whether line item
cost amounts should include or exclude taxes.

Receipt Business Rules

Note: This guide discusses only business rules related to GST. For detailed information about other business
rules, see the Configuration Guide for Accounts Payable.
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With Receipt business rules, you can determine whether displayed receipt price amounts include taxes.

#% The Financial Edge

File Edit Yiew Go Favouwites Tool: Help

4 Back & Eorward I Community Services Inc. ™ + Accounts Payable ™

Shorkcuts

+ Configuration » Business Rules

» General Receipt Configurat...
b Vendor General
» Invaice I Exclude "Do not post” as a post status Terms

b Recuring Invaice

¥ Credit Nate ™ Exclude "wai for Invoice' as a post status Attributes

B Payment During data entry. unit price and extended price Iexclude tam ‘I Aging

# Cash Management Adjus Information

¥ Purchase Order .

b Line ltem Business Rulesl
o Fis
Distributions
Miscelaneous
Line Iterms
International
Address

Posting
Information
Default
Accounts
Products
G5T Tax IDS

Blackbaud Systems |

wWelcome to fccounts Payable |

During data entry, unit price and extended price. With this rule, you can select whether receipt price
amounts should include or exclude taxes.

Tables Configuration

Note: Billing entities are shared between Accounts Payable, Accounts Receivable, and Student Billing. If you
create a billing entity in one program, such as Accounts Payable, it also appears in the other programs.

Tables increase data entry speed and accuracy throughout Accounts Payable. When entering information into a
field with a table, you can quickly access a list of possible entries for that field, select an entry, and place it directly
into the field rather than entering it manually.

In Accounts Payable, the Billing Entity table contains several predefined commonly used GST tax entities, such
GST, FRE (GST-free), and GNR (GST Not Registered, Withhold Payment Tax). You can also enter additional taxes,
if, for example, your city imposes a sales tax in addition to GST. You can select from these field entries when
creating several record types.

You can click the down arrow on the right side of a field or press F4 to view a list of entries for a table. You can
also place the cursor in the field and click the down arrow on your keyboard to scroll through the entries. You can
usually enter text directly in the field, and if the program does not recognise it as a valid entry, you get a message
asking if you want to add the text as a new entry. Finally, you can place the cursor in a table field and press F7 to
access a screen on which you can view, add, edit, and delete entries.

To keep entries uniform, it is also extremely important that you limit rights for adding and editing table entries.
These rights are controlled though the Set Up System Security page of Administration. Allowing only a few key
users to add, edit, or delete table entries ensures the validity of your database, records, and reports. Maintaining
strict control over the Billing Entity table is especially important because it ensures that your tax information is
tracked and reported correctly.

For more detailed information and procedures for adding, editing, and deleting tables and table entries, see the
Configuration Guide for Accounts Payable.
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1. On the Tables page, select the Billing Entity table. Table entries appear in a box on the right.

The Financial Edge (=]
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2. Inthe table entry box, select the entry below the point where to insert the new entry.
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3. Click Insert. The New Table Entry screen appears.
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the selected entry.

Products Configuration

To make the new table entry inactive, tick Inactive.
To save the new table entry and return to the Tables page, click OK. The new billing entity appears above

In the Short Description field, enter an abbreviation for the new billing entity.
In the Long description field, enter the full name of the new billing entity.

Note: For detailed information and procedures for creating a new product record, see the Records Guide for

Accounts Payable.

If you have the optional module Purchase Orders, you can create product records in Accounts Payable. On the
product record, you can specify whether the product is taxable, and you can select a tax identifier you created in
Configuration. To access the Products page from Configuration, select the Products tab. The program lists existing
products in the grid. To create a new product, click New. The New Product screen appears.
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Product is taxable. If the product you are purchasing is taxable, tick this checkbox.

GST Tax ID. In the GST Tax ID field, select “FRE”, “GNR”, or “GST” for the tax entity code. If necessary, you can
add sales tax entity codes to the Sales Tax Entity Table on the Tables page.
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GST Tax IDs Configuration

The GST Tax IDS page is where you can create, edit, and delete GST IDs. After you add tax IDs, you can apply them
to records containing taxable items and the tax ID information appears on the record.

For example, Accounts Payable contains a pre-defined GST item “GST”. On the GST Tax IDS page, you can open
the “GST” record and designate default expense and payable accounts to use when applying the “GST” item to
taxable items. Then, when you create a new invoice containing taxable goods or services, you can select the
“GST” tax ID and the correct account distributions appear automatically.

If you define default expense and payable accounts on the GST Tax IDS page, those accounts appear on other
record types so you will not have enter them on every new record containing a GST item.
» Creating a new GSTID

1. On the Configuration page, click GST Tax IDS. The GST Tax IDS page appears.
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Note: You can also open, edit, and delete GST items from the GST Items page.
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2. Click New GST Tax ID. The New GST Tax ID screen appears.

o v kW

~

#% Mew GST Tax ID
File Edit “iew GST TaxlD Favouwites Toolz Help

E]Saveandﬁlosev|u X|N L N||IQ'|?' |
Item ID: I Status: [ 4ctive j

Drescription: I

Billing E ntity I Percent I Expenze Account Mumber | Account Descripti... | Payables Account Mumber | Account ©

K1 M

™| Swihern calculating ke far e I j through I j entities, include

Comment:

In the Item ID field, enter the tax item ID.
In the Status field, select “Active” or “Inactive”.
In Description field, enter a description for the GST item, for example, “Goods and Services Tax".

In the Billing Entity column of the grid, select a GST tax entity previously added to Billing Entity table in
Configuration. You can also enter a new entity in the column and you will be prompted to add it to the
Billing Entity table.

In the Percent column, enter the tax rate for the corresponding entity. For example, “10.00”.

In the Expense Account Number column, enter the expense accounts for the distribution. You can use the
small binoculars to search for an account segment or use the large binoculars to search for an account
number. When you enter a valid expense account number, the description appears automatically in the
Account Description column.

In the Payables Account Number column, enter the payables accounts for the distribution. You can use
the small binoculars to search for an account segment or use the large binoculars to search for an account
number. When you enter a valid payables account number, the description appears automatically in the
Account Description column.

Note: An interfund entry is a balancing entry made to transfer activity between funds and ensure each fund is
kept in balance. Interfund entries are used only when you enter a debit account from a fund different from the
credit account.

10.

11.

12.

If you enter expense and payables accounts from different funds, in the Interfund field above the
distribution grid, select an interfund set to balance the accounts. If you have not created a balancing
interfund set for those accounts in Configuration, you cannot save the distribution. For more information
about interfund entries, see the Configuration Guide for Accounts Payable.

If you have the optional module Projects and Grants, enter a project ID number in the Project ID column,
or use the binoculars to search for a project ID. When you enter a valid project ID number, the description
appears automatically in the Project Description column.

In the Class column, select a class for the distribution.
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13. If you have the optional module Projects and Grants and have defined transaction codes, additional
columns appear based on the number of transaction codes you have defined. In the grid, select a value for
each transaction code.

14. If taxes should be compounded on the first tax entity in the grid, tick When calculating tax for the []
through [] include and select the range. The options available depend on the number of billing entities in
the grid.

Warning: There is no “GNR” option for New Zealand users.

15. In the Comments field, enter any additional information associated with the tax.
16. To return to the GST Items page, click Save and Close.

Accounts Payable Records

From the Records page of Accounts Payable, you can create vendors, invoices, recurring invoices, and credit
notes. Each of these record types can contain information to help you track GST taxes you pay so you can claim
deductions. If you have the optional module Purchase Orders, you can also track GST information for purchase
orders, products, receipts, and requisitions.

In Accounts Payable, you can create and apply GST items to products, vendors, invoices, credit notes, purchase
orders, and receipt records.

This chapter guides you through available GST options and fields, and it explains how they affect your
organisation. For detailed explanations of other record features, and for procedures for creating new records, see
the Records Guide for Accounts Payable.

Warning: Before you begin adding GST information to records, you should create GST tax IDs and set business
rules in Configuration.

Before you begin adding GST information to records, you should create GST tax IDs and set business rules in
Configuration. For more information about Configuration, see the Getting Started chapter.

Adding GST to Products

Note: For detailed information and procedures for creating a new product record, see the Records Guide for
Accounts Payable.
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If you have the optional module Purchase Orders, you can create product records in Accounts Payable. On the
product record, you can specify whether the product is taxable, and you can select a tax identifier you created in
Configuration.
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Product is taxable. If the product you are purchasing is taxable, tick this checkbox.

GST Tax ID. In the GST Tax ID field, select “FRE”, “GNR”, or “GST” for the tax entity code. If necessary, you can
add sales tax entity codes to the Sales Tax Entity Table on the Tables page of Configuration. For more
information, see the Getting Started chapter.

Adding GST to Vendors

Note: For detailed information and procedures for creating a new vendor record, see the Records Guide for
Accounts Payable.

On a vendor record, you can add GST information in several fields, including ABN and GST branch. GST
information is added on both the Vendor and Distribution tabs of a vendor record. If you do not enter an ABN for
a vendor, the “GST Not Registered, Withhold Payment” billing item is applied automatically to all invoices and
48.5 percent of the invoice amount is withheld from payments.

Vendor Tab

Warning: If you do not enter an ABN, the GNR item is applied automatically and 48.5 percent of all invoices for
this vendor are withheld.

On the Vendor tab, you can add ABN and GST Branch information.
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Warning: If you are a New Zealand user, enter information in the GST Registration Number field. The ABN field

does not appear.

ABN. In the ABN field, enter the Australian Business Number for the vendor. If you do not enter an ABN for a
vendor, the Tax ID will default to “GST Not Registered, Withhold Payment” for all the vendor’s distributions.

GST Branch. In the GST Branch field, enter the GST branch number for the vendor. The GST Branch number is

used for reporting.

Distribution Tab

The Distribution tab of the vendor record is where you define the default expense distribution for the vendor.
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The Distribution tab contains vendor account distribution information. From here, you designate debit accounts
for the vendor’s transactions, amounts to distribute to the accounts, and whether to classify distributions using
projects, classes, or transaction codes. You can also define whether to assign a Tax ID to a vendor. For example, if
the vendor is not subject to GST, you can assign an ID of “FRE” to ensure that no taxes are withheld on any of the
vendor’s invoices.
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Note: In the GST Tax ID field, you can select the standard GST tax, a tax free status, or GST Not Registered,
Withhold Payment Tax. For more information about GST Tax IDs, see the Getting Started chapter.

GST Tax ID. In the GST Tax ID field, select “FRE”, “GNR”, or “GST”. If necessary, you can add sales tax entity
codes to the Sales Tax Entity Table on the Tables page of Configuration. For more information, see the Getting
Started chapter.

Adding GST to Invoices

In Accounts Payable, you can edit tax information on the Invoice tab, and you can add GST tax information when
creating invoice adjustments.
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Invoice Tab

On the Invoice tab, you can edit GST tax information that appears for the charge amount you enter.
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Edit Tax. To edit the tax settings for this invoice, click Edit Tax. The Edit Sales Tax screen appears. For more
information about editing sales tax information, see “Editing Sales Tax Information” on page 30.

Invoice Adjustments

Adjustments are corrections you make to a posted invoice that reverse the incorrect post and then create
another post with new distributions. You can change GST information on invoice adjustments only if you void a
previous partial payment. To make a new adjustment to a posted invoice, from the menu bar, select Invoice, New
Adjustment. The New Adjustment Screen Appears. For detailed information and procedures for creating invoice
adjustments, see the Records Guide for Accounts Payable.
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Adjustment Tab
On the invoice Adjustment Tab, you can select a new GST ID if the invoice has not been paid.
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GST Tax ID. In the GST Tax ID field, you can select a new ID if the invoice has not been paid. When you select a
tax ID, the tax amount appears automatically.

New Tax Distribution Tab

Note: For detailed information and procedures for creating a new invoice adjustment, see the Records Guide
for Accounts Payable.

On the New Tax Distribution tab, you can change the ID or amount of tax, and you can change the tax
distribution, including debit and credit accounts. To view the amount of the previous distribution, select the
Previous Tax Distribution tab.
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Total Tax. In the Total Tax field, select “GST”, “FRE”, or “GNR”. A GST amount appears in the amount field. You
can add sales tax entity codes to the Sales Tax Entity Table on the Tables page of Configuration.

Billing Entity. In this column of the grid, select a sales tax entity previously added to Sales Tax Entity table in
Configuration. You can also enter a new entity in the column and you will be prompted to add it to the Sales
Tax Entity table.

DR Account Number. In this column, you can edit the default debit account information for the GST. You can
use the binoculars to search for accounts. To search for an account segment, click the small binoculars
button. To search for an account number, click the large binoculars button. When you enter a valid debit
account number, the description appears automatically in the DR Account Description column.

Percent. To enter distributions by percent, click the % button.
Amount. To enter distributions by amount, click the $ button.

CR Account Number. In this column, you can edit the default debit account information for the GST. You can
use the binoculars to search for accounts. To search for an account segment, click the small binoculars
button. To search for an account number, click the large binoculars button. When you enter a valid credit
account number, the description appears automatically in the CR Account Description column.

Project ID. In this column, you can enter a project ID number in the Project ID column, or use the binoculars to
search for a project ID. When you enter a valid project ID number, the description appears automatically in
the Project Description column. Projects are available only with the optional module Projects and Grants.

Class. In the Class column, select a class for the distribution.

Transaction Codes. If you have the optional module Projects and Grants and have defined transaction codes,
additional columns appear based on the number of transaction codes you have defined. In the grid, select a
value for each transaction code.

DR/CR Entries. Click this button to preview the current debits and credits for the GST item.

Apply Rate. If you enter a new total tax, you can use this button to update subtotals in the Amount column for
each billing entity in the grid. The new subtotals are based on the distribution percentages you entered on the
GST Tax IDs page of Configuration.

Update Total. If you enter new tax distribution amounts in the Amount column of the grid, you can click this
button to update the total tax field.
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Previous Tax Distribution Tab

On the Previous Tax Distribution tab, you can view the tax distribution for the adjustment, before any changes.
Field and grid entries on the Previous Tax Distribution tab are locked and cannot be edited. To change the tax
distribution, see “New Tax Distribution Tab” on page 24.
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Adding GST to Recurring Invoices

Note: For detailed information and procedures for creating a new recurring invoice record, see the Records
Guide for Accounts Payable.

Recurring invoices are templates from which you can create regular invoices quickly and easily according to a
schedule. They provide basic information such as the vendor name, invoice amount, and payment method so you
do not have to enter the entire invoice from scratch. Although you can pay and post the invoices you create from
a recurring invoice, recurring invoices are never posted or included in any balance calculation.

Note: Although you can pay and post the invoices you create from a recurring invoice, recurring invoices are
never posted or included in any balance calculation.
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You can create both regular and recurring invoices directly from a vendor record or create the invoice from the
File menu of a vendor record and apply it to a vendor. GST options are available on invoice and recurring invoice

records.
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Edit Tax. To edit the tax settings for this recurring invoice, click Edit Tax. The Edit Sales Tax screen appears. For
more information about editing sales tax information, see “Editing Sales Tax Information” on page 30.

Adding GST to Credit Notes

Note: For detailed information and procedures for creating a new credit note record, see the Records Guide

for Accounts Payable.

A credit note is a document issued by a vendor to record an adjustment against an invoice. You can apply a credit
note to one or more invoices to decrease the amount owed. Credit notes also reduce the amount of GST you pay.
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The credit note record displays basic credit note information including number, date, description, post
information, and GST amount.
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Edit Tax. To edit the tax settings for this credit note, click Edit Tax. The Edit Sales Tax screen appears. For more
information about editing sales tax information, see “Editing Sales Tax Information” on page 30.

Adding GST to Purchase Orders

Note: For detailed information and procedures for creating a new purchase order record, see the Records
Guide for Accounts Payable.

If you have the optional module Purchase Orders, you can create purchase orders and receipts. A purchase order
is a record you create to authorise the purchase of goods or services from a specific vendor. Once you create the
purchase order record, you can enter line items and General Ledger distributions for each line item. In Accounts
Payable you can create three types of purchase orders: regular, blanket, and template.

Once you generate a regular purchase order from a blanket purchase order, you cannot add additional line items
to the blanket purchase order. Also, you cannot edit existing line items.

By creating a purchase order from a vendor record, you automatically associate the purchase order with that
vendor.
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On purchase order records, on the New Line Item screen, you can tick if the purchase line item is taxable, and you
can specify whether or not the line item’s unit cost includes taxes. To access the New Line Item screen, on a
purchase order record, select the Line Item tab and click New Line Item. The New Line Item screen appears.

% Mew Line Item for PO for AlphaGraphics I
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Product is taxable. If the product you are purchasing is taxable, tick this checkbox.

Amounts include tax. If you already included the tax amount in the Unit Cost of the line item, you can tick this
checkbox to prevent the program from calculating additional taxes. When you tick this checkbox, “(with tax)”
appears beside the Unit Cost and Extended Cost column headings.

Edit Tax. To edit the tax settings for this product, click Edit Tax. The Edit Sales Tax screen appears. For more
information about editing sales tax information, see “Adding GST to Products” on page 19.

Viewing GST on Receipts

Note: For detailed information and procedures for creating a new receipt record, see the Records Guide for
Accounts Payable.

If you have the optional module Purchase Orders, you can create receipts. When you create a receipt for a
purchase order, you automatically generate the entries required to reverse encumbrance transactions posted
from a purchase order. A receipt also acts as a template you can use for creating invoices for items you have
received.

Once an item on a purchase order is delivered to your organisation, you can receipt the item. A receipt consists of
two parts: the receipt record and the individual line item receipts attached to the receipt record. On the receipt
record, you enter the date the item was delivered, name of the person who received the order, and a description
of the receipt. From the receipt record, you can add, edit, and delete individual line item receipts. You can
manually create receipts for each line item or you can auto receive the purchase order.

Note: By creating a receipt record from a purchase order, you automatically associate the receipt with that
purchase order and the purchase order number is loaded by default.

If the receipt line item contains sales taxes, you can view the sales tax distribution. On the Receipt tab, click Sales
Tax. The Edit Sales Tax screen appears, however, fields on this screen are for informational purposes and cannot
be edited. This information defaults from the purchase order record.
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For detailed information and procedures for creating a new receipt record, see the Records Guide for Accounts
Payable.

i Edit Sales Tax I
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Editing Sales Tax Information

On several accounts payable record types, you can add or edit GST information on the Edit Sales Tax screen. This
screen displays the current total GST amount and the default distributions you established on the GST Tax IDS
page of Configuration. For more information about GST Tax IDs, see the Getting Started chapter.

To edit sales tax from an invoice, recurring invoice, or credit note record, click Edit Tax. The Edit Sales Tax screen
appears.
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Warning: If you are using the New Zealand version of Student Billing, the “GNR” option does not appear.

Total Tax. In the Total Tax field, select “GST”, “FRE”, or “GNR”. A GST amount appears in the total tax amount
field. You can add sales tax entity codes to the Sales Tax Entity Table on the Tables page of Configuration.

Billing Entity. This column displays the billing entity you selected in the Total Tax field. This column is for
informational purposes and cannot be edited.

Description. This column displays a description of the billing entity you selected in the Total Tax field. This
column is for informational purposes and cannot be edited.

Warning: You must enter a debit account number before saving the record.

DR Account Number. In this column, you can edit the default debit account information for the GST. You can
use the binoculars to search for accounts. To search for an account segment, click the small binoculars
button. To search for an account number, click the large binoculars button. When you enter a valid debit
account number, the description appears automatically in the DR Account Description column.

Percent. To enter distributions by percent, click the % button.
Amount. To enter distributions by amount, click the $ button.
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Note: If you do not specify a credit account for the GST item, Accounts Payable automatically uses the default
AP Summary account you set on the Default Accounts page of Configuration.

CR Account Number. In this column, you can edit the default credit account information for the GST. You can
use the binoculars to search for accounts. To search for an account segment, click the small binoculars
button. To search for an account number, click the large binoculars button. When you enter a valid credit
account number, the description appears automatically in the CR Account Description column.

Project ID. In this column, you can enter a project ID number in the Project ID column, or use the binoculars to
search for a project ID. When you enter a valid project ID number, the description appears automatically in
the Project Description column. Projects are available only with the optional module Projects and Grants.

Class. In the Class column, select a class for the distribution.

Transaction Codes. If you have the optional module Projects and Grants and have defined transaction codes,
additional columns appear based on the number of transaction codes you have defined. In the grid, select a
value for each transaction code.

DR/CR Entries. Click this button to preview the current debits and credits for the GST item.

Apply Rate. If you enter a new total tax, you can use this button to update subtotals in the Amount column for
each billing entity in the grid. The new subtotals are based on the distribution percentages you entered on the
GST Tax IDs page of Configuration.

Update Total. If you enter new tax distribution amounts in the Amount column of the grid, you can click this
button to update the total tax amount field.
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This chapter explains how the Goods and Services Tax (GST) affects the Accounts Receivable program of The
Financial Edge.

This chapter includes information about managing GST in Configuration, Records, and Reports. In Configuration,
you can designate the Australian Business Number (ABN) and GST Branch Registration number, and you can set
important business rules that determine how GST information is handled in other areas of the program.

Accounts Receivable Configuration

Configuration is where you set up Accounts Receivable to fit the needs of your organisation. For example, you
can set a business rule specifying if your organisation collects GST. Also, on the GST Tax IDS page, you can create
different GST tax items, such as the standard 10 percent GST tax, a tax free item for tax-free products and
services, and an item for unregistered organisations that have not declared an ABN. You can then select these
items to speed data entry when creating new product, flat rate, and per usage billing items.

For more information and procedures for setting the other fields in Configuration, see the Configuration Guide
for Accounts Receivable.

General Configuration

The General page is where you enter basic information about your organisation.

The address and phone information you enter on this page appears on printed documents and correspondence.
You can also designate the ABN and GST Branch Registration number on this page.

&% The Financial Edge
File Edit “iew Go Favowites Took Help
% Back & Fomwvard ] Community Services Inc, = = Accounts Receivable =
Shortubs .2 1
= Configuration * General
Organization: Community Services Inc. m
General I
Cauntry IAustlaIia j Terms
Address: 33503 Bentinck Street =] Attributes
LI Aging
Information
City: |P0|tland Business
— Rules
Shate: IV\C 'l Wictaria
Tables
Postcode: |33DE Fields
Phone: |105) 5555 5555 istribti
Distributions
GST/HST Inf = Internatio. ..
ABN |12345 Interfund
GST Branch, I Pasting
Information
GST Mot Registered Withholding Tax 10 I vl St
Information
Default
Accounts
Products
and Billing
Items
Addressee |
Salutations
welcome to Accounts Receivable

Warning: If you are a New Zealand user, enter information in the GST Registration Number field. The ABN,
GST Branch, and GST Not Registered Withholding Tax ID fields do not appear.

ABN. In the ABN field, enter the federal charitable identification number for your organisation. This number is
used in reports.
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GST Branch. In the GST Branch field, enter your organisation’s GST branch number. This number is used in
reports.

GST Not Registered Withholding Tax ID. Select a default sales tax billing item to use for vendors who do
not declare an ABN.

Business Rules Configuration

Business rules help you customise standard procedures and requirements to suit your organisation. On the
General business rules page in Accounts Receivable, you can set a business rule to designate whether your
organisation collects GST.

#% The Financial Edge
File Edit Yiew Go Favouwites Tool: Help
4 Back & Eorward I Community Services Inc. ™ + Accounts Receivable ™
Shorkcuts . . :
Configuration » Business Rules
|E| = Home =
§ '1—‘ EEEE General = || Configur-...
& » Individual/Organization General
Records b Charge " —
g ™ Use a single 4R Summary &ccount and never post Applications Terms
b Credi . . .
I ¥ Invoi I pour AR Summary Account iz in a fund that requires balancing by Net dsset Clazss, we Attributes
‘\@ nvaIsE shrangly recommend that you use a single Met Asset Class value for all Accounts
- P Invoice Line ltem Receivable tranzactions. Using mare than one Net Azzet Class value could result in Aging
I-E Export » Fecuring Invoice zome financial statements not balancing by Met Asset Class Information
i Exp0rE X -
o B Retun } Allows non-bartk. transactions to use cash accounts: | &ways j Business
b Return Line lkem Rules
b Deposit Tables
: :ZILT:;[ Automatically apply new payments: IAs defined on each client j Fields J
» Oueue Automatically apply new credits: IAs defined on zach client j Distributions
‘when entering new charges and unapplied credits or payments exist.. Inkernatia. .
alwayz apply the credits and payments automatically j Interfund
on Posting
. . Inf i
‘When applying automatically, apply to |Oldest charges j Termation
\ - Statement
Apply to owner's charges | with others' charges based on above ules j Information
Diefault
Accounts
GST: Our organization collects GST j
Froducks
1| and Billing
. . Items
Hide tranzactions on statements: IDo ot allow j
Addressee |
Salutations
Refer to "Service Provider' as IService Provider ;I
Blackbaud Systems
Welcome to Accounts Receivable |

GST. In the GST field, if your organisation collects goods and services taxes, select “Our Organisation collects
GST”

Tables Configuration

Note: Billing entities are shared between Accounts Payable, Accounts Receivable, and Student Billing. If you
create a billing entity in one program, such as Student Billing, it also appears in the other programs.

Tables increase data entry speed and accuracy throughout Accounts Receivable. When entering information into
a field with a table, you can quickly access a list of possible entries for that field, select an entry, and place it
directly into the field rather than entering it manually.

In Accounts Receivable, the Billing Entity table contains several predefined commonly used GST tax entities, such
GST, FRE (GST-free), and GNR (GST Not Registered, Withhold Payment Tax). You can also enter additional taxes,

if, for example, your city imposes a sales tax in addition to GST. You can select from these field entries when
creating several record types.
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You can click the down arrow on the right side of a field or press F4 to view a list of entries for a table. You can
also place the cursor in the field and click the down arrow on your keyboard to scroll through the entries. You can
usually enter text directly in the field, and if the program does not recognise it as a valid entry, you get a message
asking if you want to add the text as a new entry. Finally, you can place the cursor in a table field and press F7 to
access a screen on which you can view, add, edit, and delete entries.

To keep entries uniform, it is also extremely important that you limit rights for adding and editing table entries.
These rights are controlled though the Set Up System Security page of Administration. Allowing only a few key
users to add, edit, or delete table entries ensures the validity of your database, records, and reports. Maintaining
strict control over the Billing Entity table is especially important because it ensures that your tax information is
tracked and reported correctly.

For more detailed information and procedures for adding, editing, and deleting tables and table entries, see the
Configuration Guide for Accounts Receivable.
» Inserting a new Billing Entity table entry

1. On the Tables page, select the Billing Entity table. Table entries appear in a box on the right.

# The Financial Edge

File Edit Miew Go Favouwites Tools Help

4 Back ® Eorviard J Cormmunity Services Inc, ™ + Accounts Receivable ™
Shorkcuts

Configuration » Tables

BHe Home
H—r Mew Table Entry Open Delete... Inzert Sort Table Cleanup.. Up Do Configura...
" General
Iﬁ Type. |<A|| Tahles> j Shork Description Long Description Stakus ‘
. Credit Rating A GST Goods and Services Tax Act?ve TE’LJ
@ O Currenicy Type FRE GST Free Active Attributes
C Entered By GMR GST Mot Registered, Withh... Active Aging
i Information
-E:. Export Ethricity
o Finance Rate Business
FOB
Industiy
Item Category
Items
Joumal Distributions
Media Type Inkernational

MNotepad Tupe
Qther Payment Type
Payment Source

Interfund

Information

MR R

Phone Type
Relationship Statement
Religion Information
Billing E ntity
Service Provider b Accounts
L Shipping Codes Products and
a Plug-Ins Staf Billng Ttems
S0 Addressee |
5r/::- e [T LI Salutations
Blackbaud Systems | Add new table | Lelsts fable I ™ Display active entries anly

Welcome to Accounts Receivable |
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2. Inthe table entry box, select the entry below the point where to insert the new entry.

#% The Financial Edge

File Edit Wiew Go Favouites Tools Help

 Back % Farward J Cormmunity Services Inc, = + Accounts Receivable ™

Shartcuts

Configuration » Tables

Mew Table Enty Open Delete.. Insert Sort Table Cleanup.. Up Down Configura...
General
Type: |<A" Tables> j I Short Description | Long Description |Status ‘
Credit Rating 5| GST Goods and Services Tax Active UEiS J
Currency Type Attributes
Entered By GMR. GST Mot Registered, Withh... Active Aging
L3 i Infarmation
'-Du Export Ethricity JEmormat I
o Finance Rate Business
FOB
Q Reports Industry
Item Categary
Items
HJoumal Distributions
Media Type Inkernational

nks

MNotepad Type

Interfund
(Other Payment Type nterfun

HR R

miniskration Payment Source IF’quting "
Phone Type nformation
SNECE | |Fielationship gzt
Religion nformation
g Service Provider b Accounts
! Shipping Codes Products and
A a Plug-Ins Staff Eiling Ttems
{
H State ;I Addressee |

;(/‘: Helo || | EEEEEE Salutations

Add new table | DElete fate I I™ Display active entries only

Blackbaud Systems |

welcome to Accounts Receivable |

3. Click Insert. The New Table Entry screen appears.

Mew Table Entry | x|
Short description: I

Long descriphion: I

[ Inactive
akK I Cancel |

In the Short Description field, enter an abbreviation for the new billing entity.

In the Long description field, enter the full name of the new billing entity.
To make the new table entry inactive, tick Inactive.

N o v ks

To save the new table entry and return to the Tables page, click OK. The new billing entity appears above
the selected entry.

Products and Billing Items Configuration

This section contains information about creating new GST items and applying existing GST items to products and
billing items. For more information about Products and Billing Items, see the Records Guide for Accounts
Receivable.

Creating GST Items

If your organisation collects Goods and Services taxes for items or services rendered, you can establish GST billing
items. Once you establish GST billing items, you can associate them with subsequent billing item records.

Tip: You create Product and Billing Item records from the Products and Billing Items page of Configuration. For
increased efficiency, you can also create product and billing item records from the Products and Billing Items
page of Records, or to save time, directly from charge or invoice records.
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» Adding a GST item

This procedure guides you through adding a GST item from the Products and Billing Items page of
Configuration in Accounts Receivable. However, you can also add GST items, as needed, when adding charges
and entering line items on invoices. Additionally, you can add GST items from the Records page of Accounts
Receivable.

1.

LA S

7.

Note:

From the Products and Billing Items page, click the down arrow next to New Flat Rate Item and select
New GST Item. The New GST Item screen appears.

# New GST Item o=

File Edit “iew Bilingltem Favouites Tools Help

ESaveandElosev|u X|B, ﬁ| o4 b N||IQ'| Yo |

Item 1D I j Status: IActive 'l
Drescription: I
[rates: IItem can be uzed on any date j

Item | Attributes I ﬂotesl

Billing Ertity I Percent I CR &ccount Mumber | CR Account Des.. | DR Account Number | DR Account Des..
K i
¥ ‘when calculating tax for the I j through I j entities, include GST
I~ ltem iz subject to finance and late charges
Comment:

In the Item ID field, enter a unique ID for the item.
In the Status field, select “Active” or “Inactive”.
In the Description field, enter a description of the item.

In the Dates field, select “Item can be used on any date” or “Item can only be used from” and enter the
dates during which the GST can be used.

In the Billing Entity column of the grid, select a GST tax entity previously added to Billing Entity table in
Configuration. You can also enter a new entity in the column and you will be prompted to add it to the
Billing Entity table.

In the Percent column, enter the tax rate for the corresponding entity. For example, “10.00”.

An interfund entry is a balancing entry made to transfer activity between funds and ensure each fund is

kept in balance. Interfund entries are used only when you enter a debit account from a fund different from the
credit account.

8.

10.

In the CR Account and DR Account columns, enter the correct account information. You can use the
binoculars to search for accounts.

If you enter debit and credit accounts from different funds, in the Interfund field above the distribution
grid, select an interfund set to balance the accounts. If you have not created a balancing interfund set for
those accounts in Configuration, you cannot save the distribution. For more information about interfund
entries, see the Configuration Guide for Accounts Receivable.

If you have the optional module Projects and Grants, enter a project ID number in the Project ID column,
or use the binoculars to search for a project ID. When you enter a valid project ID number, the description
appears automatically in the Project Description column.
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In the Class column, select a class for the distribution.

If you have the optional module Projects and Grants and have defined transaction codes, additional
columns appear based on the number of transaction codes you have defined. In the grid, select a value for
each transaction code.

If taxes should be compounded on the first GST entity in the grid, tick When calculating tax for the []
through [] include and select the range. The options available in the range drop-down lists depend on the
number of GST entities in the grid.

You can make the item subject to both finance charges and late fees by ticking Item is subject to finance
and late charges.

In the Comments field, you can enter default comments for the item that will appear on statements.

To save the GST item record and return to the Records page, click Save and Close. To continue adding
information for this item, click the Attributes tab. For detailed procedures about entering information on
the Attributes tab, see “Adding an attribute to a GST item” on page 45.

You can also add notes for the GST tax item. For detailed procedures about adding notes, see “Adding a
note to a GST item” on page 46.

» Adding an attribute to a GST item

Note: If you tick an attribute as required in Configuration, the attribute automatically appears on the item and
you must select a description before saving.

An attribute is a reporting tool you use to group information based on a common theme. By defining
attributes, you can filter information to your specification, which is a useful feature for sorting or filtering
items for reports. You can also define the type of data stored for each item. For example, if you have defined
an attribute for income categories, you can track products and billing items by income.

Note:
1.

Attributes can be edited at any time or deleted if the attribute is not required.

From an open GST item record, select the Attributes tab.

. GST Item GSTBilling Item - GST Charges for Clients M= 3 I

File Edit “iew Bilingltem Favouites Tools Help
E]Saveandﬁlosev|u X|@§|N 1 » N|||?' |
IternD:  [GSTEiling ltem =l Status: [acive 7|

Description: IGST Charges for Clients

D ates: IItem can be uzed on any date j

HMotes I

o <Al Categories -

Attribute Type I Description Short Description Date I Required I Comments

| | P!

In the Attribute type field, select a specific attribute type or “All Categories”.
In the Attribute type column, select an attribute. Attribute types are established in Configuration.
In the Description column, select a description of the attribute.
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Note: The Short Description column and the Required checkbox are for informational purposes and are

edited only from the Attributes page of Configuration.

5. Inthe Date column, enter a date.

6. In the Comments column, enter additional information about the attribute.

7. To close the GST item record and return to the Products and Billing Items page, click Save and Close.

» Adding a note to a GST item

The Notes tab of a GST item record is an open text field where you can enter additional information about the
GST item. You can maintain data such as the purchaser’s name, the delivery date, or other important

information.

1. From an open GST item record, select the Notes tab.

2. In the text box, enter free-form text information about the GST item.

File Edit “iew Bilingltem Favouites Tools Help

ESaveandElosev|u X||ﬁ §| H 4 » N||| ?-

®_GST Item GSTBilling Item - GST Charges for Clients =] B3 |

IternD:  [GSTEiling ltem =l Status: [acive 7|

Description: IGST Charges for Clients

D ates: IItem can be uzed on any date j

Item IAttribgtes

Y|

Note: Notes can be edited or deleted at any time. Just remember that deleted notes cannot be recovered!

3. When you exit the Notes tab, your changes are saved automatically.

Adding GST to Products and Billing Items

Note: You must define at least one Product or Billing Item record before adding charges.

If your organisation collects GST, when you create a product, flat rate, or per usage item that is subject to GST,
tick Item is subject to GST. Then, you can select a related GST item or create a new GST item. Selecting an existing
GST item speeds data entry because Accounts Receivable automatically calculates the GST and applies the GST
item’s default distribution to the product, flat rate, or per usage record so you do not have to reenter that

information.
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On the Product tab of a product record, you can specify if the product is taxable, and you can select a GST billing

item.
P Product ¥ideo - Drug Awareness Yideo M= E3 I
Fle Edit “iew Bilingltem Favourtes Tools Help

E]Saveand[ﬁlosav|n X‘BL§|N 4 » “||

2.

Item ID: IVldeo j Statuis: IAct\va -

Description: IDrug Awareness Yideo

Diates: IItem can be used on any date j

Product | Pricing ﬁchedu\el GL Distrihulinnl Atmhglesl ﬂntesl

Unit price decimals: |2_j ¥ Allows user to edit unit price on transactions
Quantity decimals: |3_:||

Unit of measure: IEach

=

¥ Product is subject ko GST:

GETBiling Item 'l

I Product i subject to finance and late charges

¥ Product iz eligible for terme discournt

¥ Product iz eligible for trade discount

Service Provider:

[

Comment:

2|

Product is subject to GST. Tick this checkbox if you must collect GST for this product. In the GST field, select
the GST item you want to apply to this product. You create GST items on the Product and Billing Items page.

For more information about GST items, see “Creating a New GST ltem”.

Adding GST to Flat Rate and Per Usage Items

On the Item tab of flat rate and per usage item records, you can specify if an item is taxable, and you can select a

GST billing item.

ESaveandCIosev|u X‘&§|" 4« » "||

? .

. Per Uzage Item MS - Meeting Space =] E3 I
Ele Edit “iew Bilingltem Favourtes Tools Help

Item [D: IMS j Status: IACWB -

Description: IM eeting Space

Dates: IItem cah be uzed on any date j

Item | GL Distribution | Abtributes I ﬂotasl

Unit price decimals: |2_:|I W Allow user to edit unit price on transactions
Quantity decimals: |3_:||

Default values:

Unit of Measure I Quankity I

Urik Price I Extended Amount

Day 1.000 $200.00 $200.00

¥ ltem iz subject to GST:

G5 TRiling ltem 'l

I ltem iz subject to finance and late charges

I ltem iz eligible for terms discount

I ltem iz eligible for trade discount

Service Provider:

=l

Comment:
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Item is subject to GST. Tick this checkbox if you must collect GST for this item. In the GST field, select the GST
item you want to apply to this item. You create GST items on the Product and Billing Iltems page. For more
information about GST items, see “Creating a New GST Item”.

Accounts Receivable Records

From the Records page of Accounts Receivable, you can create products and billing items, clients, charges,
credits, invoices, recurring invoices, returns, refunds, deposits, and payments. Each of these record types can
contain information to help you track GST taxes you must pay.

In Accounts Receivable, you can create and apply GST items to products and billing items, and on the Products
and Billing Items page, you can create a new billing item for GST charges. After you create GST billing items, you
can add them as line items on other record types. You can also store ABN and GST branch information on client
records.

This chapter guides you through available GST options and fields, and it explains how they affect your
organisation. For detailed explanations of other record features, and for procedures for creating new records, see
the Records Guide for Accounts Receivable.

Warning: Before you begin adding GST information to records, you should create GST tax IDs and set business
rules in Configuration.

Before you begin adding GST information to records, you should create GST tax items and set business rules in
Configuration. For more information about Configuration, see the Getting Started chapter.

Adding a New GST Billing Item

If your organisation collects Goods and Services taxes on behalf of government bodies for items or services
rendered, you can establish GST billing items. Once you establish GST billing items, you can associate them with
subsequent billing item records.

Tip: You can also create Product and Billing Item records from the Products and Billing Items page of
Configuration, or to save time, directly from charge or invoice records.
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On the Products and Billing Items page, you can create new GST items that you can access from other records to
help track information and speed data entry. To create a new GST item, on the Products and Billing Items page,

click the down arrow next to the New Flat Rate Item button and select New GST Item. The New GST Item screen
appears.

P Hew GS5T Item !IEI
File Edit Y“iew EBilingltern Favowites Tools Help

ESaveandElosev|u Xl& ﬁl H 4 “|||g'| ?- |

Item 1D I j Status: IActive 'I
Description: |
Dates: IItem can be uged on any date j

Itermn I Attributes I Hotesl

Billing Entiky I Percent | CR Account Mumber ICR Account Desc... | DR Accounk Number IDR Account Desc...

< |

¥ when calculating tax for the I j through I

j entities, ihclude GST
[ Item is subject to finance and late charges

Caomment:

N
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» Adding a GST item

This procedure guides you through adding a GST item from the Records page of Accounts Receivable.
However, you can also add GST items, as needed, when adding charges and entering line items on invoices.
Additionally, you can add GST items from the Products and Billing Items page of Configuration in Accounts
Receivable.

1.

LA S

7.

Note:

From the Products and Billing Items page, click the down arrow next to New Flat Rate Item and select
New GST Item. The New GST Item screen appears.

P Hew GST Item M= 3 I

File Edit “iew Bilingltem Favouites Tools Help
E]Saveandﬁlosev|u X|B.E|N 4 b N|||Q'|?' |
Item [D: I j Status: IActive vl

Drescription: I

Dates: IItem can be uzed on any date j

Item | Attributes I ﬂotesl

Billing Enkity: I Percent I CR Account Mumber | CR Account Desc... | DR Account Mumber | DR Account Desc...
K i
¥ ‘when calculating tax for the I j through I j entities, include GST
I~ ltem iz subject to finance and late charges
Comment:

In the Item ID field, enter a unique ID for the item.
In the Status field, select “Active” or “Inactive”.
In the Description field, enter a description of the item.

In the Dates field, select “Item can be used on any date” or “Item can only be used from” and enter the
dates during which the GST can be used.

In the Billing Entity column of the grid, select a GST entity previously added to the Billing Entity table in
Configuration. You can also enter a new entity in the column and you will be prompted to add it to the
Billing Entity table.

In the Percent column, enter the tax rate for the corresponding entity. For example, “10.00”.

An interfund entry is a balancing entry made to transfer activity between funds and ensure each fund is

kept in balance. Interfund entries are used only when you enter a debit account from a fund different from the
credit account.

8.

10.

In the CR Account and DR Account columns, enter the correct account information. You can use the
binoculars to search for accounts.

If you enter debit and credit accounts from different funds, in the Interfund field above the distribution
grid, select an interfund set to balance the accounts. If you have not created a balancing interfund set for
those accounts in Configuration, you cannot save the distribution. For more information about interfund
entries, see the Configuration Guide for Accounts Receivable.

If you have the optional module Projects and Grants, enter a project ID number in the Project ID column,
or use the binoculars to search for a project ID. When you enter a valid project ID number, the description
appears automatically in the Project Description column.
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In the Class column, select a class for the distribution.

If you have the optional module Projects and Grants and have defined transaction codes, additional
columns appear based on the number of transaction codes you have defined. In the grid, select a value for
each transaction code.

If taxes should be compounded on the first GST entity in the grid, tick When calculating tax for the []
through [] include and select the range. The options available in the range drop-down lists depend on the
number of GST entities in the grid.

You can make the item subject to both finance charges and late fees by ticking Item is subject to finance
and late charges.

In the Comments field, you can enter default comments for the item that will appear on statements.

To save the GST item record and return to the Records page, click Save and Close. To continue adding
information for this item, click the Attributes tab. For detailed procedures about entering information on
the Attributes tab, see “Adding an attribute to a GST item” on page 45.

You can also add notes for the GST item. For detailed procedures about adding notes, see “Adding a note
to a GST item” on page 46.

» Adding an attribute to a GST item

Note: If you tick an attribute as required in Configuration, the attribute automatically appears on the item and
you must select a description before saving.

An attribute is a reporting tool you use to group information based on a common theme. By defining
attributes, you can filter information to your specification, which is a useful feature for sorting or filtering
items for reports. You can also define the type of data stored for each item. For example, if you have defined
an attribute for income categories, you can track products and billing items by income.

Note:
1.

Attributes can be edited at any time or deleted if the attribute is not required.

From an open GST item record, select the Attributes tab.

. GST Item GSTBilling Item - GST Charges for Clients M= 3 I

File Edit “iew Bilingltem Favouites Tools Help
E]Saveandﬁlosev|u X|@§|N 1 » N|||?' |
IternD:  [GSTEiling ltem =l Status: [acive 7|

Description: IGST Charges for Clients

D ates: IItem can be uzed on any date j

HMotes I

o <Al Categories -

Attribute Type I Description Short Description Date I Required I Comments

| | P!

In the Attribute type field, select a specific attribute type or “All Categories”.
In the Attribute type column, select an attribute. Attribute types are established in Configuration.
In the Description column, select a description of the attribute.
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Note: The Short Description column and the Required checkbox are for informational purposes and are

edited only from the Attributes page of Configuration.

5. Inthe Date column, enter a date.

6. In the Comments column, enter additional information about the attribute.

7. To close the GST item record and return to the Products and Billing Items page, click Save and Close.

» Adding a note to a GST item

The Notes tab of a GST item record is an open text field where you can enter additional information about the
GST item. You can maintain data such as the purchaser’s name, the delivery date, or other important

information.

1. From an open GST item record, select the Notes tab.

2. In the text box, enter free-form text information about the GST item.

File Edit “iew Bilingltem Favouites Tools Help

ESaveandElosev|u X||ﬁ §| H 4 » N||| ?-

®_GST Item GSTBilling Item - GST Charges for Clients =] B3 |

IternD:  [GSTEiling ltem =l Status: [acive 7|

Description: IGST Charges for Clients

D ates: IItem can be uzed on any date j

Item IAttribgtes

Y|

Note: Notes can be edited or deleted at any time. Just remember that deleted notes cannot be recovered!

3. When you exit the Notes tab, your changes are saved automatically.

Adding GST to Products and Billing Items

If your organisation collects GST, when you create a product, flat rate, or per usage item that is subject to GST,
tick Item is subject to GST. Then, you can select a related GST item or create a new GST item. Selecting an existing
GST item speeds data entry because Accounts Receivable automatically calculates the GST and applies the GST
item’s default distribution to product, flat rate, or per usage record so you do not have to reenter that

information.
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Adding GST to Products

On the Product tab of a product record, you can specify if the product is taxable, and you can select a GST billing
item.

R, Product Video - Drug Awareness Video [_ [Of=] I
File Edit ‘“fiew Bilingltem Favourtezs Tools Help

ESaveandElosav|u X‘& §|N 4 » N|| ?- ‘
hemiD:  [video =l

Status: IACUVB -

Description: |Drug funareness Yiden

Dates:

IItem can be used an any date j

Product | Pricing ﬁchedu\el GL Distribulionl Attnbglesl ﬂotesl

Unit price decimals: |2_j W Allow user to edit unit price on transactions
Quantity decimals: IS_:II

Unit of measure: IEach

=

W Product is subject to GST: GSTRilling Iterm 'l [+ Product is eligible for terms discount

™ Pioduct is subject ta finance and late charges

¥ Product iz eligible for trade dizcount

Service Provider:

[
Comment:

| A

Product is subject to GST. Tick this checkbox if you must collect GST for this product. In the GST field, select

the GST item you want to apply to this product. You create GST items on the Product and Billing Items page.
For more information about GST items, see “Creating a New GST Item”.

Adding GST to Flat Rate and Per Usage Items

On the Item tab of flat rate and per usage item records, you can specify if an item is taxable, and you can select a
GST billing item.

T Per Usago lom WS MestngSpace W=
Ele Edit “iew Bilingltem Favourtes Tools Help

E]Saveandtlosev|u X‘&§|K 4 » DI|||?' ‘
lemiD: M5 =l

Status: IActwa -

Description: IM eeting Space
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Item | GL Distribution | Abtributes I ﬂotasl

Unit price decimals: |2_:|I W Allow user to edit unit price on transactions
Quantity decimals: |3_:||

Default values: Unit of Measure I

Quantity | Unit Price |
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¥ ltem iz subject to GST: G5 TRiling ltem vl ™ Itemn iz eligible far terms discount

I ltem iz subject to finance and late charges

Extended Amount I
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Day
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=l

Service Provider:

Comment:
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Item is subject to GST. Tick this checkbox if you must collect GST for this item. In the GST field, select the GST
item you want to apply to this item. You create GST items on the Product and Billing Items page. For more
information about GST items, see “Creating a New GST Item”.

Adding GST Information to Clients

Note: Individual client records do not contain GST information.

On organisation client records, you can add ABN and GST branch information that appears automatically when
you create invoices, invoice line items, and charges for that client. That way, you do not have to type that
information on every new record. On the client Activity tab, you can view, open, and edit invoice and charge
records, including GST items. For more information about invoices, see “Adding GST to Invoices and Recurring
Invoices” on page 50. For more information about charges, see “Adding GST to Charges” on page 49.

To enter an ABN or GST branch information on an organisation record, select the Client 1 tab.

® M= 3

File Edit “iew Client Favourtes Toole Help
[ 5ave and Close ~ U|&§|H 1 » N|E|||?* ‘

EFT Barks I Recuring I Automatic Payments | History of Changes I Activity
Client 1 | Cliert 2 I D efault: I Addreszes I Attriputes I Motes | Media I Actions I Relationships I Bayers I Statements

Client name: |
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Clisnt type: | =l

L L

Service Provider: I City: I

ABM: |1E| 283 746 573 State: I 'I
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Indugtn: I j Cantach: | |
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Warning: If you are a New Zealand user, enter information in the GST Registration Number field. The ABN field
does not appear.

ABN. In the ABN field, enter the client’s Australian Business Number (ABN) or Tax File Number (TFN).

GST Branch. In the GST Branch field, enter the GST branch number for the vendor. The GST Branch number is
used for reporting.
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Adding GST to Charges

When you create a charge record that contains GST, Account Receivable automatically creates a separate charge
record containing the GST item. For example, Dr Mary Young purchases T-shirts for which you must charge GST.
The last charge on file is number 1022. When you create the charge record for the T-shirts, the program
automatically creates charge 1023 for the GST item, and the charge you created for the order is given number
1024.

When you click Edit GST, the program opens the GST charge record so you can edit the GST item description. All
other fields are locked and cannot be edited.

. MNew Charge [_ O] =]
File Edit ‘“iew Tranzaction Favourtes Tool: Help
ESaveandClosev|u X|B, ﬁ||‘ 4 & N|'}§||I§'|?' |
Tranzaction |§L Distributionl F'agmentsfcreditsl .&ttribgtestotesI
|Eharge 1D
Eharge for: Clierit Name | Cliert 1D | T { AEN |
&
Transaction date: |D2£24J’ZDDB Diue date: I
Post status/date: | Not yet posted | ¥ | [02/24/2008
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Buantity/price: Unit of Measure I Cuantity Unit Price I Extended Amount
EdtasT | | =l
Comment: I
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|Press F7 far Client Search |Am0unt: $0.00 |Balance: $0.00 | y

TFN/ABN. The TFN/ABN column of the grid displays the ABN or TFN you entered on the client record. This
column is locked and cannot be edited. To change this number, open the client record.

Edit GST. To edit the tax settings for this charge, click Edit GST. A charge record containing the GST item appears
so you can edit the GST item description. All other fields are locked and cannot be edited.

In the GST field, select the GST item you want to apply to this charge. You create GST items on the Product and
Billing Items page. For more information about GST items, see “Adding a GST item” on page 44.

Adding GST to Credits

When you create a credit record that contains GST, Account Receivable automatically creates a separate credit
record containing the GST item. For example, you create a credit for Dr Mary Young that includes GST. The last
credit on file is number 517. When you create the new credit record, the program automatically creates charge
518 for the GST item, and the credit you created is given number 519.



50 CHAPTER

When you click Edit GST, the program opens the GST credit record so you can edit the GST item description. All
other fields are locked and cannot be edited.

Bl Mew Credit |- (O] %]

File Edit “iew Transaction Fawourtes Toolz Help

ESaveandElose-|u X|B. ﬁ|“ 4 "|%||g‘
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TFN/ABN. The TFN/ABN column of the grid displays the ABN or TFN you entered on the client record. This
column is locked and cannot be edited. To change this number, open the client record.

Edit GST. To edit the tax settings for this credit, click Edit GST. A credit record containing the GST item appears so
you can edit the GST item description. All other fields are locked and cannot be edited.

In the GST field, select the GST item you want to apply to this credit. You create GST items on the Product and
Billing Items page. For more information about GST items, see “Adding a GST item” on page 44.

Adding GST to Invoices and Recurring Invoices

Invoices are essential for maintaining information about client bills and tracking outstanding accounts receivable.
On invoice and recurring invoice records, you can easily view line items added to the invoice, apply discounts, and
view applied payments and credits. You can also edit GST information and apply GST to the invoice line items.
Adding GST to invoice line items ensures you can quickly and easily produce an accurate accounting of GST you
collect.

Note: In Accounts Receivable, you manage recurring invoices on the Recurring Invoices page of Records. For
more information about recurring invoices, see the Recurring Invoices chapter.

In Accounts Receivable, you can create two types of invoices: regular and recurring. A regular invoice is a
payment request you send to clients for goods or services rendered, while a recurring invoice is a template you
use to create a regular invoice according to a schedule. Accounts Receivable invoices are not posted, instead, you
post the invoice’s line items. Recurring invoices are also never posted or included in any balance calculation. In
Accounts Receivable, recurring invoices are entered, edited, and deleted from the Recurring Invoices page of
Records.
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In Accounts Receivable, you cannot post an invoice, but you can post the invoice’s line items. In other words,
invoices are “containers” that hold line items. Invoice line items are individual charges added to a client’s record
SO you can maintain an accurate accounting of purchases and bill accordingly. The charge records you create
when you add an invoice line item can be posted later. For more information about charge records, see the
Records Guide for Accounts Receivable.

GST fields are identical on invoice and recurring invoice records.

ENewinvoice ——— —— ——— ——————— EEH|
File Edit “iew Transaction Favourtes Toolz Help
[ 5ave and Close - UX|B, ﬁ|" 4 » H||Ig'|?' |
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TFN/ABN. The TFN/ABN column of the grid displays the ABN or TFN you entered on the client record. This
column is locked and cannot be edited. To change this number, open the client record.

Note: For detailed information and procedures for creating a new invoice or recurring invoice record, see the
Records Guide for Accounts Receivable.

GST. In the GST field, you can select a GST item to use as the default on invoice line items.

Viewing GST on Returns

In Accounts Receivable, if you make an error when entering invoices, you can create a return record that reverses
all or part of the invoice. The return record then appears on the Payments/Credits tab. You cannot reverse
standalone invoices that do not contain line items. To reverse an entire invoice, from the menu bar, select
Transaction, Reverse Entire Invoice. To reverse part of an invoice, select Transaction, Reverse Portion of Invoice.
For more information about returns, see the Returns chapter.
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On the Line Item tab of a return record, in the GST field at the bottom of the screen, you can view the returned

amount of GST.
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This chapter explains how the Goods and Services Tax (GST) affects the Student Billing program of The Financial
Edge.

This chapter includes information about managing GST in Configuration, Records, and Reports. In Configuration,
you can designate the Australian Business Number (ABN) and GST Branch Registration number, and you can set
important business rules that determine how GST information is handled in other areas of the program.

Student Billing Configuration

Configuration is where you set up Student Billing to fit the needs of your organisation. For example, you can set a
business rule specifying if your organisation collects GST. Also, on the GST Tax IDS page, you can create different
GST tax items, such as the standard ten percent GST tax, a tax free item for tax-free products and services, and an
item for unregistered organisations that have not declared an ABN. You can then select these items to speed data
entry when creating new product, flat rate, and per usage billing items.

For more information and procedures for setting the other fields in Configuration, see the Configuration Guide for
Student Billing.

General Configuration

The General page is where you establish basic information about your organisation.

The address and phone information you enter on this page appears on printed documents and correspondence.
You can also designate the ABN and GST Branch Registration number on this page.

&% The Financial Edge

File Edit “iew Go Favowites Took Help
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Fress FF to zoom

Warning: If you are a New Zealand user, enter information in the GST Registration Number field. The ABN,
GST Branch, and GST Not Registered Withholding Tax ID fields do not appear.

ABN. In the ABN field, enter the federal charitable identification number for your organisation. This number is
used in reports.
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GST Branch. In the GST Branch field, enter your organisation’s GST branch number. This number is used in
reports.

GST Not Registered Withholding Tax ID. Select a default sales tax billing item to use for vendors who do
not declare an ABN.

Business Rules Configuration

Business rules help you customise standard procedures and requirements to suit your organisation. On the

General business rules page in Student Billing, you can set a business rule to designate whether your organisation
collects GST.
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GST. In the GST field, if your organisation collects goods and services taxes, select “Our Organisation collects
GST”

Tables Configuration

Note: Billing entities are shared between Accounts Payable, Accounts Receivable, and Student Billing. If you
create a billing entity in one program, such as Student Billing, it also appears in the other programs.

Tables increase data entry speed and accuracy throughout Student Billing. When entering information into a
field with a table, you can quickly access a list of possible entries for that field, select an entry, and place it directly
into the field rather than entering it manually.

In Student Billing, the Billing Entity table contains several predefined commonly used GST tax entities, such GST,
FRE (GST-free), and GNR (GST Not Registered, Withhold Payment Tax). You can also enter additional taxes, if, for

example, your city imposes a sales tax in addition to GST. You can select from these field entries when creating
several record types.
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You can click the down arrow on the right side of a field or press F4 to view a list of entries for a table. You can

also place the cursor in the field and click the down arrow on your keyboard to scroll through the entries. You can
usually enter text directly in the field, and if the program does not recognise it as a valid entry, you get a message
asking if you want to add the text as a new entry. Finally, you can place the cursor in a table field and press F7 to

access a screen on which you can view, add, edit, and delete entries.

To keep entries uniform, it is also extremely important that you limit rights for adding and editing table entries.
These rights are controlled though the Set Up System Security page of Administration. Allowing only a few key
users to add, edit, or delete table entries ensures the validity of your database, records, and reports. Maintaining
strict control over the Billing Entity table is especially important because it ensures that your tax information is

tracked and reported correctly.

For more detailed information and procedures for adding, editing, and deleting tables and table entries, see the

Configuration Guide for Student Billing.

» Inserting a new Billing Entity table entry

1.

On the Tables page, select the Billing Entity table. Table entries appear in a box on the right.
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2. Inthe table entry box, select the entry below the point where to insert the new entry.
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3. Click Insert. The New Table Entry screen appears.

Mew Table Entry | x|
Short description: I

Long descriphion: I

[ Inactive
akK I Cancel |

In the Short Description field, enter an abbreviation for the new sales tax entity.

In the Long description field, enter the full name of the new sales tax entity.
To make the new table entry inactive, tick Inactive.

N o v ks

To save the new table entry and return to the Tables page, click OK. The new sales tax entity appears
above the selected entry.

Products and Billing Items Configuration

This section contains information about creating new GST items and applying existing GST items to products and
billing items. For more information about Products and Billing Items, see the Records Guide for Student Billing.

Creating GST Items

If your organisation collects Goods and Services taxes on behalf of government bodies for items or services
rendered, you can establish GST billing items. Once you establish GST billing items, you can associate them with
subsequent billing item records.

Tip: You create Product and Billing Item records from the Products and Billing Items page of Configuration. For
increased efficiency, you can also create product and billing item records from the Products and Billing Items
page of Records, or to save time, directly from charge or invoice records.
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» Adding a GST item

This procedure guides you through adding a GST item from the Products and Billing Items page of
Configuration in Student Billing. However, you can also add GST items, as needed, when adding charges and
entering line items on invoices. Additionally, you can add GST items from the Records page of Student Billing.

1. From the Products and Billing Items page, click the down arrow next to New Flat Rate Item and select

vk W

New GST Item. The New GST Item screen appears.
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In the Item ID field, enter a unique ID for the item.
In the Status field, select “Active” or “Inactive”.
In the Description field, enter a description of the item.

In the Dates field, select “Item can be used on any date” or “Item can only be used from” and enter the
dates during which the GST can be used.

In the Billing Entity column of the grid, select a GST entity previously added to the Billing Entity table in
Configuration. You can also enter a new entity in the column and you will be prompted to add it to the
Billing Entity table.

In the Percent column, enter the tax rate for the corresponding entity. For example, “10.00”.

In the CR Account and DR Account columns, enter the correct account information. You can use the
binoculars to search for accounts.

Note: An interfund entry is a balancing entry made to transfer activity between funds and ensure each fund is
kept in balance. Interfund entries are used only when you enter a debit account from a fund different from the
credit account.

9.

10.

11.

If you enter expense and payables accounts from different funds, in the Interfund field above the
distribution grid, select an interfund set to balance the accounts. If you have not created a balancing
interfund set for those accounts in Configuration, you cannot save the distribution. For more information
about interfund entries, see the Configuration Guide for Student Billing.

If you have the optional module Projects and Grants, enter a project ID number in the Project ID column,
or use the binoculars to search for a project ID. When you enter a valid project ID number, the description
appears automatically in the Project Description column.

In the Class column, select a class for the distribution.
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13.

14.

15.
16.
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If you have the optional module Projects and Grants and have defined transaction codes, additional

columns appear based on the number of transaction codes you have defined. In the grid, select a value for
each transaction code.

If taxes should be compounded on the first tax entity in the grid, tick When calculating tax for the []

through [] include and select the range. The options available depend on the number of billing entities in
the grid.

You can make the item subject to both finance charges and late fees by ticking Item is subject to finance
and late charges.

In the Comments field, you can enter default comments for the item that will appear on statements.

To save the GST item record and return to the Records page, click Save and Close.To continue adding
information for this item, click the Attributes tab. For detailed procedures about entering information on
the Attributes tab, see “Adding an attribute to a GST item” on page 59.

You can also add notes for the sales tax item. For detailed procedures about adding notes, see “Adding a
note to a GST item” on page 60.

» Adding an attribute to a GST item

Note:

If you tick an attribute as required in Configuration, the attribute automatically appears on the item and

you must select a description before saving.

An attribute is a reporting tool you use to group information based on a common theme. By defining
attributes, you can filter information to your specification, which is a useful feature for sorting or filtering
items for reports. You can also define the type of data stored for each item. For example, if you have defined
an attribute for income categories, you can track products and billing items by income.

Note:

1.

2.
3.
4.

Attributes can be edited at any time or deleted if the attribute is not required.

From an open sales tax item record, select the Attributes tab.

. GST Item GSTBilling Item - GST Charges for Clients M= 3 I

File Edit “iew Bilingltem Favouites Tools Help

ESaveandElosev|u X|@§|N 1 » N|||?' |
ltemID:  [E5TBiling ltem =l Status: [actve =]

Description: IGST Charges for Clients

D ates: IItem can be uzed on any date j

| Motes I

o <Al Categories -

Attribute Type I Description Short Description Date I Required I Comments

| | P!

In the Attribute type field, select a specific attribute type or “All Categories”.

In the Attribute type column, select an attribute. Attribute types are established in Configuration.
In the Description column, select a description of the attribute.
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Note: The Short Description column and the Required checkbox are for informational purposes and are

edited only from the Attributes page of Configuration.

5. Inthe Date column, enter a date.

6. In the Comments column, enter additional information about the attribute.

7. To close the GST item record and return to the Products and Billing Items page, click Save and Close.

» Adding a note to a GST item

The Notes tab of a GST item record is an open text field where you can enter additional information about the
sales tax item. You can maintain data such as the purchaser’s name, the delivery date, or other important

information.

1. From an open GST item record, select the Notes tab.

2. In the text box, enter free-form text information about the GST item.

File Edit “iew Bilingltem Favouites Tools Help

ESaveandElosev|u X||ﬁ §| H 4 » N||| ?-

®_GST Item GSTBilling Item - GST Charges for Clients =] B3 |

IternD:  [GSTEiling ltem =l Status: [acive 7|

Description: IGST Charges for Clients

D ates: IItem can be uzed on any date j

Item IAttribgtes

Y|

Note: Notes can be edited or deleted at any time. Just remember that deleted notes cannot be recovered!

3. When you exit the Notes tab, your changes are saved automatically.

Adding GST to Products and Billing Items

If your organisation collects GST, when you create a product or billing item that is subject to GST, tick Item is
subject to GST. Then, you can select a related GST item or create a new GST item. Selecting an existing GST item
speeds data entry because Student Billing automatically calculates the GST and applies the GST item’s default
distribution to the product or billing item record so you do not have to reenter that information.
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Adding GST to Products

On the Product tab of a product record, you can specify if the product is taxable, and you can select a GST billing
item.

= Product Yideo - Drug Awareness Yideo M=l E3 I

File Edit ¥“iew Bilingltemm Favourtes Toolz Help
ESaveandElosev|u )(||§ §|“ 4 » "| B2 |
Itern |0 |Video =] Status: m

Description: |Drug Awarensss Video

Dates: Iltem can be uzed on any date j

Product | Pricing §chedule| GL Distribution' Attribgtesl ﬂotesl

Unit price decimals: |2_:Il I Allow user to edit unit price on transactions
Quantity decimals: IB_j

Urit of measure: IEach j

W Product is subjsct to GST: IGSTBiIIing Ikem vl ¥ Product is eligible for terms discount
™ Product is subjsct to finance and late charges W Product is eligibls for rade discount
Service Provider: I j

Comment:

[ | ¢

Product is subject to GST. Tick this checkbox if you must collect GST for this product. In the GST field, select
the GST item you want to apply to this product. You create GST items on the Product and Billing Items page.
For more information about GST items, see “Adding a GST item” on page 58”".
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Adding GST to Flat Rate, Per Usage, TRP, and Automatic Billing Items

On the Item tab of billing item records, you can specify if an item is taxable, and you can select a GST billing item.

. Per Usage Item M5 - Meeting Space [ [=] E3 I

File Edt “iew Bilingltem Favourites Toolz Help
E]Saveandﬁlosev|u )(||3§|“ 4 » “|| 9. ‘

Item |0 IMS j Status: IActive - l

Description: |Meeting Space

Dates: Iltem can be uged on any date j

Item |§L Distributionl Attlibgtesl ﬂotesl

Unit price decimnals: |2_j ¥ Allow user to edit unit price on transactions
Gluantity decimals: |3_:I|

Default values: Unit of Measure | Quantity | Uniit: Price: I Extended Amount |
Day 1.000 $200.00 $200.00

¥ Item is subject ko GST: IGSTBiIIing Item vI [ Item iz eligible for terms discount

I~ Item is subject to finance and late charges I Item is eligible for trade discount

Service Provider: I j

Comment:

| | 7

Item is subject to GST. Tick this checkbox if you must collect GST for this item. In the GST field, select the GST
item you want to apply to this item. You create GST items on the Product and Billing ltems page. For more
information about GST items, see “Adding a GST item” on page 58.

Student Billing Records

From the Records page of Student Billing, you can create products and billing items, students, individuals,
organisations, charges, credits, invoices, recurring invoices, returns, refunds, deposits, and payments. Each of
these record types can contain information to help you track sales taxes you collect.

In Student Billing, you can create and apply GST items to products and billing items, and on the Products and
Billing Items page, you can create a new billing item for GST charges. After you create GST billing items, you can
add them as line items on other record types. You can also store ABN and GST branch information on
organisation records.

This chapter guides you through available GST options and fields, and it explains how they affect your
organisation. For detailed explanations of other record features, and for procedures for creating new records, see
the Records Guide for Student Billing.

Warning: Before you begin adding GST information to records, you should create GST tax IDs and set business
rules in Configuration.

Before you begin adding GST information to records, you should create GST tax items and set business rules in
Configuration. For more information about Configuration, see the Getting Started chapter.
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Adding a New GST Billing Item

If your organisation collects Goods and Services taxes on behalf of government bodies for items or services
rendered, you can establish GST billing items. Once you establish GST billing items, you can associate them with
subsequent billing item records.

Tip: You can also create Product and Billing Item records from the Products and Billing Items page of
Configuration, or to save time, directly from charge or invoice records.

On the Products and Billing Items page, you can create new GST items that you can access from other records to
help track information and speed data entry. To create a new GST item, on the Products and Billing Items page,
click the down arrow next to the New Flat Rate Item button and select New GST Item. The New GST Item screen
appears.

T New GST Item !Iil

File Edit Y“iew Bilinglten Favourites Tools Help

ESaveandClosev|n XlB, ﬁl H 4 “|||g'| ? - |

Itern ID: | =] Status: IActive VI
Diescription: I
Dates: IItem cah be uzed on any date j

Item I Attributes I ﬂotesl

Billing Entiky I Percent | CR Account Mumber ICR Account Desc... | DR Accounk Number IDR Account Desc...

Ki i
¥ 'when calculating tax for the | j thravgh I j entities, include GST

I~ Itemis subject to finahce and late charges

Camment:
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» Adding a GST item

This procedure guides you through adding a GST item from the Records page of Student Billing. However, you
can also add GST items, as needed, when adding charges and entering line items on invoices. Additionally, you
can add GST items from the Products and Billing Items page of Configuration in Student Billing.

1. From the Products and Billing Items page, click the down arrow next to New Flat Rate Item and select
New GST Item. The New GST Item screen appears.

P Hew GST Item M= 3 I

File Edit “iew Bilingltem Favouites Tools Help

ESaveandElosev|u X|B, ﬁ| H 4 » N||IQ'| ?- |

Item [D: I j Status: IActi\.-e VI
Drescription: I
Dates: IItem can be uzed on any date j

Item | Attributes I ﬂotesl

Billing Enkity: I Percent I CR Account Mumber | CR Account Desc... | DR Account Mumber | DR Account Desc...
K i
¥ ‘when calculating tax for the I j through I j entities, include GST
I~ ltem iz subject to finance and late charges
Comment:

| A

In the Item ID field, enter a unique ID for the item.
In the Status field, select “Active” or “Inactive”.
In the Description field, enter a description of the item.

vk W

In the Dates field, select “Item can be used on any date” or “Item can only be used from” and enter the
dates during which the GST can be used.

6. In the Billing Entity column of the grid, select a GST entity previously added to the Billing Entity table in
Configuration. You can also enter a new entity in the column and you will be prompted to add it to the
Billing Entity table.

7. Inthe Percent column, enter the tax rate for the corresponding entity. For example, “10.00”.

In the CR Account and DR Account columns, enter the correct account information. You can use the
binoculars to search for accounts.

9. If you enter debit and credit accounts from different funds, in the Interfund field above the distribution
grid, select an interfund set to balance the accounts. If you have not created a balancing interfund set for
those accounts in Configuration, you cannot save the distribution. For more information about interfund
entries, see the Configuration Guide for Student Billing.

10. If you have the optional module Projects and Grants, enter a project ID number in the Project ID column,
or use the binoculars to search for a project ID. When you enter a valid project ID number, the description
appears automatically in the Project Description column.

11. In the Class column, select a class for the distribution.

12. If you have the optional module Projects and Grants and have defined transaction codes, additional
columns appear based on the number of transaction codes you have defined. In the grid, select a value for
each transaction code.
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13. If taxes should be compounded on the first GST entity in the grid, tick When calculating tax for the []
through [] include and select the range. The options available in the range drop-down lists depend on the
number of GST entities in the grid.

14. You can make the item subject to both finance charges and late fees by ticking Item is subject to finance
and late charges.

15. In the Comments field, you can enter default comments for the item that will appear on statements.

16. To save the GST item record and return to the Records page, click Save and Close. To continue adding
information for this item, click the Attributes tab. For detailed procedures about entering information on
the Attributes tab, see “Adding an attribute to a GST item” on page 65.

You can also add notes for the GST item. For detailed procedures about adding notes, see “Adding a note
to a GST item” on page 66.

» Adding an attribute to a GST item

Note: If you tick an attribute as required in Configuration, the attribute automatically appears on the item and
you must select a description before saving.

An attribute is a reporting tool you use to group information based on a common theme. By defining
attributes, you can filter information to your specification, which is a useful feature for sorting or filtering
items for reports. You can also define the type of data stored for each item. For example, if you have defined
an attribute for income categories, you can track products and billing items by income.

Note: Attributes can be edited at any time or deleted if the attribute is not required.

1. From an open GST item record, select the Attributes tab.

®_GST Item GSTBilling Item - GST Charges for Clients =] B3 |

File Edit “iew Bilingltem Favouites Tools Help
E]Saveandﬁlosev|u X|@§|N 1 » N|||?' |
IternD:  [GSTEiling ltem =l Status: [acive 7|

Description: IGST Charges for Clients

D ates: IItem can be uzed on any date j

HMotes I

<Al Categories> -

Attribute Type I Description Short Description Date I Required I Comments

| | P!

2. Inthe Attribute type field, select a specific attribute type or “All Categories”.
3. Inthe Attribute type column, select an attribute. Attribute types are established in Configuration.
4. In the Description column, select a description of the attribute.

Note: The Short Description column and the Required checkbox are for informational purposes and are
edited only from the Attributes page of Configuration.
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5. Inthe Date column, enter a date.

6.

In the Comments column, enter additional information about the attribute.

7. To close the GST item record and return to the Products and Billing Items page, click Save and Close.

» Adding a note to a GST item

The Notes tab of a GST item record is an open text field where you can enter additional information about the
GST item. You can maintain data such as the purchaser’s name, the delivery date, or other important

information.

1. From an open GST item record, select the Notes tab.

2. Inthe text box, enter free-form text information about the GST item.
[TGST o G TBiling iom - 65T Charges forChomts _____________ BmIEA|
File Edit “iew Bilingltem Favouites Tools Help
E]Saveandﬁlosev|u X|@§|N 4 » N|||?' |
ltem|D:  [E5TBilling ltem =l Status: [active 4|
Description: IGST Charges for Clients
D ates: IItem can be uzed on any date j
Item IAttribgtes
=
=
| A
Note:

Notes can be edited or deleted at any time. Just remember that deleted notes cannot be recovered!

3. When you exit the Notes tab, your changes are saved automatically.

Adding GST to Products and Billing ltems

If your organisation collects GST, when you create a product or billing item that is subject to GST, tick Item is
subject to GST. Then, you can select a related GST item or create a new GST item. Selecting an existing GST item
speeds data entry because Student Billing automatically calculates the GST and applies the GST item’s default
distribution to the product or billing item record so you do not have to reenter that information.
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Adding GST to Products

On the Product tab of a product record, you can specify if the product is taxable, and you can select a GST billing
item.

P Product Video - Drug Awareness Yideo [_ (O]
File Edit ‘“fiew Bilingltem Favourtezs Tools Help
[ 5aveardClose~| |l X (A S W 4 » W3] H| 2~

Iterm [D: |Videu ﬂ Status:  |actve -

Description: |Drug funareness Yiden

Dates: |Item can be used an any date j

Product | Pricing ﬁchedu\e] GL Distribulion] Attnbgles] ﬂotes]
Unit price decimals: |2— j
Guantity decimals: |3— j

[v Allow uzer to edit unit price on ransactions

Unit of measure: |Each

GSTRiling Item - [V Product is eligible for terms dizcount

[~ Pioduct is subject to finance and late charges

¥ Product is subject to GST:

[V Product is eligible for trade discount

I

Service Provider:

Comment:

Product is subject to GST. Tick this checkbox if you must collect GST for this product. In the GST field, select

the GST item you want to apply to this product. You create GST items on the Product and Billing Items page.
For more information about GST items, see “Adding a New GST Billing ltem” on page 63”.

Adding GST to Flat Rate, Per Usage, TRP, and Automatic Billing Items

On the Item tab of billing item records, you can specify if an item is taxable, and you can select a GST billing item

P_ Per Usage Item MS - Meeting Space M= E
File Edit “iew Bilingltem Favouwites Tools Help

[ Save andClose~ | [ ™| (& S H 4 » MW (G5 2 -

Itemn 10 |MS ﬂ Statusz: m

Description: |Meeting Space

Dates: |Item can be used on any date ﬂ
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Unit price decimals: |2— j v Allow user to edit unit price on transactions
Quantity decimals: |3_ j

Default values: Unit of Measure | Quantity Unit Price | Extended Amount |
Day 1,000 $200.00 $200.00
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Item is subject to GST. Tick this checkbox if you must collect GST for this item. In the GST field, select the GST
item you want to apply to this item. You create GST items on the Product and Billing Items page. For more
information about GST items, see “Adding a New GST Billing Item” on page 63.

Adding GST to Organisations

Note: Individual and student records do not contain GST information.

On organisation records, you can add ABN and GST branch information. The ABN appears automatically when
you create transactions such as charges and credits for that organisation. That way, you do not have to type that
information on every new record. You can use the GST branch as a filter in queries. On the organisation Activity
tab, you can view, open, and edit charge records, including GST items. For more information about charges, see
“Adding GST to Charges” on page 68.

To enter an ABN or GST branch information on an organisation record, select the Bio 1 tab.

) New Organisation =] E3

File Edit “iew QOrganisation Favourtes Toole Help
ESaveandCIosev|H|&v|H 4 » H|?|U|||§'|?' ‘

Automatic F'a_l,lmentsl Agtions | Attributes I Motes I Media | Hiztory I
Bia 1 I Eiogl Addresses I Relationzhips I Activity | Bill Codes | Default Schedules | Payers | Statements I EFT Banks I

M ame: | Country: IAustraIia j
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Type: I j State: Iﬁ
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|Press F7 to z0om |Student Biling | i

Warning: If you are a New Zealand user, enter information in the GST Registration Number field. The ABN field
does not appear.

ABN. In the ABN field, enter the organisation’s Australian Business Number (ABN).

GST Branch. In the GST Branch field, enter the GST branch number for the client. The GST Branch number is
used for reporting.

Adding GST to Charges

When you create a charge record that contains GST, Student Billing automatically creates a separate charge
record containing the GST item. For example, Dr Mary Young purchases T-shirts for which you must charge GST.
The last charge on file is number 1022. When you create the charge record for the T-shirts, the program
automatically creates charge 1023 for the GST item, and the charge you created for the order is given number
1024.
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When you click Edit GST, the program opens the GST charge record so you can edit the GST item description. All
other fields are locked and cannot be edited.

B New Charge |- (O] %]
File Edit “iew Transaction Fawourtes Toolz Help
ESaveandElose-|u X|& ﬁ||‘ 4 b N|'}§||Q‘ ? - |
Tranzaction |§L Distributionl Pa}gments#[ﬁreditsl Attribgtes;’NotesI
|Chalge 1D
Charge far. Record Name | Record ID | TFM | 28BN I
&
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Comment: I
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TFN/ABN. The TFN/ABN column of the grid displays the TFN or ABN you entered on the individual or
organisation record. This column is locked and cannot be edited. To change this number, open the individual

or organisation record.

Edit GST. To edit the tax settings for this charge, click Edit GST. A charge record containing the GST item appears
so you can edit the GST item description. All other fields are locked and cannot be edited.

In the GST field, select the GST item you want to apply to this charge. You create GST items on the Product and
Billing Items page. For more information about GST items, see “Adding a GST item” on page 64.
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In Accounts Payable, you can make payments from the Banks page. You can print cheques, record bank drafts,
create and edit one-time cheques, and create manual cheques.

You can pay all invoices associated with a bank account or select payments to make based on a series of filters.

For example, you can select invoices for payment based on a due date or a discount expiry date. You can also
make payments for one vendor or all vendors.

Glossary: A one-time cheque is a direct disbursement to an individual or company not maintained as a vendor
in the database.

A one-time cheque is paid to an individual or business not maintained as a vendor in your database. A manual
cheque is a handwritten cheque for which you only record the information in your database.

Printing Cheques and Recording Bank Drafts

When you click Print cheques and record bank drafts, you access the Create Payments screen where you select

the records and set up printing options for the payments. The Create Payments screen has tabs on which you set
parameters: General, Filters, Invoices, One-Time Cheques, and Format.

Note: To stop processing a payment run, click Cancel at the bottom of the screen.

To move among the tabs, click Next and Back at the bottom of the screen or select the tab itself. On these tabs
you specify the records to include in the payment run and how the payments should look. Once you have
selected parameters for the payment run, you can make the payments by clicking Create Now at the bottom of
the screen. To save the parameters and make the payments later, click Create Later.

» Creating a payment

1. From Payment tasks on the Banks page, click Print cheques and record bank drafts. The Create Payments
screen opens to the General tab.

E= Create Payments
File Edit iew Help

BRI

i| 2 Filters I 3 Invaices I 4: One-Time Cheques] 5 Format]

Payment Run

Papment date: Today - Pay all vendars in this payment i | Based on payment methad =
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Fost date: Payment date b
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¥ Include invoices with discounts that expire on or before |10/15/2006

Printer Options

Print repart to this printer: |\\2KPF||NT1 \DOCEK, ﬂ

Frint payrents ta this printer: | j

[¥ Pause printing between payment types

[T Create an output query of payments

‘ Mext > | Cancel | Create Later | Create Mow
E Irvoice(s) approved: $4,484.64 2 One-Time Chequels] approved: $720.00

2. In the Payment date field, select a date for the payments you are creating. You can select “Today”,
“Period end date”, or “Specific date”. If you select “Specific date”, enter the date.

3. Inthe Pay all vendors in this payment run field, select the method to use when you pay invoices. You can
select “By Computer cheque”, or “Based on payment method”.
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10.
11.

12.
13.

14.

15.

Note:
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In the Calculate discounts as of field, select a date for the program to use to determine whether
discounts are valid or expired. If none of the selected invoices have discounts, the program ignores this
date.

In the Post status field, select the status the payment should be after it is made.
In the Post date field, select a post date. If you select “Specific Date”, enter a date.
In the Invoice due date on or before field, enter a date.

To pay invoices before discounts expire, tick Include invoices with discounts that expire on or before and
enter an expiry date in the field.

In the Print report to this printer field, select the printer on which to print the Pre-payment Report.
In the Print payments to this printer field, select the printer on which to print the cheques.

If you are making different types of payments or want to change paper during the payment run, tick
Pause printing between payment types.

To create an output query of the payment run, tick Create an output query of payments.
Click Next or select the Filters tab.

ES Create Payments
File Edit “iew Help
&2 |
Step 1: General | 3 Invoices | 4 One-Time Ehequesl & Fnrmatl
Filters I Include I Selected Filkers
Wendors Al <Al Wendors >
Invoices Al <Al Invoices =
Banks Selected Operating
< Back | Hexst > I Cancel | Create Later | LCreate Mow
‘ |B Invoice(s) approved: $4.484 64 |2 One-Time Chegue(s] approved: $720.00

To access the Selected <Filter> screen, select a filter in the grid and click Open on the action bar. For
example, click Vendors in the Filters column, click Open, and the Selected Vendors screen appears.

To remove filters, click Clear Filters. The Include column displays All for every filter.

The Filters column lists vendors, invoices, and banks as the filters available for payments. You cannot

edit this column.

16.

In the Include column, select “All” or “Selected”. If you choose “Selected”, the Selected <Filter> screen
opens so you can designate specific filters. The filters you specify appear in the Selected Filters column.
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17. Click Next or select the Invoices tab.

= Create Payments
File Edit iew Help
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Date Due Payment Amaunt
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L] | i
Irvoice number 333 = Patential discount | $0.90 Credit applied $0.00 =

Invoice date 09/09/2008 Dizcount expires | 09/14/2008 Dizzount amount | $0.00

Ireecice amaount $45.00 Unpaid balance |$45.00 Balance due now | $45.00

Amount paid $0.00 Avvailable credit $0.00 Payment amount $44.10
G5T amount | $0.00 hd Credit G5T amaunt $0.00 hd
< Back | Mext > I Cancel | Create Later | Lreate Mow

‘ |B Invoice(s] approved: $4,484 54 |2 One-Time Chequels] approved: $720.00

18. If you want to pay all the invoices, click Select All on the action bar. The program ticks the checkbox in the
Pay? column for all the invoices.

19. To pay only specific invoices, untick the checkbox in the Pay? column of the invoices you do not want to
pay.

Note: On the Invoices tab you can select invoices to be paid in the payment run. You can create or edit the
payment schedule for the invoice.

20. If you do not want to pay the invoices, click Deselect All on the action bar. The program unticks the
checkbox in the Pay? column for all the invoices.

21. To hide invoice information displayed at the bottom of the screen, click Hide Details. Click Show Details
to see invoice information.



22.

23.

24.

25.

26.

Click Next or select the One-Time Cheques tab.

= Create Payments
File Edit iew Help

A3 7?-

Step 1. Generall 2 Filters | 3 Invoices

Cheque Amount

W Ol/28/2006 $220.00 Accounts Payable

< Back | Mext > I

Canicel |

Create Later | Lreate Mow

‘ |B Invoice(s] approved: $4,484 54 |2 One-Time Chequels] approved: $720.00
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To create a new one-time cheque, click New. For more information about creating one-time cheques, see

“Creating a New One-Time Cheque” on page 77.

To include all the one-time cheques in this payment run, click Select All on the action bar. The program

ticks the checkbox in the Pay? column for all the cheques.

To include only specific one-time cheques, untick the checkbox in the Pay? column of the cheques you do

not want to pay.

If you do not want to include all the one-time cheques in this payment run, click Deselect All on the action
bar. The program unticks the checkbox in the Pay? column for all the cheques.
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27. Click Next or select the Format tab. In the list on the left, select Computer cheques. Payment options for
computer cheques appear on the right.

ES Create Payments
File Edit “iew Help

&5 2-

Step 1. Generall 2: Filters | 3 Invoices | 4: One-Time Cheques 5 Fo‘r‘iﬁ;a"t'l

Computer Cheques
Ore-Time Cheques

Payment Options for Computer Cheques

FPayment Inf

Payment format: I j I
Starling payment number. |1 a4 Restore Default |
L Pt it i Edit Payment Options
Fiint Test alignment Cheque
Format.
Cheque note: Mo note printed on the cheque
Cheque stub note: Mo note printed on the cheque stub
Signature 1: Offer optional signature
Signature 2: Frink signature based on amaunt
Address: Mo address printed
Print payments in this order -
Sort By I Order By Iﬂ
Payee name Agcending
=]

< Back | TdErts I Cancel |

‘ |B Invoice(s] approved: $4,484 54

Create Later | Lreate Mow

|2 One-Time Chequels] approved: $720.00

28. In the Payment format field, select the form your office uses.
29.

In the Starting payment number field, enter a starting number, up to nine digits, for the cheques.
30.

To make changes to payment options selected in the bank account record, click Edit Payment Options.
When you click Edit Payment Options, the Default Payment Options screen appears.

31. To make sure information is aligned properly on your cheque forms or paper, click Print Test Alignment
Cheque.

32. Inthe Sort By and Order By columns at the bottom of the screen, select how to sort cheques for printing.
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33. To select formatting options for the one-time cheques in this payment run, select One-Time Cheques in

the list on the left.

ES Create Payments
File Edit “iew Help

&5 2-

Step 1. Generall 2: Filters | 3 Invoices | & One-Time Cheques  5: Format |

Computer Cheques

[he-Time 3

FPayment Inf

Payment Options for One-Time Cheques

Papment format: I

=

Format.

Starling payment number. ISame az computer cheques

¥ | Fiitit payment nimber

Edit Payment Optiohs
Fiint Test alignment Cheque

Cheque note:
Cheque stub note:
Signature 1t
Signature 2:
Address:

Print payments in this order -

Mo note printed on the cheque

Mo note printed on the cheque stub
Mever print signakure

Mever print signature

Mo address printed

Sork By I

Order By

Payee name Agcending

-

=

< Back | TdErts I

Canicel |

Create Later | Lreate Mow

‘ |B Invoice(s] approved: $4,497.40

|1 One-Time Chequels] approved: $500.00

34.
35.
36.

Note:

37.
the bottom of the screen.

Creating a New One-Time Cheque

In the Payment format field, select the form your office uses.

Tick Print payment number so the cheque number appears on the cheques.

To stop processing a payment run, click Cancel at the bottom of the screen.

In the Sort By and Order By columns at the bottom of the screen, select how to sort cheques for printing.

Now that payments are selected and formatted, you are ready to print the cheques. Click Create Now at

A one-time cheque is written to an individual or company not maintained as a vendor in the database. When you
click Create a new one-time cheque, the Add a One-Time Cheque screen appears so you can define payment,
printing, and posting options for the cheque. The Add a One-Time Cheque screen has tabs on which you set
parameters: General, Distribution, and Format. The History of Changes tab is for informational purposes only; you

do not enter or edit data on this tab.

» Adding a one-time cheque

Warning: The bank account ID automatically appears in the Bank account field. If you realise you are using the
wrong bank account, you must close the Add a One-Time cheque screen and select another bank account from

the Banks page.
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1.

AN o

Note:

From Payment tasks on the Banks page, click Create a new one-time cheque. The Add a One-Time
cheque screen opens to the General tab.

B8 Add a One-Time Cheque I

File Edit “iew Payment Help

Record and Close v| Frint Later and Close v| Frint Mo | gl

?- |

General |Qistribution| Fgrmatl History of Ehangesl

Cheque

Bank account: IDperating j IDperating Account

Chenue date:  [03/12/2008 | One-Time cheque number | [1041

Amaount: I Cheque format; I j
Edit Tax | I VI I Goods and Services Tax

Cheque amount:l Description:l

Fayes name: |

Address | Cortact: |

Contact Type I Contact Mumber

ABN: I

Post statuz/date: INot yet posted j ISpecific Date j |U3.-"1 242008 " Cleared onl

Reversal status/date: INot yet posted j I

| | |N0t reconciled

Bank account information and today’s date automatically appear in the Bank account and Cheque date
fields.

Enter the amount and a description of the payment in the Amount and Description fields
In the Cheque format field, select a cheque form your office uses.
In the Payee name field, enter the name of the business.

To edit sales tax information, click Edit Tax. For more information about editing sales tax information on
the invoice record, see “Editing Sales Tax” on page 80.

Enter the contact information in the Contact field and Contact Type grid.
In the ABN field, enter the federal charitable identification number for your organisation.

Select a post status and date for the one-time cheque in the Post status/date fields. When the cheque
clears the bank, you can tick the Cleared on checkbox and enter the date.

You can create a distribution for the payment on the Distribution tab.



10.

11.
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Select the Distribution tab.
[ AddaOneTime Choque ||

File Edit “iew Payment Help
Record Mow v| Frint Later and Close v| Frint Mo | Q| ? - |

General Distribution |H_istor_l,l of Ehangesl

Interfund: I 'l Budgetl u){,. Entries || Y %l
DR Account Mumber I DR Account Des... I Amount I CR Account Mumber I CR Account Des... I Praje
01-5100-01 S alaries-Administra... $45.00 071-1000-00 Operating Cash A... | 1001

uijors..  Load Distribution...  Distribute Evenly S Femaining: $0.00

| | |N0t reconciled

In the distribution field, select either “Distribution” or “Miscellaneous Entries”.
If you select “Distribution”, select enter the GST Tax ID field.

If you select “Miscellaneous Entries”, select an interfund entry set from the Interfund field to balance the
accounts.

Note: To delete all of the distributions, click Delete All. To delete one distribution line, select the row you want
to delete by clicking the button to the left of the grid. Select Edit from the toolbar, then Delete Row. The
selected row will be deleted.

12.

13.

14.

15.

16.

17.

In the DR Account Number column, enter the debit fund or account for your distribution. You can use the
small binoculars to search for an account segment or use the large binoculars to search for an account
number.

When you enter a valid debit account number, the description appears automatically in the DR Account
Description column.

Enter the amount of the distribution in the Amount column or the percentage in the Percent column. You
can manually enter amounts or percents for each account or you can click Distribute Evenly to distribute
amounts or percents equally among the selected accounts.

In the CR Account Number column, enter the credit fund or account for your distribution. You can use the
small binoculars to search for an account segment or use the large binoculars to search for an account
number.

When you enter a valid credit account number, the description appears automatically in the CR Account
Description column.

In the Interfund field above the distribution grid, select an interfund set to balance the accounts if you
enter debit and credit accounts from different funds. If you have not created a balancing interfund set for
those accounts in Configuration, you cannot save the distribution.

If you have the optional module Projects and Grants, enter the project ID number in the Project ID
column, or use the binoculars to search for a project ID. When you enter a valid project ID number, the
description appears automatically in the Project Description column.

In the Class column, select a class for the distribution.
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18.

19.

20.

21.

22.

23.

24.

25.

If you have the optional module Projects and Grants and have defined transaction codes, additional
columns appear based on the number of transaction codes you have defined. In the grid, select a value for
each transaction code.

To enter different transaction distributions for the debit and credit accounts in a distribution row, select
the distribution row and click Distribution. For a debit account, select DR Distribution. For a credit
account, select CR Distribution. The Transaction Distribution screen appears.

You can also use this screen to split transaction distributions among multiple projects, classes, or
transaction codes for a single debit or credit account. When you have finished entering information, click
OK to return to one-time cheque Distribution tab.

You can click Load Distribution to display a list of all existing account distributions defined in Accounts
Payable Configuration.

You can click Distribute Evenly to divide the distribution evenly among all accounts entered in the
distribution grid.

To attach transaction attributes to an account in the distribution, select the account and click Attributes
on the action bar below the grid. When you have finished entering information, click OK to return to the
one-time cheque Distribution tab.

You can click Delete All to delete all the distributions in the grid.

If you have the optional module Budget Management, you can click Budget on the action bar above the
grid to check the account or project against its budget.

To preview General Ledger debits and credits for the cheque, click DR/CR Entries on the action bar above
the grid.

Note: The History of Changes tab displays an historic record of key changes made to the one-time cheque. The
information provides an audit trail and is for informational purposes only. You cannot add or edit data on the
History of Changes tab.

26.

Click Print Later and Close on the toolbar so you can print this one-time cheque in your next payment
run. You return to the Banks page.

Editing Sales Tax

To edit sales tax information, click Edit Tax on the one-time cheque. When you edit the tax amount, the new
amount is applied to the tax distribution proportionally.

» Editing sales tax from a one-time cheque

1.

2.

From the one-time cheque, click Edit Tax. The Edit Sales Tax screen appears.

@ EdtSales T ______________________________________H|
Total Tax = |$550— B Entries ||E 1'

Sales TaxE.. I D escription I DR Account Mumber I DR Account Des... I Amount I CR Account Mumber
| |GST Goods and Servic... $6.50
Kl |
Apply Rate  Update Total Remaining: $0.00

Cancel |

| |

In the Total Tax field, select “GST”, “FRE”, or “GNR”".
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If you defined default debit accounts on the Distribution tab of the vendor record, they appear
automatically in the DR Account Number column. Otherwise, enter debit accounts for the distribution.
When you enter a debit account number, the description appears automatically in the DR Account
Description column.

4. To preview General Ledger debits and credits for the invoice, click Dr/Cr Entries.
5. To enter distributions by amount, click the $ button. To enter distributions by percent, click the % button.

6. To save the edited sales tax, click OK.

Edi

ting Unwritten One-Time Cheques

When you click Edit unwritten one-time cheques, the Unwritten One-Time Cheques screen for the selected bank
account appears so you can select a cheque and edit payment, printing, and posting options for the cheque. You
can also record and print one-time cheques from this screen.

» Editing an unwritten one-time cheque

Note:

To add a new one-time cheque, click New on the toolbar. To delete a one-time cheque, select the

cheque in the grid and click Delete on the toolbar.

1.

Note:

Note:

From Payment tasks on the Banks page, click Edit unwritten one-time cheques. The Unwritten One-Time
Cheques screen appears

@ Unwritten Dne-Time Cheques for Dperating Account

New & Open Delete Becord Cheque  Frint Cheque i Find L Export

01/28/2006  Mr John Doe $220.00 Legal Consulting

Cloze |

To use one-time cheque information in another software application, click Export on the toolbar.

Select a cheque in the grid and click Open on the toolbar. You can enter or edit information on the
cheque record before making the payment.

To record the cheque as a payment transaction in the bank register, select the cheque in the grid and click
Record Cheque on the toolbar.

If the grid contains numerous entries, you can click Find to find a specific one-time cheque. By using the

Find screen, you can quickly find the cheque instead of spending time scrolling through them in the grid.



82 CHAPTER

5.

To print the cheque, select it in the grid and click Print Cheque on the toolbar. The Printing Payment
Status screen appears so you can assure cheques will print successfully. After cheques print and you
return to the Unwritten One-Time Cheques screen, the cheque no longer appears in the grid.

Click Close to return to the Banks page.

Creating Payments from Invoices

From the Payments/Credits tab of an invoice record, you can click Pay Now to open the Create a Payment for
Invoice screen. This screen is similar to the Add a One-Time cheque screen in Banks. Here, you create cheques to
pay invoices.

» Creating a payment from an invoice

1.

From the Payments/Credits tab of an open invoice, click Pay Now. The Create a Payment for Invoice
screen opens on the General tab.

E= Create a Payment for Invoice 333 I
File Edit “iew Papment Help

Record and Cloge =| Fint Later and Close v| Print Mow | el

2. |
?

General |Qistribution| Fgrmatl History of Ehangesl

Cheque Information.

Berk sccourt. RRRERERGG— = | |
Cheque date: I‘I 0/15/2008 IEomputer cheque numherj I
Amort: |$45.DD Cheque format: I j

Payee Infor

Payes name: IAIphaGraphicS

Siddress | 137E Calhoun Street Contact: |Ms_ Sue White

Charleston, SC 23401

Contact Type | Cartact Mumber
Buzinesz [200] 468-8936

Tax D number: I

Post status/date: INot yet posted ﬂ ISpecific Date ﬂ |1DH15£2DDE " Cleared onl
Reversal status/date: IND[ et posted j I

| | |N ot reconciled

In the Bank account field, select a bank account. The bank account description appears automatically.
In the Cheque date field, enter the cheque date.

4. The Amount field is for informational purposes only and displays values from the Invoice amount or

© N v

10.

11.

Discount amount fields of the invoice.

In the cheque type field, select “Computer cheque number” or “Manual cheque number”.
In the cheque number field, enter a cheque number.

If you select a computer cheque type, in the Cheque format field, select a cheque format.

The Payee name, Address, and Tax ID number fields are for informational purposes and display vendor
information from the invoice.

The Contact, Contact Type, and Contact Number fields are for informational purposes and display contact
information from the invoice.

In the Post status/date field, select a current posting status and the date posted to the general ledger. If
you select “Specific Date”, enter a date.

When the cheque clears, mark Cleared on and enter the date it cleared.
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12. The Reversal status/date fields are for informational purposes only and display reversal information from
the invoice.

13. Select the Distribution tab.

E= Create a Payment for Invoice 333 I
File Edit Wiew Payment Help

Record and Closs -

Brinit Later and Elose v| Pririt Mo | Q‘| ? - |

General Distribution I Fgrmatl History of Changesl

Interfund: I v l 0%, Entries ”E EI

I DR Account Humber I DR Account Des. .. | Amount | CR Account Number | CR Account Des... |

Froje:

| | |N ot reconciled

14. On the Distribution tab, you can view debit and credit information you entered on the invoice record.
Information on the payment Distribution tab is for informational purposes only, and cannot be edited.

15. Select the Format tab.

E= Create a Payment for Invoice 333 I
File Edit “iew Payment Help

Record and Close -

Bririt [Later and Elose v| Pririt Mo | sl

?- |

General I Diztribution | Histary of Changes I

FPapment O

Format and Print Opti

Cheque naote; Mo note printed on the cheque ﬂ
Cheque stub note: Mo note printed on the cheque stub
Cheque printed to:

Signakure 1: Mewer prink signature

Signakure 2: Mever print signature

Transit A8 number: =]

Signature(s]

Signature I Preview |

Electronic signature iz not allowed

1
2 | Electronic signature is not allowed

| | |N ot reconciled

16. Click Payment Options on the action bar to access the Payment Options screen. In the Format and Print
Options grid, you can change alignment and cheque stub information. In the Signature(s) grid, you can
add or edit electronic signatures and enter notes for the one-time cheque.



84 CHAPTER

Note: Selections you make on the Payment Options screen appear in the Format and Print Options frame.

17. Click Printer Options to access the Printer Options screen.
18. To save the payment and return to the invoice record, click Record and Close.
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In Accounts Payable, Accounts Receivable, and Student Billing, you can create Business Activity Statements to
view GST information quickly and easily. These reports are valuable tools for documenting your GST deductions
and providing accurate information about the taxes you collect.

The Reports page is the central location for reporting. From the navigation bar, select Reports to access the
Reports page. This page contains links to each report category. When you click a link, the program displays a list
of the reports making up the category. To access Business Activity Statements in Accounts Payable, click Invoice
Reports. To access Business Activity Statements and GST Reports in Accounts Receivable or Student Billing, click
Transaction Reports.

This chapter explains the procedures for creating Business Activity Statements and GST Reports.

Accounts Payable Reports

In Accounts Payable, you can create Business Activity Statements to document the amount of GST you have paid
so you can claim tax deductions. This section contains detailed procedures for creating a business activity
statement. For detailed information about creating other Accounts Payable reports, see the Reports Guide for
Accounts Payable.

Creating a Business Activity Statement

The Business Activity Statement shows tax information from your Accounts Payable, Accounts Receivable,
Student Billing, General Ledger, and Raiser’s Edge programs.

The Business Activity Statement has four tabs on which you set parameters: General, AP Filters, AR Filters, and
Format tabs. To move among the tabs in a report, use Next and Back at the bottom of the screen or select the tab
itself. On these tabs you specify the records to include in the report and how the report should look.

» Creating a Business Activity Statement

Note: The action bar is located above the list of reports and contains links for creating a new report, opening a
report, and deleting a report. These links are common to all Reports pages.

1. From the Reports page, click Invoice Reports. The Invoice Reports page appears with a list of all invoice
reports on the left.
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2.

In the list on the left, select Business Activity Statement.

&% The Financial Edge

File Edit “iew Go Favouites Tools Help

% Back  # Fopivardl I Community Services Inc, = Accounts Payable ~

Shortcuts

12 Reports « Invoice Reports

Hew |Dgen |Qelete... Reports

— " - EBank.
ACCD“”‘D'S‘""“;W F;ePU" Business Activity Statement Accaunt

Reports

‘B B ement Name | Diescription | [rate Created | Created By | ualig Inaice
Cash Requirements Repart Reparts I

Credit Mote Repart Pivat
]
Hold Payment Repart Reparts

Irwnice Expense Allocation A

Invoice Generation Report gfrd?rase
Invaice History Repart Festie

Open Invoice Report d—
Praject Distribution Repart ;Z;nstrs
Recurring Invoice Report

Tranzaction Fegister

[ o
™ Only shaw my reports
= = The Business Activity Statement reports on tax information
Monthly Reports ﬂ from Accounts Payable, Accounts Receivable, General
W Ledger. and The Raizer's Edge.
‘W’alcnme to Accounts Payable ‘ él

3. Onthe action bar, click New. The New Business Activity Statement screen appears on the General tab. On
this tab, you can set specific parameters and make selections about the information included in the

report.

lﬂ Hew Business Achivity Statement E

File Edit View Favorites Toolz Help

RS e ?-

1. General |g: AP Filtersl 3 AR Fillersl 4 Formatl

Include Irvaice, Credit Memos, and One-Time Checks with these dates -

Date: Include all dates

Inelude transactions from these systems -

¥ Accounts Receivable
W Accounts Papable

[ Create an output query of IInvoices 'l

Report Onentation; Landscape

< Bach MNest » Catcel Print Freview Layout

Note: Fields, options, and checkboxes on the General tab vary for each report.

4.

In the Date field, select a date range for the report. If you select “Specific range”, you must also enter a

start date and end date.

In the Include transactions from these systems frame, you can select to include Accounts Payable and

Accounts Receivable transactions in the report.
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6. To create an output query, tick the checkbox and select “Invoices”.
7. Click Next or select the AP Filters tab. On this tab, you can filter the information appearing in the report.

lﬂ Hew Business Achivity Statement E I
File Edit “iew Favouites Toolz Help
=g [zl |
1: Genera 12 aR Fillersl 4 Formatl
| Clear &l Filters
Filters I Include I Selected Filters I
33T Tax Entities All <Al GIT Tax Entities >
Yendors all <all vendors=
Invoices all <all Invoices>
Credit Mokes all <l Credit Motes =
Payments all <Al Payments =
Post Statuses all <Al Post Statuses:=
Yendor Attributes All <all Yendor Attributes =
Inrvoice Aktributes all <all Invoice Attributes =
Credit Moke Attribukes Al <Al Credit Mote Attribukes:
< Back MNest » Catcel Print Freview Layout

Note: Once you select a filter in the grid, you can click Open to access the Selected <Filter> screen on which
you select specific filters.

8. In the Include column, select “All” or “Selected”. If you choose “Selected,” the Selected <Filter> screen
opens so you can designate specific filters. Depending on your selection, different filter screens can
appear.

Selected G5T Tax Entities |

Include: @ Al

Fin: | N
Include these gst tax entities:

Goods and Services Tax
G5T Free
GST Mot Registered, “Withhold Payment

Al [¥]v

oK

9. To include all of the filters listed in the grid by ticking All. You can include individual filters by ticking
Selected and moving the filter into the Include these gst tax entities checkbox.

10. To view or edit the previous filter without returning to the AP Filters tab, click Previous Filter. To view or
edit the next filter without returning to the AP Filters tab, click Next Filter.
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Note: You can click Clear All Filters to remove all previously selected filters from the report.

11. Click OK to return to the AP Filters tab.
12. Click Next or select the AR Filters tab.

lQ Mew Business Activity Statement I
File Edit “iew Favorites Toolz Help
FIEE =
1 Generall 2 AP Filterz |4_1: Formatl
Ep0pen ) Clear Al Fiters
Filters I Inchude I Selected Fileers I
GST Tax Entities Al <8l GST Tax Entities =
Clients All <all Clients=
Invoices all <4l Invoices=
Credits All <all Credits =
Posk Statuses all <all Post Skatuses:
Client &ttributes Al <4l Clienk Attribukes =
Invoice Attributes All <Al Invoice Attributes =
Transaction Attributes all <Al Transaction Attributes =
< Back | Next = Catcel Print Preview Layout

Note: Once you highlight a filter in the grid, you can click Open to access the Selected <Filter> screen on which

you select specific filters.

13. In the Include column, select “All” or “Selected”. If you choose “Selected,” the Selected <Filter> screen
opens so you can designate specific filters. Depending on your selection, different filter screens can

appear.

14. You can include all of the filters listed in the grid by ticking All. You can include individual filters by ticking

Selected and moving the filter into the Include these gst tax entities checkbox.

15. To view or edit the previous filter without returning to the AR Filters tab, click Previous Filter. To view or

edit the next filter without returning to the AR Filters tab, click Next Filter.

16. Click OK to return to the AR Filters tab.
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17. Click Next or select the Format tab. On the Format tab, you select how you want the report to appear. A
description of each formatting option is provided.

lﬂ Hew Business Achivity Statement E I

File Edit View Favorites Toolz Help
== RN el R |

1 Generall 2 AP Filtersl 3 AR Filkers :__:

Report Footer
Miscellamenus

Aliar: I Center - l

[¥ Print organization name in header

B Headings Headings

Criteria y

Detail r— Heading Format

Sart Title: IBusiness.&ctivit}l Statement
Page Footer Subtitle: I

v Frint Page Mumber in Heading

¥ Piint Report Date in Heading

Format: IF'age 1 j Farmat: IShort Date and Time j
Aligr:  [Right =] || A et [~
¥ Frint report heading on each page

< Back | et > | Catcel | Print | Freview | Layout |

Headings. You can enter a maximum of 60 characters in both the Title and Subtitle fields. The program assigns
a name in the Title field based on the record type; in this case, “Business Activity Statement”. You can change
this title. The title and subtitle appear at the top of the report. You can also select how you want the heading
aligned and if you want your organisation’s name to appear in the header.
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You can include other options in the header, such as the page number and the date, also select to include the
header on every page of the report.

File Edit Wiew Favourtes

H &= ahW

=] Headings
B Ciiteria
=] Detail

=] Sart

=] Page Footer
=] Fieport Footer
2] Miscelaneous

n Mew Business Activity Statement

Toolz Help
2 -

.

1: General] 2 AP Filtersl 2 AR Filkers 4 Format l

Criteria
Iv Frint theze crteria on | a separate page -
w| Saved report name -

w| Dutput query name

| Dates to Include

| Include transactions from these systems

w| Accounts Payable tas entities to include

v Yendors to include

w| Accounts Payable invoices to include

v Credit notes to include

w| One-time cheques to include

w| Accounts Payable post statuses to include

w| Accounts Payable vendor attriibutes to include
w| Account Pavable invoice attibutes to include
v Credit note attributes to include

| Accounts Receivable tar entities to include

W Clients to include

v Account Receivable invoices to include j

< Back |

Cancel | Brint | Preview | Laypout |

Criteria. Select Criteria to print a list of criteria used to create the report. Tick Print these criteria on and select a
separate page or the first page. All selected options print in the criteria section of the report.

The program automatically selects all criteria. Untick the checkbox for any you do not want to print with the

report.

File Edit “iew Favorites

H &S %W

=] Headings
=] Criteria
5 Detai
=] Sort

=] Page Footer

=] Fieport Footer
2] Miscellaneous

1: General] 2 AP Filtersl 3

n Mew Business Activity Statement

Tools Help
? =

AR Filters 4 Format l

¥ Include the totals section of the report.

[v Include the tax items section of the report,

< Back

Cancel Erint Freview Lapout
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Detail. Use Detail to select details specific to the report. On this screen you can choose to include the totals
and/or the tax items sections of the report.

lE Mew Business Activity Statement I
File Edit Wiew Favortez Toolz Help
ST |
1: General' 2 AP Filtersl 2 AR Filkers 4 Format |
Headings Sort
Criteria
Detil Sart by | Order by |
(8 Sort GST Tax Entity Ascending
Page Footer Tranzaction Type Azcending
Feport Footer
Miscelaneous
< Back | e | Cancel | Brint | Preview | Laypout |

Sort. Use Sort to select the order in which information appears on the report. When you select Sort on the
Format tab, a grid displays the categories you can sort in the report. Select a sorting category in the Sort by
column and select Ascending or Descending in the Order by column.
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If you make no selections in the Sort by column in the grid, the program sorts by GST Tax Entity and
Transaction Type in ascending order.

lE Mew Business Activity Statement
File Edit Wiew Favorites

x|
Help
S R =l |

1: General' 2 AP Filtersl 2 AR Filkers 4 Format |

Tools

Headings Page Footer
Criteria e
Detal — Page Footer Tex
Sart Text:
(B Page Footer
Feport Footer
Miscelaneous
aligr: ICenter 'I
™ Print Page Muriber in Footer ™ Print Feport Date in Footer
Farmat: IF'age 1 j Format: IShDrt Date and Time j
Aligr: IHight j Align: ILeft j
< Back | e | Cancel Brint | Preview | Laypout |

Page Footer. You can enter a maximum of 255 characters in the page footer. You can also include other options
in the page footer, such as the page number and date.

lE Mew Business Activity Statement x| I
File Edit ‘“iew Favortez Toolz Help
S e = ?- |

1 General' 2 AP Filtersl 2 AR Filkers  4: Format |

Headings Report Footer

Criteria Fenart Footer Test

Detal epart Foater Tex

Sort Text:

Page Footer

E Report Footer

Miscellaneous

aligr: ILeft vl
< Back | st Cancel Frint Preview Layout
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Report Footer. You can enter a maximum of 255 characters in the report footer and select how you want text
aligned. The report footer appears at the end of the report.

lE Mew Business Activity Statement I
File Edit Wiew Favortez Toolz Help

S R =l |

1: General' 2 AP Filtersl 2 AR Filkers 4 Format |

Headings Miscellaneous
Criteria

Dretail Show currency character on Al amounts
Sort Show percent sign on Al amounts
Page Footer Megative amaunt farmat [1234.5E)
_ eport Footel Mumber of digits after decimal for amounts 2
| Mumber of digits after decimal for percentages 2

Show 1000's zeparator Yesz

Showe blank s instead of zeros Mo

Font zize a

Sample amoLnt:

Arnount [$1.234 5E)
Percent 100,002
< Back | e | Cancel | Brint | Preview | Laypout |

Miscellaneous. You can select how you want numbers to appear on the report. You can also select the font size
used in the report.

Accounts Receivable Reports

In Accounts Receivable, you can create Business Activity Statements to document the amount of GST you have
collected so you can properly report it to the ATO. You can also create a GST report that displays all the
GST-related charges and invoice line items for the period. This section contains detailed procedures for creating a
business activity statement and GST report. For detailed information about creating other Accounts Receivable
reports, see the Reports Guide for Accounts Receivable.
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Creating a Business Activity Statement

The Business Activity Statement shows tax information from your Accounts Payable, Accounts Receivable,
General Ledger, and Raiser’s Edge programs.

## The Education Edge M
File Edit Yiew Go Favouwites Tool: Help

€ Back & Earwarn I Community Services Inc. ™ + Accounts Receivable ™

I@ Reports « Transaction Reports

"?-“1—‘ Home New Open Delete Reports
| T business Acty Statement | =8

B busi — ” :
Invoice Report Mame |Dascription ‘Date Created |Craated By |Others May Moo 22;‘;"’?:

Project Distribution Report

Recuring lrnvoice Report gank ﬁzccount
GST Report EpeliEs
Tranzaction List Client Reparts

Unapplied Credit Repart Custom
Reports

Deposit and
Receipt
Reports

Pivok Reports

Product and
Billing Item
Reports

onfiguration gransiction I
eports

shboard
[« | i

I Only show my reports

Shorkcuts

Plug-Ins

! The Buzinezs Activity Statement reports on taw infarmation from Accounts
Payable, Accounts Receivable. General Ledoer. and The Raiser's Edge.

“wielcome to Accounts Receivable |

The Business Activity Statement has four tabs on which you set parameters: General, AP Filters, AR Filters, and
Format tabs. To move among the tabs in a report, use Next and Back at the bottom of the screen or select the tab
itself. On these tabs you specify the records to include in the report and how the report should look.

» Creating a Business Activity Statement

Note: The action bar is located above the list of reports and contains links for creating a new report, opening a
report, and deleting a report. These links are common to all Reports pages.

1. From the Reports page, click Transaction Reports. The Invoice Reports page appears with a list of all
invoice reports on the left.
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2. Inthe list on the left, select Business Activity Statement.

x

# The Education Edge _[5]
File Edit Wiew Go Favouites Tools Help

 Back % Farward J Cormmunity Services Inc, = + Accounts Receivable ™
12 Reports » Transaction Reports
Hew [per Delete,.. Reports

ent

|3 Irmvcice Report Name |Descriptmn ‘Date Created |Created Ey |0thers May Moc stgrstlss

j Praject Distribution Report

= 3] Recuring lrvoice Feport E{:Béi;count
g Export ] G5T Repart
= ) Transaction List Clierk Reports

.g Reparts ] Unapplied Credit Report Custarn
Reports

Shartcuts

d

Depasit and
Receipt
Reports

Pivot Reports

Product and
ministration Biling Item
Reports

nfiguration Transaction
- Reports
d
K1 0
_-faphm.]n._: [~ Only show my reparts
¢ |

i E The Business Activity Statement reports on ta information from Accounts
=l Help Payable, Accounts Receivable, General Ledger, and The Raiser's Edge.

Blackbaud Systems |

welcome to Accounts Receivable |

3. Onthe action bar, click New. The New Business Activity Statement screen appears on the General tab. On
this tab, you can set specific parameters and make selections about the information included in the
report.

lQ Mew Business Activity Statement
File Edit “iew Favorites Toolz Help

= D= RN e

1. General |g; AP Filtersl 3 AR FiIters' 4 Formatl

Include Invoice, Credit Memos, and One-Time Checks with these dates -

Drate: Include all dates

Include transactions from these systems -

W Accounts Receivable
W Accounts Payable

[~ Create an output query of Ilnvoices Vl

Report Orientation: Landscape

< Bachk | Next = Catcel Print Preview Layout

Note: Fields, options, and checkboxes on the General tab vary for each report.

4. In the Date field, select a date range for the report. If you select “Specific range”, you must also enter a
start date and end date.

5. In the Include transactions from these systems frame, you can select to include Accounts Payable and
Accounts Receivable transactions in the report.



6. To create an output query, tick the checkbox and select “Invoices”.
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7. Click Next or select the AP Filters tab. On this tab, you can filter the information appearing in the report.

lﬂ Hew Business Achivity Statement E I
File Edit “iew Favouites Toolz Help
=g [zl |
1: Genera 12 aR Fillersl 4 Formatl
| Clear &l Filters
Filters I Include I Selected Filters I
33T Tax Entities All <Al GIT Tax Entities >
Yendors all <all vendors=
Invoices all <all Invoices>
Credit Mokes all <l Credit Motes =
Payments all <Al Payments =
Post Statuses all <Al Post Statuses:=
Yendor Attributes All <all Yendor Attributes =
Inrvoice Aktributes all <all Invoice Attributes =
Credit Moke Attribukes Al <Al Credit Mote Attribukes:
< Back MNest » Catcel Print Freview Layout

Note: Once you select a filter in the grid, you can click Open to access the Selected <Filter> screen on which

you select specific filters.

8. In the Include column, select “All” or “Selected”. If you choose “Selected,” the Selected <Filter> screen
opens so you can designate specific filters. Depending on your selection, different filter screens can

appear.

Selected GST Tax Entities

Include: @ Al

Fin: | N
Include these gst tax entities:

Goods and Services Tax
G5T Free
GST Mot Registered, “Withhold Payment

Al [¥]v

oK

9. To include all of the filters listed in the grid, select All. You can include individual filters by choosing

Selected and moving the filter into the <Selected Filters> box.

10. To view or edit the previous filter without returning to the AP Filters tab, click Previous Filter. To view or

edit the next filter without returning to the AP Filters tab, click Next Filter.
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Note: You can click Clear All Filters to remove all previously selected filters from the report.

11. Click OK to return to the AP Filters tab.
12. Click Next or select the AR Filters tab.

lQ Mew Business Activity Statement I
File Edit “iew Favorites Toolz Help
SRR ElC el |
1 Generall 2 AP Filter: I 4 Formatl
Ep0pen ) Clear Al Fiters
Filters I Inchude I Selected Fileers I
GST Tax Entities Al <8l GST Tax Entities =
Clients All <all Clients=
Invoices all <4l Invoices=
Credits All <all Credits =
Posk Statuses all <all Post Skatuses:
Client &ttributes Al <4l Clienk Attribukes =
Invoice Attributes All <Al Invoice Attributes =
Transaction Attributes all <Al Transaction Attributes =
< Back | Next = Catcel Print Preview Layout

Note: Once you highlight a filter in the grid, you can click Open to access the Selected <Filter> screen on which
you select specific filters.

13.

14.

15.

16.
17.

In the Include column, select “All” or “Selected”. If you choose “Selected,” the Selected <Filter> screen
opens so you can designate specific filters. Depending on your selection, different filter screens can
appear.

You can include all of the filters listed in the grid by selecting All. You can include individual filters by
choosing Selected and moving the filter into the <Selected Filters> box.

To view or edit the previous filter without returning to the AR Filters tab, click Previous Filter. To view or
edit the next filter without returning to the AR Filters tab, click Next Filter.

Click OK to return to the AR Filters tab.

Click Next or select the Format tab. On the Format tab, you select how you want the report to appear. A
description of each formatting option is provided.

Headings. You can enter a maximum of 60 characters in both the Title and Subtitle fields. The program assigns a
name in the Title field based on the record type; in this case, “Business Activity Statement”. You can change
this title. The title and subtitle appear at the top of the report. You can also select how you want the heading
aligned and if you want your organisation’s name to appear in the header.
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You can include other options in the header, such as the page number and the date, also select to include the
header on every page of the report.

File Edit Wiew Favorites

S R =l |

lE Mew Business Activity Statement I

Toolz: Help

B Headings
Criteria

Dretail

Sart

Page Faoter
Feport Footer
Miscelaneous

1: General | 2 &P Fiters | 3: AR Fiker

—Heading Format

Title: |Business Activity Statement

Subtitle: |

Align: ICenter 'I

¥ PFrint organization name in header

W Frint Feport Date in Heading
Format: IShDrt D ate and Time j

Align. Left =]

v Print Page Number in Heading
Farmat: IF'age 1 j

Aligr: | Right =]

[V Print report heading on each page

< Back | e |

Cancel | Brint | Preview | Laypout |

Criteria. Select Criteria to print a list of criteria used to create the report. Tick Print these criteria on and select a
separate page or the first page. All selected options print in the criteria section of the report.

The program automatically selects all criteria. Untick the checkbox for any you do not want to print with the

report.

File Edit “iew Favourtes

RS R -2

IQ Mew Business Activity Statement I

Tools Help

Headings
{8 Ciiteria
Dretail
Sort

Page Footer

Fieport Footer
Mizcelansous

1: General' 2 AP Filtersl 3 AR Filterz 4 Format |

Criteria
™ Print theze criteria on Ia zeparate page 'l

Saved report name

Output query name

Datesz ta Include

Include transactions from these spstems
Accounts Payable tax entities to include
Wendors to include

Accounts Payable invoices to include

Credit notes ta include

One-time cheques to include

Accounts Payable post statuses to include
Accounts Payable vendor attributes to include
Account Payable invoice attibutes to include
Credit note attributes to include

Accounts Feceivable tax entities to include
Clients to include

Account Receivable invoices to include LI

|»

< Back [ Ewt

Cancel Erint Freview | Lapout |
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Detail. Use Detail to select details specific to the report. On this screen you can choose to include the totals
and/or the tax items sections of the report.

lE Mew Business Activity Statement I
File Edit Wiew Favortez Toolz Help

S R =l |

1: General' 2 AP Filtersl 2 AR Filkers 4 Format |

Headings Detail

Criteria
E ot [¥ Include the totals section of the repart.
of
Page Footer ¥ Include the tax items section of the repaort.

Feport Footer
Miscelaneous

< Back | e | Cancel | Brint | Preview | Laypout |

Sort. Use Sort to select the order in which information appears on the report. When you select Sort on the
Format tab, a grid displays the categories you can sort in the report. Select a sorting category in the Sort by
column and select Ascending or Descending in the Order by column.
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If you make no selections in the Sort by column in the grid, the program sorts by GST Tax Entity and

Transaction Type in ascending order.

n Mew Business Activity Statement
File Edit Wiew Favortez Toolz Help
H (&S & B

1: General] 2 AP Filtersl 2 AR Filkers 4 Format l

=] Headings Sort

Z] Criteria

=] Detail Sort by | Order by |

GST Tax Entity Azcending

=] Page Foater Tranzaction Type Azcending

=] Fieport Footer

2] Miscelaneous

< Back | Cancel Brint | Preview | Laypout |

in the page footer, such as the page number and date.

File Edit ‘“iew Favortez Toolz Help
H| (&S GG L

1 General] 2 AP Filtersl 2 AR Filkers  4: Format ]

=] Headings Page Footer

=] Criteria

2] Detail Page Footer Text

=] Sort Teat:
Page Footer
=] Feport Footer
=] Mizcelansous

Cener 7]

[~ Print Page Murnber in Footer [~ Print Report O ate in Footer

| [~ | | -~
| [~ | | =

n Mew Business Activity Statement

< Back Cancel Frint Preview Layout

Page Footer. You can enter a maximum of 255 characters in the page footer. You can also include other options
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Report Footer. You can enter a maximum of 255 characters in the report footer and select how you want text
aligned. The report footer appears at the end of the report.

n Mew Business Activity Statement
File Edit Wiew Favortez Toolz Help

H &= ahW ?-

1: General] 2 AP Filtersl 2 AR Filkers 4 Format l

2] Headings Miscellaneous

Z] Criteria
2] Detal Show currency character on Al amounts
=] Sort Show percent sign on Al amounts
=] Page Foater Megative amaunt farmat [1234.5E)
= Fiepart Foote Mumber of digits after decimal for amounts 2
. - Mumber of digits after decimal for percentages 2

Show 1000's zeparator Yesz

Showe blank s instead of zeros Mo

Font zize a

Sample amoLnt:

Arnount [$1.234 5E)
Percent 100,002
< Back | | Cancel | Brint | Preview | Laypout |

Miscellaneous. You can select how you want numbers to appear on the report. You can also select the font size
used in the report.

n Mew Business Activity Statement
File Edit ‘“iew Favortez Toolz Help

H &= LW ?-

1 General] 2 AP Filtersl 2 AR Filkers  4: Format ]

5] Headings Report Footer

=] Criteria

5 Detai Report Footer Text
2] Sort Text:

=l Page Foater

=] Mizcelansous

< Back Cancel Frint Preview Layout
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Creating a GST Report

The GST Report shows taxes you have received from charges and invoice line items in Accounts Receivable.

The GST Report has three tabs on which you set parameters: General, Filters, and Format tabs. To move among
the tabs in a report, use Next and Back at the bottom of the screen or select the tab itself. On these tabs you
specify the records to include in the report and how the report should look.

» Creating a GST Report

1. From the Reports page, click Transaction Reports. The Transaction Reports page appears with a list of all
transaction reports on the left.

2. Inthe list on the left, select GST Report.

#% The Education Edge HEl
File Edit Wew Go Favowites Toole Help

b

& Back & Forwand J Community Services Inc. = = Accounts Receivable ™

Shartcuts

12 Reports « Transaction Reports

FEE. Home

'Fq'f " New Open [elste. mj
f ] Account Distribution Feport GST Report Qgguurts

j Business Activity Statement
] Invoice Report Mame |Descrlptmn ‘Date Created |Created By |0thers May M
j Project Distribution Report
[Z] Recurring lrvoice Freport

Analysis
Reports

Bank Account
"B GST Report Reports
Trarsaction List Client Reports

Unapplied Credit Repart Custom
Reports

it

d

Deposit and
Receipt
Reports

Pivot Reports

Product and
Billing Ikem
Reports

Transaction
Reports

KN i
__.:-aphm_ln__: [~ Only show my reports
y g
o E A GST Report provides detailed or summarised information regarding GST
e Help transactions for a specified period of time.

Blackbaud Systems |

‘wielzome to Accounts Feceivable |
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3. On the action bar, click New. The New GST Report screen appears on the General tab. On this tab, you

can set specific parameters and make selections about the information included in the report.

I3 Mew GST Report I

File Edit “iew Favourtes Tool: Help
=Pl RN el |

1: General |g: Filtersl 3 Folmatl

Report format: I VI = | Shiov L distritution, far eack Billing entit

Include these dates:

Transaction date: Ilnclude all dates 'I
Post date: Ilnclude all dates 'I

[ Create an output querny of ICIients ‘l

Report arientation: I Portrait = I
< Bach Mest » Catcel Print Freview Layout

Note: Fields, options, and checkboxes on the General tab vary for each report.

4.

In the Report Format field, select “Detail” or “Summary” as the report format. “Detail” format includes
each one line item, while “Summary” displays a total.

In the Transaction date field of the Include these dates frame, select a specific date or date range for
transactions to include in the report.

If you select “<Specific range>", you can specify a start and end date. If the Start date field is blank, all
activity is included up to the end date. If the End date field is blank, all activity from the start date until
present is included. If both fields are blank, all activity is included.

In the Post date field, select a date or date range of post dates to include in the report.

If you select “<Specific range>", you can specify a start and end date. If the Start date field is blank, all
activity is included up to the end date. If the End date field is blank, all activity from the start date until
present is included. If both fields are blank, all activity is included.

To create an output query, tick the checkbox and select “Clients”, “Charges”, “Credits”, or “Products and
Billing Items”.

In the Report orientation field, select “Portrait” or “Landscape”.
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9. Click Next or select the Filters tab. On this tab, you can filter the information appearing in the report.

I3 New GST Report
Fille Edit “iew Favourtes Toole Help

= D= RN ] e 2

]|

1: General 3 Folmatl
@ 0pen ) Clear &ll Filters
Filters | Include | Selected Filters |
Clients all <all Clients:
Client &ttributes Al <4l Clienk Attribukes =
Source Charges all <Al Source Charges=
Source Credits all <4l Source Credits=
Inrvoices All <all Invoices>
Returns all <all Returns >
Transaction Attributes all <all Transaction Attributes =
Piost Skatuses all <l Post Statuses’=
ST Entities all <Al 55T Entities =
Products and Eilling Items all <Al Products and Billing Items =
Product and Eilling Ikem AL,.. All <Al Product and Eiling Item Attributes >

< Back | MNest » Catcel

Print Praview Layaout

Note: Once you select a filter in the grid, you can click Open to access the Selected <Filter> screen on which

you select specific filters.

10. In the Include column, select “All” or “Selected”. If you choose “Selected,” the Selected <Filter> screen
opens so you can designate specific filters. Depending on your selection, different filter screens can

appear.
GST Enities |
Find: |
G5T Entities
Description Description
Goods and Services Tax
GST Free
G5T Mot Registered, Withhold Payment
>
>
<
<

Ok I Cancel |

11. Toinclude all of the filters listed in the grid, select All. You can include individual filters by choosing
Selected and moving the filter into the <Selected Filters> box.

12. To view or edit the previous filter without returning to the Filters tab, click Previous Filter. To view or edit
the next filter without returning to the Filters tab, click Next Filter.
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Note:

13.
14.

Click OK to return to the Filters tab.
Click Next or select the Format tab. On the Format tab, you select how you want the report to appear. A

description of each formatting option is provided.

You can click Clear All Filters to remove all previously selected filters from the report.

Headings. You can enter a maximum of 60 characters in both the Title and Subtitle fields. The program assigns a
name in the Title field based on the record type; in this case, “GST Report”. You can change this title. The title
and subtitle appear at the top of the report. You can also select how you want the heading aligned and if you
want your organisation’s name to appear in the header.

You can include other options in the header, such as the page number and the date, also select to include the
header on every page of the report.

I Hew GST Report

]|

File Edit Wiew Favourtez Tools

= =R =y

Help
2 .
-

1: General' 2 Filters 3 Format |

Criteria
Sort/Break,
Page Footer
Report Faater
Miscelaneous
Colour Scheme

—Heading Format
Title:  |GST Fieport

Subtitle: |

Align: ICenter 'I

¥ PFrint organization name in header

v Print Page Number in Heading W Frint Feport Date in Heading

Farmat: IF'age 1 j Format: IShDrt Date and Time j
Align: IHight j Align: ILeft j
[V Print report heading on each page
< Back | [ Ew | Cancel | Brint | Freview | Laypout |

Criteria. Select Criteria to print a list of criteria used to create the report. Tick Print these criteria on and select a
separate page or the first page. All selected options print in the criteria section of the report.
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The program automatically selects all criteria. Untick the checkbox for any you do not want to print with the

report.

I Hew GST Report

File Edit Wiew Favourtes

Toole Help

= DRE= RE R e 2

]|

Headings
{8 Criteria
Sort/Break
Page Footer
Report Faater
Miscelaneous
Colour Scheme

1: General' 2 Filters 3 Format |

W Frint these criteria an Ia separate page 'l

Saved report name

Output query name

Show GL distibution for each billing entity
Transaction dates to include

Pozt dates to include

Clients to include

Client attributes to include

Source Credits to include

Source Charges to include
Invoices to include

Retumns to include

Tranzaction attributes to inchude
Post statuzes to include

GST entities to include

GST biling items to include

GST billing item attributes to include

< Back | [ Ew |

Cancel | Brint | Freview |

Laypout |

Sort/Break. Use Sort to select the order in which information appears on the report. When you select Sort on
the Format tab, a grid displays the categories you can sort in the report. Select a sorting category in the Sort
by column and select Ascending or Descending in the Order by column.

If you make no selections in the Sort by column in the grid, the program sorts by Billing Entity in ascending

order.
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You can also create breaks between the sections you have sorted by. In the Text before value and Text after
value fields, you can enter up to 30 characters in each field for information you want to print directly before
and after the break. If you mark Print count per Sales tax entity or Print count as percentage of total for the
selected sort field, the number or percentage for each selected sort option appears in the footer. If you mark
Page break on each new Sales tax entity, a new page starts for the highest level break.

I New G5T Report I
File Edit “iew Favourtes Toolz Help

3 S &2 |

1 General' 2 Filkers 3 Format |

Headings Sort/Break

Criteria

Bs k Sart by I Order by I Break? I
Page Footer Eilling entity Ascending
Report Footer
Miscellaneous

Colour Scheme

A i

Break Header for Billing entity-

Text before value: |

Tewt after valus: |

Break. Footer for Billing entity:
¥ Pirint count per Billing entity
[~ Print count as a percentage of batal

[" Page break on each new Billing entity

< Back et | Cancel | Print Previsw Layout
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Page Footer. You can enter a maximum of 255 characters in the page footer. You can also include other options
in the page footer, such as the page number and date.

I Hew GST Report

File Edit Wiew Favourtes Toolz Help

= DRE= RE R e 2

]|

1: General' 2 Filters 3 Format |

Headings
Criteria

Page Footer

—Page Footer Text

Sort/Break,

Text:

{8 Page Foater
Report Faater
Miscelaneous
Colour Scheme

aligr: ICenter 'I

™ Print Page Muriber in Footer

™ Print Feport Date in Footer

Farmat: IF'age 1 j Format: IShDrt Date and Time j
Align | Right 52 (S B 2
< Back | [ Ew | Cancel Brint | Freview | Laypout |

Report Footer. You can enter a maximum of 255 characters in the report footer and select how you want text
aligned. The report footer appears at the end of the report.

1@ New GST Report

File Edit “iew Favourtez Toolz Help

S &G = ?-

1 General' 2 Filkerz 3 Format |

Report Footer

Headings

Criteria
Sort/Break Report Footer Tesxt
Page Footer Text:

‘8 Report Footer
Mizcelansous
Colour Scheme

Aligr: ||_eft vl

< Back | st Cancel

Frint Freview

Layout
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Miscellaneous. You can select how you want numbers to appear on the report. You can also select the font size
used in the report.

I Hew GST Report I

File Edit Wiew Favourtes Toolz Help
FHEE T |

1: General' 2 Filters 3 Format |

Headings Miscellaneous
Criteria

Sart/Break Show currency characker on Al amounts
Page Footer Showe percent sign on Al amounts
R eport Footer Megative amaunt Farmat (1234.56]
E Colour hee Mumber of digits after decimal For amounts 2

Murnber of digits after dacimal For percentages 2

Show 1000's separator Yes

Shows blanks instead of zeros Mo

Faont size g

Sample amoLnt:

Amounk ($1,234.56)
Percent 100, 00%
< Back | [ Ew | Cancel | Brint | Freview | Laypout |

Colour Scheme. Use Colour Scheme to select colours for report headings. When you click in the colour
checkbox next to the selection, the Colour screen appears so you can select a standard colour or define a

custom colour. If you leave the Apply a Colour Scheme checkbox unticked, the report prints in black and
white.

I Hew GST Report I

File Edit Wiew Favourtes Toolz Help
FHEE T |

1: General' 2 Filters 3 Format |

Headings Colour Scheme
Criteria
Sart/Break [ Apply a Colour Scheme

Page Footer
Report Faater

:8 Colour Scheme [T Group heading back colour Group Headings

Report Name
M Colurn heading back calour Subtitle

. Group heading fore colour

Hestane Vefaults |

< Back [ Ewt Cancel Erint Freview Lapout
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Student Billing Reports

In Student Billing, you can create Business Activity Statements to document the amount of GST you have
collected so you can properly report it to the ATO. You can also create a GST report that displays all the
GST-related charges and invoice line items for the period. This section contains detailed procedures for creating a
business activity statement and GST report. For detailed information about creating other Student Billing reports,
see the Reports Guide for Student Billing.

Creating a Business Activity Statement

The Business Activity Statement shows tax information from your Student Billing, Accounts Payable, Accounts
Receivable, General Ledger, and Raiser’s Edge programs.

% The Education Edge HE
File Edit “iew Go Favowites Took Help

% Back & Fomwvard ] Community Services Inc, = = Accounts Receivable =

Shortubs

@ Reports « Transaction Reports
MNew Open Delet= Reports
- - Action
Business Activity Statement Reports
tel Hame |Dascription ‘Date Created |Craated By |Others May Moo Sgagﬁz
E i Project Distribution Report o
E Fiecuring Invoice Report Bank Account
== g Export GST Report Reports
f Tranzaction List Client Reports

.g Reports Unapplied Credit Repart Customn
Reports

"

Deposit and
Receipt
Reports

Pivok Reports

Product and
dminiskration Billing Iterm
Reports

onfiguration lransiction I
Eeports

vashboard
[« | i

Plug-Ins ™ Only show my reparts

. _ E The Buzinezs Activity Statement reports on taw infarmation from Accounts
=lai Help Payable, Accounts Receivable, General Ledger, and The Raiser's Edge.

Blackbaud Systems |

“wielcome to Accounts Receivable |

The Business Activity Statement has four tabs on which you set parameters: General, AP Filters, AR Filters, and
Format tabs. To move among the tabs in a report, use Next and Back at the bottom of the screen or select the tab
itself. On these tabs you specify the records to include in the report and how the report should look.

» Creating a Business Activity Statement

Note: The action bar is located above the list of reports and contains links for creating a new report, opening a
report, and deleting a report. These links are common to all Reports pages.

1. From the Reports page, click Transaction Reports. The Invoice Reports page appears with a list of all
invoice reports on the left.
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2. Inthe list on the left, select Business Activity Statement.

x

# The Education Edge _[5]
File Edit Wiew Go Favouites Tools Help

 Back % Farward J Cormmunity Services Inc, = + Accounts Receivable ™
12 Reports » Transaction Reports
Hew [per Delete,.. Reports

ent

|3 Irmvcice Report Name |Descriptmn ‘Date Created |Created Ey |0thers May Moc stgrstlss

j Praject Distribution Report

= 3] Recuring lrvoice Feport E{:Béi;count
g Export ] G5T Repart
= ) Transaction List Clierk Reports

.g Reparts ] Unapplied Credit Report Custarn
Reports

Shartcuts

d

Depasit and
Receipt
Reports

Pivot Reports

Product and
ministration Biling Item
Reports

nfiguration Transaction
- Reports
d
K1 0
_-faphm.]n._: [~ Only show my reparts
¢ |

i E The Business Activity Statement reports on ta information from Accounts
=l Help Payable, Accounts Receivable, General Ledger, and The Raiser's Edge.

Blackbaud Systems |

welcome to Accounts Receivable |

3. Onthe action bar, click New. The New Business Activity Statement screen appears on the General tab. On
this tab, you can set specific parameters and make selections about the information included in the
report.

lQ Mew Business Activity Statement
File Edit “iew Favorites Toolz Help

= D= RN e

1. General |g; AP Filtersl 3 AR FiIters' 4 Formatl

Include Invoice, Credit Memos, and One-Time Checks with these dates -

Drate: Include all dates

Include transactions from these systems -

W Accounts Receivable
W Accounts Payable

[~ Create an output query of Ilnvoices Vl

Report Orientation: Landscape

< Bachk | Next = Catcel Print Preview Layout

Note: Fields, options, and checkboxes on the General tab vary for each report.

4. In the Date field, select a date range for the report. If you select “Specific range”, you must also enter a
start date and end date.

5. In the Include transactions from these systems frame, you can select to include Accounts Payable and
Accounts Receivable transactions in the report.



6. To create an output query, tick the checkbox and select “Invoices”.
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7. Click Next or select the AP Filters tab. On this tab, you can filter the information appearing in the report.

lﬂ Hew Business Achivity Statement E I
File Edit “iew Favouites Toolz Help
=g [zl |
1: Genera 12 aR Fillersl 4 Formatl
| Clear &l Filters
Filters I Include I Selected Filters I
33T Tax Entities All <Al GIT Tax Entities >
Yendors all <all vendors=
Invoices all <all Invoices>
Credit Mokes all <l Credit Motes =
Payments all <Al Payments =
Post Statuses all <Al Post Statuses:=
Yendor Attributes All <all Yendor Attributes =
Inrvoice Aktributes all <all Invoice Attributes =
Credit Moke Attribukes Al <Al Credit Mote Attribukes:
< Back MNest » Catcel Print Freview Layout

Note: Once you select a filter in the grid, you can click Open to access the Selected <Filter> screen on which

you select specific filters.

8. In the Include column, select “All” or “Selected”. If you choose “Selected,” the Selected <Filter> screen
opens so you can designate specific filters. Depending on your selection, different filter screens can

appear.

Selected GST Tax Entities

Include: @ Al

Fin: | N
Include these gst tax entities:

Goods and Services Tax
G5T Free
GST Mot Registered, “Withhold Payment

Al [¥]v

oK

9. To include all of the filters listed in the grid, select All. You can include individual filters by choosing

Selected and moving the filter into the <Selected Filters> box.

10. To view or edit the previous filter without returning to the AP Filters tab, click Previous Filter. To view or

edit the next filter without returning to the AP Filters tab, click Next Filter.
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Note: You can click Clear All Filters to remove all previously selected filters from the report.

11. Click OK to return to the AP Filters tab.
12. Click Next or select the AR Filters tab.

lQ Mew Business Activity Statement I
File Edit “iew Favorites Toolz Help
SRR ElC el |
1 Generall 2 AP Filter: I 4 Formatl
Ep0pen ) Clear Al Fiters
Filters I Inchude I Selected Fileers I
GST Tax Entities Al <8l GST Tax Entities =
Clients All <all Clients=
Invoices all <4l Invoices=
Credits All <all Credits =
Posk Statuses all <all Post Skatuses:
Client &ttributes Al <4l Clienk Attribukes =
Invoice Attributes All <Al Invoice Attributes =
Transaction Attributes all <Al Transaction Attributes =
< Back | Next = Catcel Print Preview Layout

Note: Once you highlight a filter in the grid, you can click Open to access the Selected <Filter> screen on which
you select specific filters.

13.

14.

15.

16.
17.

In the Include column, select “All” or “Selected”. If you choose “Selected,” the Selected <Filter> screen
opens so you can designate specific filters. Depending on your selection, different filter screens can
appear.

You can include all of the filters listed in the grid by selecting All. You can include individual filters by
choosing Selected and moving the filter into the <Selected Filters> box.

To view or edit the previous filter without returning to the AR Filters tab, click Previous Filter. To view or
edit the next filter without returning to the AR Filters tab, click Next Filter.

Click OK to return to the AR Filters tab.

Click Next or select the Format tab. On the Format tab, you select how you want the report to appear. A
description of each formatting option is provided.

Headings. You can enter a maximum of 60 characters in both the Title and Subtitle fields. The program assigns a
name in the Title field based on the record type; in this case, “Business Activity Statement”. You can change
this title. The title and subtitle appear at the top of the report. You can also select how you want the heading
aligned and if you want your organisation’s name to appear in the header.
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You can include other options in the header, such as the page number and the date, also select to include the
header on every page of the report.

File Edit Wiew Favorites

S R =l |

lE Mew Business Activity Statement I

Toolz: Help

B Headings
Criteria

Dretail

Sart

Page Faoter
Feport Footer
Miscelaneous

1: General | 2 &P Fiters | 3: AR Fiker

—Heading Format

Title: |Business Activity Statement

Subtitle: |

Align: ICenter 'I

¥ PFrint organization name in header

W Frint Feport Date in Heading
Format: IShDrt D ate and Time j

Align. Left =]

v Print Page Number in Heading
Farmat: IF'age 1 j

Aligr: | Right =]

[V Print report heading on each page

< Back | e |

Cancel | Brint | Preview | Laypout |

Criteria. Select Criteria to print a list of criteria used to create the report. Tick Print these criteria on and select a
separate page or the first page. All selected options print in the criteria section of the report.

The program automatically selects all criteria. Untick the checkbox for any you do not want to print with the

report.

File Edit “iew Favourtes

RS R -2

IQ Mew Business Activity Statement I

Tools Help

Headings
{8 Ciiteria
Dretail
Sort

Page Footer

Fieport Footer
Mizcelansous

1: General' 2 AP Filtersl 3 AR Filterz 4 Format |

Criteria
™ Print theze criteria on Ia zeparate page 'l

Saved report name

Output query name

Datesz ta Include

Include transactions from these spstems
Accounts Payable tax entities to include
Wendors to include

Accounts Payable invoices to include

Credit notes ta include

One-time cheques to include

Accounts Payable post statuses to include
Accounts Payable vendor attributes to include
Account Payable invoice attibutes to include
Credit note attributes to include

Accounts Feceivable tax entities to include
Clients to include

Account Receivable invoices to include LI

|»

< Back [ Ewt

Cancel Erint Freview | Lapout |
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Detail. Use Detail to select details specific to the report. On this screen you can choose to include the totals
and/or the tax items sections of the report.

lE Mew Business Activity Statement I
File Edit Wiew Favortez Toolz Help

S R =l |

1: General' 2 AP Filtersl 2 AR Filkers 4 Format |

Headings Detail

Criteria
E ot [¥ Include the totals section of the repart.
of
Page Footer ¥ Include the tax items section of the repaort.

Feport Footer
Miscelaneous

< Back | e | Cancel | Brint | Preview | Laypout |

Sort. Use Sort to select the order in which information appears on the report. When you select Sort on the
Format tab, a grid displays the categories you can sort in the report. Select a sorting category in the Sort by
column and select Ascending or Descending in the Order by column.
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If you make no selections in the Sort by column in the grid, the program sorts by GST Tax Entity and

Transaction Type in ascending order.

n Mew Business Activity Statement
File Edit Wiew Favortez Toolz Help
H (&S & B

1: General] 2 AP Filtersl 2 AR Filkers 4 Format l

=] Headings Sort

Z] Criteria

=] Detail Sort by | Order by |

GST Tax Entity Azcending

=] Page Foater Tranzaction Type Azcending

=] Fieport Footer

2] Miscelaneous

< Back | Cancel Brint | Preview | Laypout |

in the page footer, such as the page number and date.

File Edit ‘“iew Favortez Toolz Help
H| (&S GG L

1 General] 2 AP Filtersl 2 AR Filkers  4: Format ]

=] Headings Page Footer

=] Criteria

2] Detail Page Footer Text

=] Sort Teat:
Page Footer
=] Feport Footer
=] Mizcelansous

Cener 7]

[~ Print Page Murnber in Footer [~ Print Report O ate in Footer

| [~ | | -~
| [~ | | =

n Mew Business Activity Statement

< Back Cancel Frint Preview Layout

Page Footer. You can enter a maximum of 255 characters in the page footer. You can also include other options
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Report Footer. You can enter a maximum of 255 characters in the report footer and select how you want text
aligned. The report footer appears at the end of the report.

n Mew Business Activity Statement
File Edit Wiew Favortez Toolz Help

H &= ahW ?-

1: General] 2 AP Filtersl 2 AR Filkers 4 Format l

2] Headings Miscellaneous

Z] Criteria
2] Detal Show currency character on Al amounts
=] Sort Show percent sign on Al amounts
=] Page Foater Megative amaunt farmat [1234.5E)
= Fiepart Foote Mumber of digits after decimal for amounts 2
. - Mumber of digits after decimal for percentages 2

Show 1000's zeparator Yesz

Showe blank s instead of zeros Mo

Font zize a

Sample amoLnt:

Arnount [$1.234 5E)
Percent 100,002
< Back | | Cancel | Brint | Preview | Laypout |

Miscellaneous. You can select how you want numbers to appear on the report. You can also select the font size
used in the report.

n Mew Business Activity Statement
File Edit ‘“iew Favortez Toolz Help

H &= LW ?-

1 General] 2 AP Filtersl 2 AR Filkers  4: Format ]

5] Headings Report Footer

=] Criteria

5 Detai Report Footer Text
2] Sort Text:

=l Page Foater

=] Mizcelansous

< Back Cancel Frint Preview Layout
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Creating a GST Report

The GST Report shows taxes you have received from charges and invoice line items in Accounts Receivable.

The GST Report has three tabs on which you set parameters: General, Filters, and Format tabs. To move among
the tabs in a report, use Next and Back at the bottom of the screen or select the tab itself. On these tabs you
specify the records to include in the report and how the report should look.

» Creating a GST Report

1. From the Reports page, click Transaction Reports. The Transaction Reports page appears with a list of all
transaction reports on the left.

2. Inthe list on the left, select GST Report.

#% The Education Edge HEl
File Edit Wew Go Favowites Toole Help

b

& Back & Forwand J Community Services Inc. = = Accounts Receivable ™

Shartcuts

12 Reports « Transaction Reports

FEE. Home

'Fq'f " New Open [elste. mj
f ] Account Distribution Feport GST Report Qgguurts

j Business Activity Statement
] Invoice Report Mame |Descrlptmn ‘Date Created |Created By |0thers May M
j Project Distribution Report
[Z] Recurring lrvoice Freport

Analysis
Reports

Bank Account
"B GST Report Reports
Trarsaction List Client Reports

Unapplied Credit Repart Custom
Reports

it

d

Deposit and
Receipt
Reports

Pivot Reports

Product and
Billing Ikem
Reports

Transaction
Reports

KN i
__.:-aphm_ln__: [~ Only show my reports
y g
o E A GST Report provides detailed or summarised information regarding GST
e Help transactions for a specified period of time.

Blackbaud Systems |

‘wielzome to Accounts Feceivable |
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3. On the action bar, click New. The New GST Report screen appears on the General tab. On this tab, you

can set specific parameters and make selections about the information included in the report.

I3 Mew GST Report I

File Edit “iew Favourtes Tool: Help
=Pl RN el |

1: General |g: Filtersl 3 Folmatl

Report format: I VI = | Shiov L distritution, far eack Billing entit

Include these dates:

Transaction date: Ilnclude all dates 'I
Post date: Ilnclude all dates 'I

[ Create an output querny of ICIients ‘l

Report arientation: I Portrait = I
< Bach Mest » Catcel Print Freview Layout

Note: Fields, options, and checkboxes on the General tab vary for each report.

4.

In the Report Format field, select “Detail” or “Summary” as the report format. “Detail” format includes
each one line item, while “Summary” displays a total.

In the Transaction date field of the Include these dates frame, select a specific date or date range for
transactions to include in the report.

If you select “<Specific range>", you can specify a start and end date. If the Start date field is blank, all
activity is included up to the end date. If the End date field is blank, all activity from the start date until
present is included. If both fields are blank, all activity is included.

In the Post date field, select a date or date range of post dates to include in the report.

If you select “<Specific range>", you can specify a start and end date. If the Start date field is blank, all
activity is included up to the end date. If the End date field is blank, all activity from the start date until
present is included. If both fields are blank, all activity is included.

To create an output query, tick the checkbox and select “Clients”, “Charges”, “Credits”, or “Products and
Billing Items”.

In the Report orientation field, select “Portrait” or “Landscape”.
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9. Click Next or select the Filters tab. On this tab, you can filter the information appearing in the report.

I3 New GST Report
Fille Edit “iew Favourtes Toole Help

= D= RN ] e 2

]|

1: General 3 Folmatl
@ 0pen ) Clear &ll Filters
Filters | Include | Selected Filters |
Clients all <all Clients:
Client &ttributes Al <4l Clienk Attribukes =
Source Charges all <Al Source Charges=
Source Credits all <4l Source Credits=
Inrvoices All <all Invoices>
Returns all <all Returns >
Transaction Attributes all <all Transaction Attributes =
Piost Skatuses all <l Post Statuses’=
ST Entities all <Al 55T Entities =
Products and Eilling Items all <Al Products and Billing Items =
Product and Eilling Ikem AL,.. All <Al Product and Eiling Item Attributes >

< Back | MNest » Catcel

Print Praview Layaout

Note: Once you select a filter in the grid, you can click Open to access the Selected <Filter> screen on which

you select specific filters.

10. In the Include column, select “All” or “Selected”. If you choose “Selected,” the Selected <Filter> screen
opens so you can designate specific filters. Depending on your selection, different filter screens can

appear.
GST Enities |
Find: |
G5T Entities
Description Description
Goods and Services Tax
GST Free
G5T Mot Registered, Withhold Payment
>
>
<
<

Ok I Cancel |

11. Toinclude all of the filters listed in the grid, select All. You can include individual filters by choosing
Selected and moving the filter into the <Selected Filters> box.

12. To view or edit the previous filter without returning to the Filters tab, click Previous Filter. To view or edit
the next filter without returning to the Filters tab, click Next Filter.
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Note:

13.
14.

Click OK to return to the Filters tab.
Click Next or select the Format tab. On the Format tab, you select how you want the report to appear. A

description of each formatting option is provided.

You can click Clear All Filters to remove all previously selected filters from the report.

Headings. You can enter a maximum of 60 characters in both the Title and Subtitle fields. The program assigns a
name in the Title field based on the record type; in this case, “GST Report”. You can change this title. The title
and subtitle appear at the top of the report. You can also select how you want the heading aligned and if you
want your organisation’s name to appear in the header.

You can include other options in the header, such as the page number and the date, also select to include the
header on every page of the report.

I Hew GST Report

]|

File Edit Wiew Favourtez Tools

= =R =y

Help
2 .
-

1: General' 2 Filters 3 Format |

Criteria
Sort/Break,
Page Footer
Report Faater
Miscelaneous
Colour Scheme

—Heading Format
Title:  |GST Fieport

Subtitle: |

Align: ICenter 'I

¥ PFrint organization name in header

v Print Page Number in Heading W Frint Feport Date in Heading

Farmat: IF'age 1 j Format: IShDrt Date and Time j
Align: IHight j Align: ILeft j
[V Print report heading on each page
< Back | [ Ew | Cancel | Brint | Freview | Laypout |

Criteria. Select Criteria to print a list of criteria used to create the report. Tick Print these criteria on and select a
separate page or the first page. All selected options print in the criteria section of the report.
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The program automatically selects all criteria. Untick the checkbox for any you do not want to print with the

report.

I Hew GST Report

File Edit Wiew Favourtes

Toole Help

= DRE= RE R e 2

]|

Headings
{8 Criteria
Sort/Break
Page Footer
Report Faater
Miscelaneous
Colour Scheme

1: General' 2 Filters 3 Format |

W Frint these criteria an Ia separate page 'l

Saved report name

Output query name

Show GL distibution for each billing entity
Transaction dates to include

Pozt dates to include

Clients to include

Client attributes to include

Source Credits to include

Source Charges to include
Invoices to include

Retumns to include

Tranzaction attributes to inchude
Post statuzes to include

GST entities to include

GST biling items to include

GST billing item attributes to include

< Back | [ Ew |

Cancel | Brint | Freview |

Laypout |

Sort/Break. Use Sort to select the order in which information appears on the report. When you select Sort on
the Format tab, a grid displays the categories you can sort in the report. Select a sorting category in the Sort
by column and select Ascending or Descending in the Order by column.

If you make no selections in the Sort by column in the grid, the program sorts by Billing Entity in ascending

order.
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You can also create breaks between the sections you have sorted by. In the Text before value and Text after
value fields, you can enter up to 30 characters in each field for information you want to print directly before
and after the break. If you mark Print count per Sales tax entity or Print count as percentage of total for the
selected sort field, the number or percentage for each selected sort option appears in the footer. If you mark
Page break on each new Sales tax entity, a new page starts for the highest level break.

I New G5T Report I
File Edit “iew Favourtes Toolz Help

3 S &2 |

1 General' 2 Filkers 3 Format |

Headings Sort/Break

Criteria

Bs k Sart by I Order by I Break? I
Page Footer Eilling entity Ascending
Report Footer
Miscellaneous

Colour Scheme

A i

Break Header for Billing entity-

Text before value: |

Tewt after valus: |

Break. Footer for Billing entity:
¥ Pirint count per Billing entity
[~ Print count as a percentage of batal

[" Page break on each new Billing entity

< Back et | Cancel | Print Previsw Layout
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Page Footer. You can enter a maximum of 255 characters in the page footer. You can also include other options
in the page footer, such as the page number and date.

I Hew GST Report

File Edit Wiew Favourtes Toolz Help

= DRE= RE R e 2

]|

1: General' 2 Filters 3 Format |

Headings
Criteria

Page Footer

—Page Footer Text

Sort/Break,

Text:

{8 Page Foater
Report Faater
Miscelaneous
Colour Scheme

aligr: ICenter 'I

™ Print Page Muriber in Footer

™ Print Feport Date in Footer

Farmat: IF'age 1 j Format: IShDrt Date and Time j
Align | Right 52 (S B 2
< Back | [ Ew | Cancel Brint | Freview | Laypout |

Report Footer. You can enter a maximum of 255 characters in the report footer and select how you want text
aligned. The report footer appears at the end of the report.

1@ New GST Report

File Edit “iew Favourtez Toolz Help

S &G = ?-

1 General' 2 Filkerz 3 Format |

Report Footer

Headings

Criteria
Sort/Break Report Footer Tesxt
Page Footer Text:

‘8 Report Footer
Mizcelansous
Colour Scheme

Aligr: ||_eft vl

< Back | st Cancel

Frint Freview

Layout
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Miscellaneous. You can select how you want numbers to appear on the report. You can also select the font size
used in the report.

I Hew GST Report I

File Edit Wiew Favourtes Toolz Help
FHEE T |

1: General' 2 Filters 3 Format |

Headings Miscellaneous
Criteria

Sart/Break Show currency characker on Al amounts
Page Footer Showe percent sign on Al amounts
R eport Footer Megative amaunt Farmat (1234.56]
E Colour hee Mumber of digits after decimal For amounts 2

Murnber of digits after dacimal For percentages 2

Show 1000's separator Yes

Shows blanks instead of zeros Mo

Faont size g

Sample amoLnt:

Amounk ($1,234.56)
Percent 100, 00%
< Back | [ Ew | Cancel | Brint | Freview | Laypout |

Colour Scheme. Use Colour Scheme to select colours for report headings. When you click in the colour
checkbox next to the selection, the Colour screen appears so you can select a standard colour or define a

custom colour. If you leave the Apply a Colour Scheme checkbox unticked, the report prints in black and
white.

I Hew GST Report I

File Edit Wiew Favourtes Toolz Help
FHEE T |

1: General' 2 Filters 3 Format |

Headings Colour Scheme
Criteria
Sart/Break [ Apply a Colour Scheme

Page Footer
Report Faater

:8 Colour Scheme [T Group heading back colour Group Headings

Report Name
M Colurn heading back calour Subtitle

. Group heading fore colour

Hestane Vefaults |

< Back [ Ewt Cancel Erint Freview Lapout
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This chapter addresses the posting and tracking of GST information from The Raiser’s Edge. To post from

The Raiser’s Edge to General Ledger, you must set up the tax tables and vendor tax defaults in Configuration and
have both programs installed.

Setting Up the Default Tax Entity

To post from The Raiser’s Edge to General Ledger, you must set up tax tables and vendor tax defaults in
Configuration. When you have The Raiser’s Edge installed, the Default GST Tax Entity for The Raiser’s Edge
appears on the General screen of Configuration. From the General screen, you can enter the default sales tax
entity for all transactions posted from The Raiser’s Edge.

» Setting up the default tax entity

1. On the Configuration page, click General. The General page appears.

# The Education Edge ] E3
File Edt View Go Favouites Tools Help
4 Back  ® oyl I Community Services Inc, ™ + Accounts Payable ™
Shartcuts i 3
1 Configuration » General
Qiganization: Community Services Inc. m
General
Country: |Ausl|aha j FJ
Addiess. 33509 Bentinck Street = Attributes
j Aging
Information
City: IF‘ort\and Business
Rules
State: vic ~| Victoria
Tables
Postcode:  [3305 KJ
Phone: [i03) 5555 5555 Distributions
Miscelane. ..
EETAYED (14 ~ Line Ikems
Internatio. ..
ABN: 12345678 90 Address
GST Branch: [333 Interfund
GST Mot Registered Withholding Tax 1D IGST ~| Goods and Services Tax Posting
Information
Default GST Tax Entity for The Raiser's Edge: IGST 'I Goods and Services Tax Default
efaul
Accounts
Products
GST Tax IDS
=lai Help
Blackbaud Systems |
Press F7 for calculator |

2. In the Default GST Tax Entity for The Raiser’s Edge field, select the default sales tax entity for all
transactions posted from The Raiser’s Edge. You can select “GST”, “FRE”, or “GNR”.

Setting Up the General Ledger Transaction
Form

This procedure is an alternative to manually entering transactions in a regular batch. Instead of entering each
transaction in the grid on the batch record, you enter each transaction on the New Transaction screen. The
benefit of using the New Transaction screen is that you see all journal entry grid information at once, instead of
having to scroll through the grid to see each column.

On the New Transaction screen, you can enter transaction distributions, assign attributes, and enter transaction
notes. The procedures for entering transaction distributions, attributes, and notes are the same as if you were
entering them from the batch record.

» Entering transactions using the New Transaction screen

1. On the Journal Entry page, open the regular batch record for which you want to enter transactions.
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Tip: To move between rows in a grid column, press CTRL + the up or down arrow key.

2.

10.

11.

12.

13.
14.

In the row of the journal entry grid where you want to enter the transaction, double-click a cell in the
Account description column. The New Transaction screen appears.

UE: Tranzaction 38-1 E
File Edit “iew | Transaction Tools Help
[ Save and Clos =+ Go To 3] | ? . |
Account: I H Eirst . Operating Cazh Account
Reference: 4| Eievious
L ] e Encumbrance status: [Fregul =l
ransaction type: M Last neumbrance status: | Regular
Amaount: I ——— Joumnal: IJoumaI Entry j
GST Information
Fost date: —_— e hosted  Rewverse on: I
Load Defaults from...
Distribution | Attril T
l otal igtribute By E ey
Project ID I Class I Miszion I Spendable/... | Performance IAmount I Percent I
| 1006 Unrestricted Met Azzetz Mone Spendable $3.00 100.0000
Trangaction 1 01-1000-00 Femaining: $0.00 [0.0000%)

|F'ress F7 for GL account lookup, Shift F7 for ... | | |

In the Account field, select the account affected by this transaction. You can search for an account

number segment or account number by selecting the corresponding icon in the field. Once you select the
account, the program displays the account description.

In the Reference field, enter a reference for this account. This entry becomes the Journal reference on
the main grid.

In the Transaction type field, select “Credit” or “Debit”.
In the Amount field, enter the amount of the transaction you want to credit or debit.

In Post date field, enter the date you want this transaction to post, which means to transcribe and
summarise detailed transaction data from journals or subledgers into the general ledger.

In the Encumbrance status field, select “Regular” or “Encumbrance”. The Type field is visible only when
your accounting system is set up for encumbrance accounting.

In the Journal field, select a journal for this transaction.

In the Reverse on field, you can enter a date to reverse the transaction creating a new transaction with
the same characteristics, excluding post date, debit/credit, and journal reference.

To access GST information for the transaction, select Transaction, GST Information. The Transaction
screen appears.

. Transaction 38-1
GST Tax Entity: I ‘l Goods and Services Tax
Amaunt: |$3.DD

Ok | Cancel |

In the GST Tax Entity field, select an available GST entity. The GST Amount column is calculated on the
entity’s percentage.

To return to the Transaction screen, click OK.

To assign optional transaction distributions, attributes, or notes to this transaction, enter them on the
Distribution tab, Attributes tab, or the Notes tab.
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15. Once you complete this transaction, to add another transaction for the next row in the grid, save the
current transaction and select File, New. Another New Transaction screen appears so you can enter
transaction details for an additional transaction.

16. To return to the batch record screen, click Save and Close. The new transactions you entered appear in
the batch record journal entry grid.
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EFT stands for electronic funds transfer, a general banking system in which transactions, such as deposits and bill
payments, are made through computer databases and electronic files. Money does not physically change hands;
it transfers electronically from one account into another account.

If you have the optional module Electronic Funds Transfer, which adds fields and options to areas of Accounts
Payable, you can send and receive electronic transfers.

This chapter is divided into two sections. The first section details EFT functionality for Australian banks. The
second section details EFT functionality for New Zealand banks. If your bank is located in New Zealand, see
“Adding EFT Information in New Zealand” on page 145.

Adding EFT Information in Australia

The bank account record stores account, payment, deposit, and adjustment information for a particular bank
account. EFT functionality on the bank record includes the location for entering the BSB number, and form
options for printing EFT notices.

You can also set EFT default options from the bank record. For more information on setting up EFT default
options, see “Defining Default EFT Options” on page 135.

» Adding EFT information to the bank record
1. From the Banks page, click Open. The Bank Account record opens to the Bank tab.

'ﬁ Bank Account - Operating Account ;Iglll

File Edit Yew BankAccount Favourites Tools Help

dSaveandClosev|H xl.___{;j|“ 4 b ﬂ|w|ﬂ|3}’|?' |

Bank | anmentsl Deposits I Adjustment Categaries I ﬂotesl History of Changesl

Azcount deseription: IDperating Account Bark name: IBank & Trust
Account 1D: IDperating Address: |
Account lype: I Cument j
Account status: IDpen ﬂ Contact name: ||Mr. Mitchell P. Greenbach, 11
Account number: |5023D21 009 Contact position: IVP of Special Accournts [ Print?
BSE number: |‘|23-458 Contact Type I Conkack Number I ﬂ
HMinimum balance: |$D.DD |_[Business
Fax
Interfund set: IU‘] j [ LI
Syskem I Account Setup I Track Cash In Default Cash Account ﬂ
Accounts Pavable Define cash account(s) One Fund 01-1000-00
Accounts Receivable  Does not use this bank acoount
Cash Receipks Does not use this bank account
Cash Management Define cash accountis) One Fund 01-1000-00
iLllflnt Billing Does niok use this bank account _ILI
4 3

| | 10/04/2008

In the Account description field, enter the name of the bank account.

In the Account ID field, enter a unique identification for the bank account. This ID must be unique
because it is used to identify each bank account and cannot be used for more than one account. Be
accurate when you enter the ID because the way you enter it is how it appears on reports and mailings.

” ou

In the Account type field, select “Current”, “Savings”, or “Other”.

5. In the Account status field, select “Open” or “Closed”. If an account is closed, you can still edit
information in the bank account record and use the account to print cheques. However, a closed bank
account does not appear on invoice records in Accounts Payable.

6. Inthe Account number field, enter the account number assigned by the bank.
In the BSB number field, enter the six-digit BSB number provided by the bank.
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11.
12.
13.

14.

15.

16.

17.
18.

19.
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In the Minimum balance field, enter the minimum amount the bank requires for you to avoid service
charges. If there is no minimum balance requirement, you can leave this field blank.

In the Interfund set field, select the interfund set used to make balancing entries between funds in
General Ledger. Interfund sets are created in Configuration.

In the Bank name field, enter the name of the bank.
To add address information for this account, click Address or enter the information in the field.
To add a contact name for this account, click Contact name or enter the name in the field.

To add the contact’s position at the bank, enter the information in the Contact position field. To print the
position on mailings, tick Print?

If you did not enter the contact through Address, enter it in the contact grid. In the Contact Type and
Contact Number columns, select a contact type and enter the number.

To define the cash accounts that will use this bank account, make selections for each accounting program
in the grid at the bottom of the screen.

Select the Payments tab. On the Payments tab you select form options for printing EFT notices.

ol x|

'ﬁ Bank Account - Dperating Account
File Edit Yiew BankAccount Favourites Tools Help

(- Save and Close + 7~ |

BX|E S " Do

Bank Payments |erosits| Adjustment Categoliesl ﬂotesl Histomy of Changesl

9§ vy
I IMairnurnn Amounlﬂ
$999,999,994,4

$999,999,999,
$999,999,9949
$999,999,999,'
$999,999,999,!
$999,999,999
Stark with $999,999,999,'
Stark with $999,999,999,' <

Lot Ao Ane oo
3

By default. print tran s to this printer:

Text Mumber

Murnbeting I
Stark with

I Transaction Type I Allgw? I
Computer Cheque v
Electronic Funds Tra...

Syskemn

Accounts Pavyable 1124

Accounts Payable

Accounts Pavable  Manual Cheque Accounts Payable Con,..

Same range as

One-Time Chegue Accounts Payable Com,..

EBank Draft

Accounts Pavyable Same range as
Skark with 101
Start with 1

Accounts Payable One-...

Accounts Payable
Cash Management  Adjustment

Accounts Receiva... Refund Chegue Same range as
Payrall Computer Cheque

Payroll Electronic Funds Tra...

Accountz Payable EI

LT T e

7 'I_l—l_l?l?l?l?lH

tronic Funds T

.

Default form: |{aE R =i

|?.x Single stub EFT notice

Edit Papment Options |

| [ 10/04/2006

In the Default form field, select the format you want to use when printing EFT notices.

To set EFT default options, click Edit Payment Options. For more information on setting up EFT default
options, see “Defining Default EFT Options” on page 135.

On the action bar, click Save and Close to return to the Banks page.

Defining Default EFT Options

You set EFT default options from the Payments tab of the bank record. You can define the following payment

options for Accounts Payable EFT:
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Cheque Alignment. To define the alignment of cheques on forms, select Cheque Alignment on the left of the
Default Payment Options screen.

= Default Payment Options for Accounts Payable Electronic Funds Transfer ﬂ

Cheque Alignment

Address Alignment

Cheque Stub Information Yertical alignment; | Default alignment A I Ihches vI
Motes = 9 g I a J I

Print Farmat Horizontal alignmert: i I

EFT General o g -IDefauIt alighment vI Ilnches vI

Mote: Maximum vertical adjustments
Up:  0.25 inches or B.35 millimeters
Dowr: 1 inch or 25.4 milimeters
M aximum horizontal adjustments
Left:  0.25 inches or B.35 millimeters
Right: 1 inch or 25.4 milimeters

Cancel |

In the Vertical alighment field, select “Default alignment”, “Move printed information up”, or “Move printed
information down”.

If you select “Move printed information up” or “Move printed information down”, you can select the distance
to move the information. For example, if you select “Move printed information up” in the Vertical alignment
field, enter .02, and select Inches, the information prints .02 inch higher on the cheque.

In the Horizontal alignment field, select “Default alighment”, “Move printed information left”, or “Move
printed information right”.

If you select “Move printed information left” or “Move printed information right”, you can select the distance
to move the information. For example, if you select “Move printed information left” in the Horizontal
alignment field, enter .02, and select Inches, the information prints .02 inch toward the left on the cheque.

Address Alignment. To define the alignment of addresses on forms, select Address Alignment on the left of
the Default Payment Options screen.

= Default Payment Options for Accounts Payable Electronic Funds Transfer ﬂ

! Address Alignment

Eheque Stub Infomation Yertical alignment: | Default alignment - I Inches -
Mates - B ) I J J I J
Print Format Harizontal alignment: i I

EFT General jul Ja] -IDefauIt alignment j IInches j

Mote: Maximum vertical adjustments
Up: 1 inch or 25.4 milimeters
Dowr: 1 inch or 25.4 milimeters
M aximum horizontal adjustments
Left: 1 inch or 25.4 milimeters
Right: 1 inch or 25.4 milimeters

Cancel |

In the Vertical alignment and Horizontal alignment fields, select “Default alignment”, “Move printed
information up”, or “Move printed information down”.
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If you select “Move printed information up” or “Move printed information down”, you can select the distance

to move the address. For example, if you select “Move printed information up” in the Vertical alignment field
and enter 2, the address prints .02 inch higher on the form.

Cheque Stub Information. To select information to print on cheque stubs, select Cheque Stub Information on
the left of the Default Payment Options screen.

= Default Payment Options for Accounts Payable Electronic Funds Transfer

‘Cheque Stub
Motes

Frint Format
EFT General

Cheque Alignment
\Address Aligrmert

Information

Cheque Stub Information

Frint thiz information on the chegue stub:

[~ Wendor 1D
[~ 4BN

[~ Contact
I Fax

[~ Phone
[~ Email

Frint jrvoices on the cheque stub in this order:

Select All |
Deszelect All |

Sork By Crder By

Inwvoice Date Ascending

¥ Show the application of each credit mema

¥ Shawthe Discount colurmn

=

Jod|

Cancel |

In the Print this information on the cheque stub box, tick one or all of the checkboxes: Vendor ID, ABN,
Contact, Fax, Phone, or Email.

In the Print invoices on the cheque stub in this order grid, select how to itemise invoices on the cheque stub.

For example, to list invoices by invoice number with the lowest number first, in the Sort By column select
Invoice Number. In the Order By column, select Ascending.

Note: To sort even further, you can sort by Invoice Date and Invoice Amount.

To print credit memo applications on the cheque stub, tick Show the application of each credit memo.

To show the discount amount as recorded in the vendor record, leave Show the Discount column ticked.

Notes. To print a note on cheques and cheque stubs, select Notes on the left of the Default Payment Options

screen.

Frint Format
EFT General

Cheque Alignment
Address Alignment
Chegue Stub Information

& Prirt the:
" Print this note:

= Default Payment Options for Accounts Payable Electronic Funds Transfer

I Mote from Yendor

¢ To print a note on the cheque, tick Print Note on Cheque. Tick Print the to access a drop down menu of
note selections. Tick Print this note to personalise a note on the cheque.

¢ To print a note on the cheque stub, tick Print Note on Cheque Stub. Tick Print the to access a drop down
menu of note selections. Tick Print this note to personalise a note on the cheque stub.
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Print Format. To select a printing format, select Print Format on the left of the Default Payment Options
screen.

= Default Payment Options for Accounts Payable Electronic Funds Transfei ﬂ
Cheque Ali_gnment Print Format
Address Alignment

ﬁh?que Stub Information Print format: ITotaI Per Cheque Printing j
otes

A maximum of 12 trangzactions will print on the cheque stub and the cheque will be
EFT General printed for that amount. [f a vendor has more than 12 transactions to pay, additional
cheques will be created bazed on the number of transactions remaining.

¢ Select “Total Per Cheque Printing” to print each cheque for the amount of the transactions that can fit on

the cheque stub. Additional cheques are created based on the number of transactions fitting on a cheque
stub.

¢ Select “Additional Document Cheque Printing” to print one cheque for the total amount and print all
transaction details on a separate sheet regardless of the number of transactions on the cheque stub. Tick
Print the transaction detail sheets or Export the transaction detail sheets to print or export transaction
details. To print the distribution for the payment, tick Show distribution for these characteristics and tick
the checkboxes for the information to appear with the transactions.

¢ Select “Combination Cheque Printing” to print one cheque for the total amount and print any transactions
not fitting on the cheque stub on a separate sheet of paper. Tick Print the transaction detail sheets or
Export the transaction detail sheets to print or export transaction details.

EFT General. To make formatting selections for EFTs, select EFT General on the left of the Default Payment
Options screen.

= Default Payment Options for Accounts Payable Electronic Funds Transfei ﬂ

Cheque Alignment EFT General

Address Alignment

Cheque Stub Information Dutput file name:

Mates i . I ;I
Prirt Farmat Account name: I

EFT General i

User number: I
Bank abbreviation: I

[V Include a contra entry [self balancing ling)

Lodgement Reference: I

Cancel |

In the Output file name field, enter the path and file name of the EFT file to create or click the ellipses to
search for a file.

The Account name field will display the bank account description.
In the User number field, enter your six-digit numeric code. This number is supplied by your bank.

In the Bank abbreviation field, enter the bank’s three-character abbreviation. This abbreviation is supplied by
your bank.

Tick Include a contra entry (self balancing line) to create an additional transaction line, or balancing entry, in
the EFT file. The Lodgement Reference field becomes active and you can add this information to the contra
entry line.



EFT TRANSACTIONS 13

Managing EFT Bank Information

From the EFT Bank Information tab on the vendor record, you can establish the necessary banking information to
perform electronic funds transfers with your vendors. When you add a new vendor bank you can designate the
account name, account number, institution ID, and contact address information.

The EFT Bank Information tab appears only if you have the optional module Electronic Funds Transfer.

» Adding a new vendor bank to a vendor record

1. From an open vendor record, select the EFT Bank Information tab.

* 0097 - A+ Office Supplies
File Edit Yiew Yendor Favourites Tools Help

uSaveandﬁlosev|H xh;ﬁ é|" L N||%| @|E|ﬂ|1’l‘|?' |
I

Motes I History of Changes I

Media
Vendgrl Activity I Becuring I Purchaze Orders I Addresses

Actions I
Diistribution I Attributes I

A& NewVendorBank @5 Open Delete

|

Chequing

Bank Mame Account Type EFT Status Motes

EFT

[ | active | 10/04/2008 4

2. From the EFT Bank Information tab, click New Vendor Bank. The New Bank screen appears.
New Bank for A+ Office Supplies ﬂ
File Edit Yiew Account Tools Help
uSaveandﬁlosev|H | M 4 » kM | ?- |
EFT status: x| Bank name: I
Account number: I Address: | ;I
Account name: |A+ Office Supplies LI
BSE number: I Contact | I
Contact position: I
Motes: Contact info:
;I r_I Contact Type Contact Mumber
=
[ 10/04/2005
3. Inthe EFT status field, select “EFT” or “Inactive”.
4. In the Account number field, enter the account number.
5. Inthe Account name field, enter the name of the account.
6. Inthe BSB number field, enter the six-digit BSB number provided by the vendor’s bank.
Note: The BSB number must be provided by the vendor’s bank.
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10.
11.
12.

13.

In the Bank name field, enter the name of the bank.

To add bank address information, click Address. For more information about entering address
information, see “Adding vendor bank address information on the vendor record” on page 140.

To add bank contact information, click Contact Name. For more information about entering contact
information, see “Adding vendor bank contact information on the vendor record” on page 140.

In the Contact position field, enter the contact’s position.
In the Notes grid, enter any notes associated with the bank.

In the Contact info grid, select a contact type in the Contact Type column and enter the contact number
in the Contact Number column.

To return to the EFT Bank Information tab, click Save and Close.

» Adding vendor bank address information on the vendor record

1.
2.

No v s~ w

9.

From an open vendor record, select the EFT Bank Information tab.
From the EFT Bank Information tab, click Address. The Address screen opens to the General tab.

Address For New Bank |

General | LContact I

Couritry: lm j Conkact Type Conkact Mumber I
Address: ;I -
| -
City: I
State: Iﬁ
Postcode: I—

Address as it will be printed: ;I [V Synchionize with individual address fields

|

()3 | Cancel |

| Presz F7 for table lookup

In the Country field, select the country of the bank.
In the Address field, enter the bank’s address.

In the City field, select the bank’s city.

In the Postcode field, enter the bank’s Postcode.

In the contact grid, select types in the Contact Type column and enter details in the Contact Number
column. This grid is the same as the contact grid on the EFT Bank Information tab of the vendor record.

In the Address as it will be printed box, verify the address is formatted the way you want it printed on
reports. The Address as it will be printed box is the same as the Address box on the EFT Bank Information
tab of the vendor record. To update the address boxes based on the individual address fields on the
Addresses screen or update individual address fields on the Addresses screen based on the address boxes,
tick Synchronise with individual address fields.

To return to the New Bank screen, click OK.

» Adding vendor bank contact information on the vendor record

1.

From an open vendor record, select the EFT Bank Information tab.
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2. From the EFT Bank Information tab, click Contact. The Address screen opens to the Contact tab.

Address For New Bank x|
Contact
Title 1: | x| Tite2] =l
First name: I
Middle name: I
Last name: I
Suffix 1: I j Suffix 2 j
Position: I ™ Print?
Full name:
IV Synchionize full name and individual name figlds

()3 | Cancel |

In the Title 1 field, select a primary title for the contact.

In the Title 2 field, select a secondary title for the contact.

In the First name field, enter the contact’s first name.

In the Middle name field, enter the contact’s middle name.

In the Last name field, enter the contact’s last name.

In the Suffix 1 and Suffix 2 fields, select formal suffixes such as “Jr.” or “Ph.D”.

LW e NV W

In the Position field, enter the contact’s job title. To print the information entered in the Position field,
tick the Print? checkbox.

10. In the Full name field, verify or edit how the contact’s full name should appear. To update the full name
based on the individual name fields or update individual name fields based on full name, you can tick
Synchronise full name and individual name fields.

Creating an EFT payment

Note: To pay an invoice using EFT, you must select “Electronic Funds Transfer” as the Payment method on the
invoice record.

You can make EFT payments from the Banks page by clicking Print cheques and record bank drafts and accessing
the Create Payments screen. Keep in mind, to pay an invoice using EFT, you must select “Electronic Funds
Transfer” as the Payment method on the invoice record.

Using Print cheques and record bank drafts under Payment tasks, you can record and generate cheques and
bank drafts for a series of payments in one payment run.

You can process payments using the default payment options selected for the bank account or make new
formatting selections on the Format tab. For more information about default payment options, see “Defining
Default EFT Options” on page 135.
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» Creating a payment

1.

10.

From Payment tasks on the Banks page in Accounts Payable, click Print cheques and record bank drafts.
The Create Payments screen appears.

;’n Create Payments x|

File Edit Yew Tools Help
Gd?- |

iSten 1 "'G'é'r'wér'él'él 2: Filters | 3 Invoices | 4: One-Time Chegues | 5 Format

Payment Run

Payment date: ITnday vl Pay all vendors in this payment run IBased on payment method vI
Calculate discounts as of: IF'a_l,lmenl date vl Pay EFT Banks with this cycle: |<A|\ EFT cycles» 'I

Post status: IFlom Irvoice ‘I
Post date: IF'a_l,lmenl date ‘I

Include invoices with these dates

Invoice due date on or before IW

¥ Include invoices with discounts that expire on or before IW
Printer Options
Frint report ta this printer: IAdobe FDF j
PFrint payments to this printer: I j

¥ Pause prirting between paprment types

< Back | Mext > I Cancel | Create Later | Lreate Mow
| |4U Ireeoicels) approved: $54.548 67 |D One-Time Chequels) approved: $0.00

In the Payment date field, select “Today”, “Period end date”, or “Specific date” for dating the payments.
If you select “Specific date”, enter a date in the Date field.

In the Calculate discounts as of field, select “Payment date”, “Today”, “Period end date”, or “Specific
date” as the date for the program to use to determine if discounts are valid or expired. If you select
“Specific date”, enter a date in the Date field. If none of the selected invoices have discounts, the program
ignores this date.

In the Post status field, select the posting status to add to the payments included in the run:

¢ “From Invoice” — The program assigns the post status according to each invoice’s post status. Enter a
date to post in the Post date field.

¢ “Not Yet Posted” — The program changes all payments from this payment run to Not Yet Posted. Enter
a date to post in the Post date field.

¢ “Do Not Post” — The program changes all payments from this payment run to Do Not Post.
In the Pay all vendors in this payment run field, select the method to use when you pay invoices:
e “Based on payment method” — The program makes the payment as recorded in the invoice record.

e “By Computer Cheque” — The program makes the payment by computer cheque, regardless of the
method recorded in the invoice record. You can select “By Computer Cheque” only if you have security
rights.

In the Pay EFT Banks with this cycle field, select an EFT cycle. EFT cycles are defined in Configuration.

To select invoices by date information, in the Invoice due date on or before field, enter a date. The
program compares the date entered in this field with the scheduled payment date on the invoice.

To pay invoices before discounts expire, tick Include invoices with discounts that expire on or before and
enter an expiration date in the field.

In the Print report to this printer field, select the printer for the control report.
In the Print payments to this printer field, select the printer for the cheques, EFT notices, or bank drafts.



11. Click Next or select the Filters tab.

Note: The bank selected on the Banks page automatically appears as a Banks filter.

12.

13.
14.
15.

& Create Payments | x|
File Edit \iew Help
ad?- |

Step1: General  2: Filters | 3 Invoices | 4: One-Time Checks I 5 Formatl

< Open Clear Filters

Filters I Include I Selected Filkers

Wendors Al <l vendors =

Invoices Al <Al Invoices >

Barks Selected Operating
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To select filters, choose “Selected” in the Include column. The Selected <Filters> screen appears so you

can select filters for the payment run.
Click OK.

You return to the Filters tab and filters you selected appear in the Selected Filters column.

Click Next or select the Invoices tab.

;,n Create Payments : LI
File Edit Yiew Tools Help
a3 ?-
Step 1. Generall 2 Filkers 3 Invnices | 4: One-Time Chequesl 5 Formatl
Hide D etails
Pay? | InvoiceMumber | Date | WYendor |  Description |  DateDue  |Payment Amourk| AmountDus |~
[ soas4-n03 D4{05{2006 A+ Office Supplies Monthly suppliss 04052006 $575.00 $575.00
-004 i} A+ Office Supplies |I"-‘1-:wr|th|';.-‘ supplies 050512006 $5?5.IIIEI|
M 12-39324-073 01/05/2006 ADS Security Sy... Monthly Security .., 01/20/2008 $75.76 $75.76
[ 12-34324-074  02/05/2006  ADS Security Sy... Monthly Securky ., 02/20/2006 $75.76 $75.76
[T 1z-34324-075 03052006 ADS Securicy Sy... Monthly Secoriy ., O3/20/2006 $75.76 $75.76
[T 1z-34324-076  OHOS(2006  ADS Security Sy... Monthly Securky .. D4/20/2006 $75.76 $75.76
[T 1234324077 OS/05/2006  ADS Security Sy... Monthly Securky ., 0S/20/2006 475,76 475,76
[T 1z-34324-078 06/05/2006 ADS Security Sy... Monthly Security ... 06/20/2006 $75.76 $75.76
[ 6363636-015 D1/10{2006  AlphaGraphics  Office Supplies 01/25/2006 $1,000.00 $1,000.00
[ 6363636-016 02f10{2006 AlphaGraphics Office Supplies 02/25/2006 $1,000.00 $1,000.00
KI| '
Invoice number 55854-004 Fatential discount $0.00 Credit applied $0.00
Irwoice date 05/05/2006 Discount expires 05/05,/2006 Dizzount amount $0.00
Invoice amount $575.00 Unpaid balance $575.00 Balance due now $575.00
Amount paid $0.00 Available credit $0.00 Payment amount $575.00
GST amount $0.00 Credit GST amount $0.00
< Back | Mext > I Cancel | Create Later | Lreate Now
| |1 Invoice(s] approved: $575.00 |D One-Time Cheque(s) approved: $0.00

16. In the Pay? column, tick the checkbox for each invoice you want to pay. To pay all the invoices, click

Select All on the action bar.
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17. Click Next or select the Format tab.

& Create Payments x|
File Edit ‘iew Tools Help

agl?- |
Step 1 Generall 2 Filters | 2 Invaices | 4: One-Time Cheques 55_1...5.0.[!1153.!.'

Payment Options for EFT Notices

Payment Inf :
Papment format: I j I
Starling payment number IBTUD2 Restore Default |
I | Fiint payment number Edit Payment Options
Frint Test Alignment Cheque
Format.
Cheque nate: Mo note printed on the cheque
Cheque stub note: Mo noke printed on the cheque stub

Frint payments in this order -

Sork By Order By Iﬂ
Payee name Ascending
-l
< Back | Hezt s I Cancel | Create Later | LCreate Mow
| |1 Invoice(s] approved: $575.00 |D One-Time Chequels) approved: $0.00

18. From the list on the left, select a payment method. The right side of the screen displays the default

19.

20.
21.

formatting selections for that payment type as selected on the Payments tab of the bank account record.
The payment methods are the payment methods for the current approved invoices.

In the Payment format field, select a blank or preprinted form on which to print the payments. If the bank
account is set to have multiple payment types use the same numbering series as another payment type,
the Starting payment number field displays the first available number for payments using the same
range.

In the Starting payment number field, enter the first number for the selected payment type.
To print the cheque number on preprinted cheques, tick Print payment number.

Note: To save changes on the Default Payment Options screen for the bank account, tick Save these changes
to the Bank Account.

22.

23.

24.

25.

To make changes to payment options in the bank account record, click Edit Payment Options. For more
information about defining payment options, see the Banks Guide.

To make sure information is aligned properly on cheque forms or paper, click Print Test Alignment
Cheque.

Select how to sort cheques when printing, in the Sort By and Order By columns in the Print payments in
this order frame. For example, to sort cheques by payee name alphabetically, select “Payee name” in the
Sort By column. In the Order By column, select “Ascending”.

To review a report of the payments to be made before creating the payments, select File, Preview
Pre-Payment Report.
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26. Click Create Now at the bottom of the screen. If you ticked View payment summary information before
creating payments in Options, the Verify Payment Information screen appears.

E= Yerify Payment Information

Y'ou are about to create payments az thown here:

x|

Payment Type | Mumber |Start Numberl End MNumber I Transactions

Taotal Amaunt

EFT Cheques 1 67002 67002 1
Totals 1 1

' ou have zelected these paument options:

$575.00
$575.00

Payment date: 10/04/2008

Post date: 1040472006

Calculate discounts a5 of 10/04/2006
Frint payments to this printer; Adobe PDF
Frint reports to thiz printer; Adobe PDF

Eﬂgreate

Cancel |

27. To process the payments, click Create Payments. The first payment type prints and the Payment Printing

Status screen appears for this payment type.

E= Payment Printing Status

Examine the printed cheques for accuracy, then select the appropriate options.

x|

oK |

Payment Type IStart NumberI End MNumnber I Successful? | Clear Al Payments | Clear Date
EFT Cheque G002 G002 ................. |7 .................. [N 10042006
‘rou indicated EFT Cheque printing was not successful..

I j numberz] I through I

28.
29.

If the payments printed unsuccessfully or incorrectly, untick the checkbox in the Successful? column.
The You indicated Computer Cheque printing was not successful frame becomes enabled. To void and

purge the unsuccessful payments, tick Void Cheques and Purge voided cheques and enter the range of

payment numbers.
30.

Click OK. The program processes all other payment types in the order they appeared on the Verify

Payment Information screen, and you return to the Banks page.

Adding EFT Information in New Zealand

The bank account record stores account, payment, deposit, and adjustment information for a particular bank
account. EFT functionality on the bank record includes the location for entering the Bank number, and form

options for printing EFT notices.

You can also set EFT default options from the bank record. For more information on setting up EFT default

options, see “Defining Default EFT Options” on page 135.
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» Adding EFT information to the bank record
1. From the Banks page, click Open. The Bank Account record opens to the Bank tab.

10.
11.
12.
13.

14.

15.

-
i

Bank Account - Dperating Account

=101 x|

File Edit Yiew Bank Account Favourites Tools Help

dSaveandEIosev|.ﬂ x|.___{;j|“ 4 "|U|ﬂ|3}’|?'

Account description:
Account 1D
Account type:
Account status:
Account humber:
Bank number:
Minimum balahce:

Interfund set:

Bank |anments| erositsl Adjustment Eategoriesl ﬂotesl Histary of Ehangesl

IDperating Account Bank name: IBank & Trust

IDperating Address: | [

IEurrent j

IDpen j Contact name: ||Mr. Mitchell P. Greenbach, ||

|5U23U21 oo3 Contact pasition: IVF' of Special Accounts ™ Print?
|12-3458 Contact Type I Contact Number I ﬂ
i fous oz

Jot Bl = ||

Syskem

I Account Setup

I Track Cash In

I Default Cash Account

Accounts Payable
Accounts Receivable
Cash Receipts

Cash Management

Define cash accountis)
Does nok use this bank account
Does nok use this bank account
Define cash accountis)

Cne Fund

Cne Fund

=

01-1000-00

01-1000-00

Does niok use this bank account

Student: Eilling T
4 »

[ 10/03/2008

|F'ress F7 to zoom

In the Account description field, enter the name of the bank account.

In the Account ID field, enter a unique identification for the bank account. This ID must be unique
because it is used to identify each bank account and cannot be used for more than one account. Be
accurate when you enter the ID because the way you enter it is how it appears on reports and mailings.

In the Account type field, select “Current”, “Savings”, or “Other”.

In the Account status field, select “Open” or “Closed”. If an account is closed, you can still edit
information in the bank account record and use the account to print cheques. However, a closed bank
account does not appear on invoice records in Accounts Payable.

In the Account number field, enter the account number assigned by the bank.
In the Bank number field, enter the six-digit bank number provided by your bank.

In the Minimum balance field, enter the minimum amount the bank requires for you to avoid service
charges. If there is no minimum balance requirement, you can leave this field blank.

In the Interfund set field, select the interfund set used to make balancing entries between funds in
General Ledger. Interfund sets are created in Configuration.

In the Bank name field, enter the name of the bank.
To add address information for this account, click Address or enter the information in the field.
To add a contact name for this account, click Contact name or enter the name in the field.

To add the contact’s position at the bank, enter the information in the Contact position field. To print the
position on mailings, tick Print?

If you did not enter the contact through Address, enter it in the contact grid. In the Contact Type and
Contact Number columns, select a contact type and enter the number.

To define the cash accounts that will use this bank account, make selections for each accounting program
in the grid at the bottom of the screen.
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16. Select the Payments tab. On the Payments tab you select form options for printing EFT notices.

'ﬁ Bank Account - Dperating Account

File Edit Wew BankAccount Favourites Tools Help

L'jSaveandEIosev|H X|g d|" 1 b N|E|5J|ﬁl|?'

Bank Payments |erosits| Adjustment Categoliesl ﬂotesl Histary of Ehangesl
SRR
Mext Mumber | Maxirmurnn Amounlﬂ
$993,393,993,"
$2 g,
$999,999,999,
$999,993,999,
$999,999,999,

$099,000,999,:
$099,000,999,

By default, print tr: i is printer:

Systern | Transaction Type | Allaws? | Murnbering |
Stark with 1124
Stark with 6

Accounts Payvable  Computer Cheque v

H

Accounts Payable  |Electronic Funds Tra...

Accounts Payable  Manual Cheque

Samerange a5 Accounts Payable Com,..

Accounts Pavable  One-Time Cheque Same range a5 Accounts Payable Com,.,
Skark with 101

Stark with 1

Accounts Pavable  Bank Draft
Cash Management  Adjustment

Accounts Receiva, .. Refund Chegue Same range a5 Accounts Payable One-...

2 e S B

Payroll Computer Cheque Skark with $999,999,599,
Payrall Electronic Funds Tra... Start with $999,999,099,
[ L P | M Pl U R Iy ACmn T e b
4 I I 3
Accountz Payable Electronic Funds T f p

EVE TN F T4 P AL PPO0Z |?.H Single stub EFT natice

Edit Payment Options |

| 10/04/2006

17. In the Default form field, select the format you want to use when printing EFT notices.

18. To set EFT default options, click Edit Payment Options. For more information on setting up EFT default
options, see “Defining Default EFT Options” on page 135.

19. On the action bar, click Save and Close to return to the Banks page.

Defining Default EFT Options

You set EFT default options from the Payments tab of the bank record. You can define the following payment
options for Accounts Payable EFT:

Cheque Alignment. To define the alignment of cheques on forms, select Cheque Alignment on the left of the
Default Payment Options screen.

Motes

Default Payment Dptions for Accounts Payable Electronic Funds Transfer ﬂ
Address Alignment
Cheque Stub Information

Frint Format
EFT General

j I I Inches j

j I_ IInches j

Wertical alignment: IDefauIt alignment

Horizontal alignment: I Default alignment

Mote: Maximum vertical adjustments
Up:  0.25 inches or B.35 millimeters
Dowr: 1 inch or 25.4 milimeters
M aximum horizontal adjustments
Left:  0.25 inches or B.35 millimeters
Right: 1 inch or 25.4 milimeters

Cancel |
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In the Vertical alignment field, select “Default alignment”, “Move printed information up”, or “Move printed
information down”.

If you select “Move printed information up” or “Move printed information down”, you can select the distance

to move the information. For example, if you select “Move printed information up” in the Vertical alignment
field, enter .02, and select Inches, the information prints .02 inch higher on the cheque.

In the Horizontal alignment field, select “Default alignment”, “Move printed information left”, or “Move
printed information right”.
If you select “Move printed information left” or “Move printed information right”, you can select the distance

to move the information. For example, if you select “Move printed information left” in the Horizontal
alignment field, enter .02, and select Inches, the information prints .02 inch toward the left on the cheque.

Address Alignment. To define the alignment of addresses on forms, select Address Alignment on the left of
the Default Payment Options screen.

= Default Payment Options for Accounts Payable Electronic Funds Transf ﬂ

| Address Alignment

) gnment

Cheque Stub Information Yertical alignment: | Default alignment - I Inches -
Mates - B ) I J J I J
Print Format Harizontal alignment: i I

EFT General jul Ja] -IDefauIt alignment j IInches j

Mote: Maximum vertical adjustments
Up: 1 inch or 25.4 milimeters
Dowr: 1 inch or 25.4 milimeters
M aximum horizontal adjustments
Left: 1 inch or 25.4 milimeters
Right: 1 inch or 25.4 milimeters

Cancel |

In the Vertical alignment and Horizontal alignment fields, select “Default alignment”, “Move printed
information up”, or “Move printed information down”.

If you select “Move printed information up” or “Move printed information down”, you can select the distance
to move the address. For example, if you select “Move printed information up” in the Vertical alignment field
and enter 2, the address prints .02 inch higher on the form.
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Cheque Stub Information. To select information to print on cheque stubs, select Cheque Stub Information on

the left of the Default Payment Options screen.

= Default Payment Options for Accounts Payable Electronic Funds Transfei

Frint thiz information on the chegue stub:

Print Format [” Vendor ID Select All |
EFT General [~ GS5T Registration Mumber
[ Cortact Deselect all |
I Fax
[~ Phone
[~ Email
Frint jrvoices on the cheque stub in this order:
Sork By Crder By Iﬂ
Inwvoice Date Ascending

¥ Show the application of each credit mema

¥ Show the Discount colurn

Cheque Alignment Cheque Stub Information
Address Alignment
‘Lheque farmation

Cancel |

In the Print this information on the cheque stub box, tick one or all of the checkboxes: Vendor ID, GST

Registration Number, Contact, Fax, Phone, or Email.

In the Print invoices on the cheque stub in this order grid, select how to itemise invoices on the cheque stub.
For example, to list invoices by invoice number with the lowest number first, in the Sort By column select

Invoice Number. In the Order By column, select Ascending.

Note: To sort even further, you can sort by Invoice Date and Invoice Amount.

To print credit memo applications on the cheque stub, tick Show the application of each credit memo.
To show the discount amount as recorded in the vendor record, leave Show the Discount column ticked.

Notes. To print a note on cheques and cheque stubs, select Notes on the left of the Default Payment Options

screen.

= Default Payment Options for Accounts Payable Electronic Funds Transfei

Cheque Alignment
Address Alignment
Chegue Stub Information

I

Print Format & Print the:

EFTG | INote from Yendor
enera

" Print this note:

¢ To print a note on the cheque, tick Print Note on Cheque. Tick Print the to access a drop down menu of

note selections. Tick Print this note to personalise a note on the cheque.

¢ To print a note on the cheque stub, tick Print Note on Cheque Stub. Tick Print the to access a drop down
menu of note selections. Tick Print this note to personalise a note on the cheque stub.
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Print Format. To select a printing format, select Print Format on the left of the Default Payment Options

screen.
= Default Payment Options for Accounts Payable Electronic Funds Transfei ﬂ
Cheque Alignment Print Format
Address Alignment _
ﬁh?que Stub Information Print format: ITotaI Per Cheque Printing j
otes
A maximum of 12 trangzactions will print on the cheque stub and the cheque will be
EFT General

printed for that amount. [f a vendor has more than 12 transactions to pay, additional
cheques will be created bazed on the number of transactions remaining.

¢ Select “Total Per Cheque Printing” to print each cheque for the amount of the transactions that can fit on

the cheque stub. Additional cheques are created based on the number of transactions fitting on a cheque
stub.

Select “Additional Document Cheque Printing” to print one cheque for the total amount and print all
transaction details on a separate sheet regardless of the number of transactions on the cheque stub. Tick
Print the transaction detail sheets or Export the transaction detail sheets to print or export transaction

details. To print the distribution for the payment, tick Show distribution for these characteristics and tick
the checkboxes for the information to appear with the transactions.

¢ Select “Combination Cheque Printing” to print one cheque for the total amount and print any transactions
not fitting on the cheque stub on a separate sheet of paper. Tick Print the transaction detail sheets or
Export the transaction detail sheets to print or export transaction details.

EFT General. To make formatting selections for EFTs, select EFT General on the left of the Default Payment
Options screen.

= Default Payment Options for Accounts Payable Electronic Funds Transfei ﬂ
Cheaue Alarmert
Address Alignment _
ﬁ?;nteéqsue Stub Information Dutput file name: I ;I
t |.| Bank file format: lﬁ

Cancel |

In the Output file name field, enter the path and file name of the EFT file to create or click the ellipses to
search for a file.

In the Bank file format field, select the bank format to use for the EFT.
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Managing EFT Bank Information

From the EFT Bank Information tab on the vendor record, you can establish the necessary banking information to
perform electronic funds transfers with your vendors. When you add a new vendor bank you can designate the
account name, account number, institution ID, and contact address information.

The EFT Bank Information tab appears only if you have the optional module Electronic Funds Transfer.

» Adding a new vendor bank to a vendor record

1. From an open vendor record, select the EFT Bank Information tab.

%0097 - A+ Dffice Supplies 10l =|
File Edit Yiew Yendor Favourites Tools Help

uSaveandﬁlosev|H xh;ﬁ é|" L N||%| @|E|ﬂ|1’l‘|?' |

Motes I History of Changes I Media | Actions I
Wendor I Activity I Becuring I Purchaze Orders I Addresses Distribution I Attributes I

A& NewVendorBank @5 Open Delete

Bank Mame 2 I Account Type I EFT Status I Motes I

Chequing EFT

[ | active | 10/04/2008 4

2. From the EFT Bank Information tab, click New Vendor Bank. The New Bank screen appears.

New Bank for A+ Office Supplies ﬂ
File Edit Yiew Account Tools Help
|-} Save and Close v| = | M 4 » kM | ?- |
EFT status: | Bankname: |
Account number: I Address: | ;I
Account name: |A+ Office Supplies _I
Bank number: I Contact | I
Contact positior: I
Motes: Contact info:
;I Contact Type Contact Mumber
[ 10/09/2005

In the EFT status field, select “EFT” or “Inactive”.

In the Account number field, enter the account number.

In the Account name field, enter the name of the account.

In the Bank number field, enter the six-digit bank number provided by the bank.
In the Bank name field, enter the name of the bank.

No v k~uWw
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10.
11.
12.

13.

To add bank address information, click Address. For more information about entering address
information, see “Adding vendor bank address information on the vendor record” on page 140.

. To add bank contact information, click Contact Name. For more information about entering contact

information, see “Adding vendor bank contact information on the vendor record” on page 140.
In the Contact position field, enter the contact’s position.
In the Notes grid, enter any notes associated with the bank.

In the Contact info grid, select a contact type in the Contact Type column and enter the contact number
in the Contact Number column.

To return to the EFT Bank Information tab, click Save and Close.

» Adding vendor bank address information on the vendor record

1.
2.

© N v kAW

10.

From an open vendor record, select the EFT Bank Information tab.
From the EFT Bank Information tab, click Address. The Address screen opens to the General tab.

Address For New Bank |
General |§ontact|
Cauntry: j Contact Tvpe Conkact Number I
Address: | =] |
Suburb: I j
City: I j
Postcode: I
Address as it will be printed: ;I [V Synchionize with individual address fields
()3 | Cancel |
| Presz F7 for table lookup

In the Country field, select the country of the bank.
In the Address field, enter the bank’s address.

In the Suburb field, select the bank’s suburb.

In the City field, select the bank’s city.

In the Postcode field, enter the bank’s Postcode.

In the contact grid, select types in the Contact Type column and enter details in the Contact Number
column. This grid is the same as the contact grid on the EFT Bank Information tab of the vendor record.

In the Address as it will be printed box, verify the address is formatted the way you want it printed on
reports. The Address as it will be printed box is the same as the Address box on the EFT Bank Information
tab of the vendor record. To update the address boxes based on the individual address fields on the
Addresses screen or update individual address fields on the Addresses screen based on the address boxes,
tick Synchronise with individual address fields.

To return to the New Bank screen, click OK.

» Adding vendor bank contact information on the vendor record

1.

From an open vendor record, select the EFT Bank Information tab.
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2. From the EFT Bank Information tab, click Contact. The Address screen opens to the Contact tab.

Address For New Bank x|
Contact
Title 1: | x| Tite2] =l
First name: I
Middle name: I
Last name: I
Suffix 1: I j Suffix 2 j
Position: I ™ Print?
Full name:
IV Synchionize full name and individual name figlds

()3 | Cancel |

In the Title 1 field, select a primary title for the contact.

In the Title 2 field, select a secondary title for the contact.

In the First name field, enter the contact’s first name.

In the Middle name field, enter the contact’s middle name.

In the Last name field, enter the contact’s last name.

In the Suffix 1 and Suffix 2 fields, select formal suffixes such as “Jr.” or “Ph.D”.

LW e NV W

In the Position field, enter the contact’s job title. To print the information entered in the Position field,
tick the Print? checkbox.

10. In the Full name field, verify or edit how the contact’s full name should appear. To update the full name
based on the individual name fields or update individual name fields based on full name, you can tick
Synchronise full name and individual name fields.

Creating an EFT payment

Note: To pay an invoice using EFT, you must select “Electronic Funds Transfer” as the Payment method on the
invoice record.

You can make EFT payments from the Banks page by clicking Print cheques and record bank drafts and accessing
the Create Payments screen. Keep in mind, to pay an invoice using EFT, you must select “Electronic Funds
Transfer” as the Payment method on the invoice record.

Using Print cheques and record bank drafts under Payment tasks, you can record and generate cheques and
bank drafts for a series of payments in one payment run.

You can process payments using the default payment options selected for the bank account or make new
formatting selections on the Format tab. For more information about default payment options, see “Defining
Default EFT Options” on page 135.
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» Creating a payment

1.

10.

From Payment tasks on the Banks page in Accounts Payable, click Print cheques and record bank drafts.
The Create Payments screen appears.

;’n Create Payments x|

File Edit Yew Tools Help
Gd?- |

iSten 1 "'G'é'r'wér'él'él 2: Filters | 3 Invoices | 4: One-Time Chegues | 5 Format

Payment Run

Payment date: ITnday vl Pay all vendors in this payment run IBased on payment method vI
Calculate discounts as of: IF'a_l,lmenl date vl Pay EFT Banks with this cycle: |<A|\ EFT cycles» 'I

Post status: IFlom Irvoice ‘I
Post date: IF'a_l,lmenl date ‘I

Include invoices with these dates

Invoice due date on or before IW

¥ Include invoices with discounts that expire on or before IW
Printer Options
Frint report ta this printer: IAdobe FDF j
PFrint payments to this printer: I j

¥ Pause prirting between paprment types

< Back | Mext > I Cancel | Create Later | Lreate Mow
| |4U Ireeoicels) approved: $54.548 67 |D One-Time Chequels) approved: $0.00

In the Payment date field, select “Today”, “Period end date”, or “Specific date” for dating the payments.
If you select “Specific date”, enter a date in the Date field.

In the Calculate discounts as of field, select “Payment date”, “Today”, “Period end date”, or “Specific
date” as the date for the program to use to determine if discounts are valid or expired. If you select
“Specific date”, enter a date in the Date field. If none of the selected invoices have discounts, the program
ignores this date.

In the Post status field, select the posting status to add to the payments included in the run:

¢ “From Invoice” — The program assigns the post status according to each invoice’s post status. Enter a
date to post in the Post date field.

¢ “Not Yet Posted” — The program changes all payments from this payment run to Not Yet Posted. Enter
a date to post in the Post date field.

¢ “Do Not Post” — The program changes all payments from this payment run to Do Not Post.
In the Pay all vendors in this payment run field, select the method to use when you pay invoices:
e “Based on payment method” — The program makes the payment as recorded in the invoice record.

e “By Computer Cheque” — The program makes the payment by computer cheque, regardless of the
method recorded in the invoice record. You can select “By Computer Cheque” only if you have security
rights.

In the Pay EFT Banks with this cycle field, select an EFT cycle. EFT cycles are defined in Configuration.

To select invoices by date information, in the Invoice due date on or before field, enter a date. The
program compares the date entered in this field with the scheduled payment date on the invoice.

To pay invoices before discounts expire, tick Include invoices with discounts that expire on or before and
enter an expiration date in the field.

In the Print report to this printer field, select the printer for the control report.
In the Print payments to this printer field, select the printer for the cheques, EFT notices, or bank drafts.



11. Click Next or select the Filters tab.

Note: The bank selected on the Banks page automatically appears as a Banks filter.

12.

13.
14.
15.

& Create Payments | x|
File Edit \iew Help
ad?- |

Step1: General  2: Filters | 3 Invoices | 4: One-Time Checks I 5 Formatl

< Open Clear Filters

Filters I Include I Selected Filkers

Wendors Al <l vendors =

Invoices Al <Al Invoices >

Barks Selected Operating

EFT TRANSACTIONS 15

To select filters, choose “Selected” in the Include column. The Selected <Filters> screen appears so you

can select filters for the payment run.
Click OK.

You return to the Filters tab and filters you selected appear in the Selected Filters column.

Click Next or select the Invoices tab.

;,n Create Payments : LI
File Edit Yiew Tools Help
a3 ?-
Step 1. Generall 2 Filkers 3 Invnices | 4: One-Time Chequesl 5 Formatl
Hide D etails
Pay? | InvoiceMumber | Date | WYendor |  Description |  DateDue  |Payment Amourk| AmountDus |~
[ soas4-n03 D4{05{2006 A+ Office Supplies Monthly suppliss 04052006 $575.00 $575.00
-004 i} A+ Office Supplies |I"-‘1-:wr|th|';.-‘ supplies 050512006 $5?5.IIIEI|
M 12-39324-073 01/05/2006 ADS Security Sy... Monthly Security .., 01/20/2008 $75.76 $75.76
[ 12-34324-074  02/05/2006  ADS Security Sy... Monthly Securky ., 02/20/2006 $75.76 $75.76
[T 1z-34324-075 03052006 ADS Securicy Sy... Monthly Secoriy ., O3/20/2006 $75.76 $75.76
[T 1z-34324-076  OHOS(2006  ADS Security Sy... Monthly Securky .. D4/20/2006 $75.76 $75.76
[T 1234324077 OS/05/2006  ADS Security Sy... Monthly Securky ., 0S/20/2006 475,76 475,76
[T 1z-34324-078 06/05/2006 ADS Security Sy... Monthly Security ... 06/20/2006 $75.76 $75.76
[ 6363636-015 D1/10{2006  AlphaGraphics  Office Supplies 01/25/2006 $1,000.00 $1,000.00
[ 6363636-016 02f10{2006 AlphaGraphics Office Supplies 02/25/2006 $1,000.00 $1,000.00
KI| '
Invoice number 55854-004 Fatential discount $0.00 Credit applied $0.00
Irwoice date 05/05/2006 Discount expires 05/05,/2006 Dizzount amount $0.00
Invoice amount $575.00 Unpaid balance $575.00 Balance due now $575.00
Amount paid $0.00 Available credit $0.00 Payment amount $575.00
GST amount $0.00 Credit GST amount $0.00
< Back | Mext > I Cancel | Create Later | Lreate Now
| |1 Invoice(s] approved: $575.00 |D One-Time Cheque(s) approved: $0.00

16. In the Pay? column, tick the checkbox for each invoice you want to pay. To pay all the invoices, click

Select All on the action bar.
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17. Click Next or select the Format tab.

& Create Payments x|
File Edit ‘iew Tools Help

agl?- |
Step 1 Generall 2 Filters | 2 Invaices | 4: One-Time Cheques 55_1...5.0.[!1153.!.'

Payment Options for EFT Notices

Payment Inf :
Papment format: I j I
Starling payment number IBTUD2 Restore Default |
I | Fiint payment number Edit Payment Options
Frint Test Alignment Cheque
Format.
Cheque nate: Mo note printed on the cheque
Cheque stub note: Mo noke printed on the cheque stub

Frint payments in this order -

Sork By Order By Iﬂ
Payee name Ascending
-l
< Back | Hezt s I Cancel | Create Later | LCreate Mow
| |1 Invoice(s] approved: $575.00 |D One-Time Chequels) approved: $0.00

18. From the list on the left, select a payment method. The right side of the screen displays the default

19.

20.
21.

formatting selections for that payment type as selected on the Payments tab of the bank account record.
The payment methods are the payment methods for the current approved invoices.

In the Payment format field, select a blank or preprinted form on which to print the payments. If the bank
account is set to have multiple payment types use the same numbering series as another payment type,
the Starting payment number field displays the first available number for payments using the same
range.

In the Starting payment number field, enter the first number for the selected payment type.
To print the cheque number on preprinted cheques, tick Print payment number.

Note: To save changes on the Default Payment Options screen for the bank account, tick Save these changes
to the Bank Account.

22.

23.

24.

25.

To make changes to payment options in the bank account record, click Edit Payment Options. For more
information about defining payment options, see the Banks Guide.

To make sure information is aligned properly on cheque forms or paper, click Print Test Alignment
Cheque.

Select how to sort cheques when printing, in the Sort By and Order By columns in the Print payments in
this order frame. For example, to sort cheques by payee name alphabetically, select “Payee name” in the
Sort By column. In the Order By column, select “Ascending”.

To review a report of the payments to be made before creating the payments, select File, Preview
Pre-Payment Report.
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26. Click Create Now at the bottom of the screen. If you ticked View payment summary information before

creating payments in Options, the Verify Payment

Information screen appears.

E= Yerify Payment Information

Y'ou are about to create payments az thown here:

x|

Payment Type | Mumber |Start Numberl End MNumber I Transactions Tatal

Arnournk |

EFT Cheques 1 67002 67002 1
Totals 1 1

' ou have zelected these paument options:

$575.00
$575.00

Payment date: 10/04/2008

Post date: 1040472006

Calculate discounts a5 of 10/04/2006
Frint payments to this printer; Adobe PDF
Frint reports to thiz printer; Adobe PDF

Cancel |

27. To process the payments, click Create Payments. The first payment type prints and the Payment Printing

28.
29.

30.

Status screen appears for this payment type.

oK |

E= Payment Printing Status 5[
Examine the printed cheques for accuracy, then select the appropriate options.
Payment Type IStart NumberI End MNumnber I Successful? | Clear Al Payments | Clear Date |
EFT Cheque 67002 67002} I - 10/042006
‘rou indicated EFT Cheque printing was not successful..
I j numberz] I through I

If the payments printed unsuccessfully or incorrectly, untick the checkbox in the Successful? column.

The You indicated Computer Cheque printing was

not successful frame becomes enabled. To void and

purge the unsuccessful payments, tick Void Cheques and Purge voided cheques and enter the range of

payment numbers.
Click OK. The program processes all other payment

types in the order they appeared on the Verify

Payment Information screen, and you return to the Banks page.
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